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PREFACE 

 

This textbook was written for BSc students, who having completed a course in descriptive 
statistics, are going to learn the elements of statistical inference. It is also useful for MSc 
students with no preliminary knowledge of the basic concepts and methods of statistical 
inference. In a former textbook ‘Descriptive Statistics’ the methods were discussed that are 
suitable for describing data. In the present textbook some of the methods will be discussed that 
are suitable to determine the probability that a conclusion drawn from sample data is true. 

The textbook presents the application of the methods on data drawn from the agricultural 
research in Georgikon Faculty reflecting the diversity of research in the Faculty. Many 
examples compare Hungarian varieties to international ones, including research data from the 
Department of Animal Sciences, the Department of Corporate Economics and Rural 
Development, the Department of Horticulture and the Institute of Plant Protection. The author 
thanks the colleagues of those departments for providing their data for this textbook. 

The step-by-step analysis is the best way to analyze biological data. The first steps are in 
connection with the planning which focuses on the relevant research question:  
I.1. Specify the research question. 
I.2. Identify the individuals or object of interest. 
I.3. Consider whether to use the entire population or a representative sample. In case of 
sampling, decide on a viable sampling method and do a power analysis if possible, to determine 
the proper sample size for the experiment. 
I.4. Determine the variables relevant to the question, determine the types (e.g. measurement) of 
variables. 
I.5. Remember that there are other variables (called confounding variables), that are not 
included in the statistical analysis, and plan an experiment that controls or randomizes these 
confounding variables. 

After that the statistical analysis may be broken down into the following steps: 
II.1. Do the experiment, collect the data. 
II.2. Decide the appropriate descriptive and inferential statistics methods. Put the question to be 
answered in the form of a statistical null and alternative hypothesis and choose the best 
statistical test to use. 
II.3. Apply appropriate descriptive and inferential statistics methods. Do not forget the 
assumptions of the chosen statistical analysis. If data fail to meet the assumptions, choose a 
more appropriate method. 
II.4. Interpret the results using graphs or tables, and make decisions. 
II.5. Note any important information and concerns that might be important about data 
collection, or data analysis and list any recommendations for future studies. 

The textbook is structured into four chapter. The first chapter explains the basic concepts of 
probability theory, while the second chapter presents the sampling distributions in statistics. 
Statistical inference is a process of drawing conclusions at a certain level of probability. As 
statistical inference can be divided into two main areas, the third chapter discusses the 
estimation, while the fourth chapter presents the most basic types of hypothesis testing. 
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1. INTRODUCTION INTO PROBABILITY DISTRIBUTIONS 

Statistical information is used to help decision making. If the population is not actually observed 
because of constraints on time, money, or effort, the information is considered unknown. 
Statistical inference is applied to make statements concerning the unknown information based 
on sample data, as a generalization from a sample to a population, because a decision based on 
limited information is always better than a decision without any information. Statistical 
inference involves drawing a conclusion about a population on the basis of available, sample-
based (viz. partial and therefore incomplete) information, so with a certain amount of 
uncertainty. 

Suppose that the likelihood for successful fertilization is examined, or the chance that the 
newborn calf will be female. The answer to the latter question can be: the gender ratio is 
50:50%, but in case of artificial insemination with sexed sperm the gender ratio can reach to 
90:10% by high fertility. When probability is used in a question or a statement, a number 
between 0 and 1 (i.e. from 0% to 100 %) is being used to indicate the likelihood of an event. 

The word ‘chance’, ‘predictability’, ‘probability’ is used to indicate the likelihood that some 
event will happen. These concepts are formalized by the branch of mathematics called 
probability theory. This chapter will introduce probability concepts. Probability is important in 
drawing inferences about a population, because statistics deals with drawing inferences 
applying the rules of mathematical probability. Getting to know the concept of probability leads 
to the concept of distributions, that is essential in Biometry. Probability theory started to 
develop on a combinatorial basis. Although mastery of this chapter is not essential to the 
application of the statistical procedures presented later, occasionally reference will be made to 
it in the later discussed chapters. 

1.1. Events and Sample Space  

In statistics an experiment is defined as a process that produces some data. When an experiment 
is performed the occurrence of a specific event may be interesting. Hooda (2013) emphasizes 
the difference between the term trial and experiment. Any act performed under given specified 
– in a formal scientific research inquiry carefully and objectively defined – conditions, may be 
termed as a trial. The trial is conducted once, twice or any number of times under the same 
specified conditions, it is called a single-trial experiment, or an experiment with two trials, or 
any number of trials. Later the experiment will be usually single-trial one, therefore the two 
terms are used as synonyms.  

An experiment generates certain outcomes. The outcome of a random experiment will depend 
on chance, and cannot be predicted with certainty. The set of all possible outcomes of an 
experiment is called the sample space (represented by the symbol S), a single outcome is called 
an element, elementary event or sample point of the sample space. All outcomes of an 
experiment are known as elementary events (represented by the symbol e). The elements can 
be listed, when sample spaces are finite: S = {e1, e2, … en} 

Suppose a phenomenon can happen in k different ways, but in only one of those ways at a time. 
Each possible outcome is referred to as an event. 
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If a random experiment has a sequence of two steps, that is something can happen k1 different 
ways and something else can happen k2 different ways, then the number of possible ways for 
both things to occur is k1 · k2. The counting rule can be extended to determine the number of 
ways for all n things to occur together (i thing can occur in any one of ki ways): k1 · k2 · k3 ·…· 
kn (Zar, 2010). 

 

A sample space can also be described in general terms, for example: 
S = {all cows of species y | y is a species} 
where the vertical bar ‘|’ is read as ‘such that’ or ‘given’. 

An event (represented by the symbol E) can be defined as a subset of the sample space 
E = {ei, ej, …ek}. Events are usually represented by capital letters. For example, A is the event 
that one of the newborn calves is female: A = {F-M, M-F}; B is that both of the newborn calves 
have the ‘same’ sex: B = {M-M, F-F}; and C is that at least one of the newborn calves is female 
C = {M-F, F-M, F-F}. 

Four types of events can be distinguished (the symbols and the number of events are 
summarized in Table 1, see the next chapter for the number of events):  

 a null or empty space (∅) contains no element of the sample space, such an event is an 
impossible event, 

 a simple event, i.e. elementary event contains only one element, 
 a compound (multiple) event contains two or more elementary events, it is the union 

of elementary events, and  
 a sample space contains all possible outcomes, the occurrence of this event is a certainty. 

Table 1 The symbol and the number of events 

Event Symbol The number of event(s) 

Sample space S 1 
Elementary event e │S│= n 
Impossible event ∅ 1 

An event, a subset of S containing k elements A, B, C, …  

All possible events  ∑ = 2   

EXAMPLE 1.1.1 

Some examples of sample spaces are: A cow fertilized is pregnant: S = {Yes, No} 
The newborn calf is bull (male – M) or heifer (female – F): S = {M, F} 
Age of cow at first calving (months): S = {24, 25, 26, 27, 28, 29, 30, 31} 
The number of calves a cow has: S = {0, 1, 2, 3, 4, 5} 
The number of calves a cow has in a lifetime: {0, 1, 2, 3, 4, …, 39} 

EXAMPLE 1.1.2 

Suppose that two cows are calving, a black one and a brown one. There are two possible outcomes 
for the sex of the newborn calf of the black cow (male or female) and two possible outcomes for the 
sex of the newborn calf of the brown cow. Therefore, k1 = 2 and k2 = 2 and there are k1 · k2 = 2 · 2 = 
4 possible outcomes of the sex of newborn calves: 
S = {M-M, F-M, M-F, F-F}. 
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The complement of an event A is the event (denoted by Ā and read as A bar or Ac) in the sample 
space containing all the outcomes that are not included in event A. The union of two events A 
and B is the event (denoted by A ∪ B) that contains all the outcomes included either in one or 
the other of the events A and B, or in both of them. The intersection of two events A and B is 
the event (denoted by A ∩ B) that contains all the outcomes common to both A and B. Events A 
and B are mutually exclusive, if they have no common elements (A ∩ B = ∅). Any event A and 
its complement, Ā, are mutually exclusive (disjoint). If all of the elements in event A are also 
elements of event B, event A is said to be a subset of event B (denoted by A ⊂ B). 

In the context of the sample space of an experiment it should be understood that it is being 
treated as a population, and a set of outcomes selected from the sample space is being treated 
as a sample (Hooda, 2013). The concept of these terms is essential to understand the concept of 
probability. The number of elements in a sample space, and in various events, are often counted 
to calculate the chance of the events occurring. To determine the number of possible outcomes 
the multiplication rule, permutations and combinations can be applied. 

1.2. Counting Techniques  

A permutation is an arrangement of the elements of a set in a specific order. A permutation is 
one of all possible ways to arrange n distinct objects in an order. If n linear positions are to be 
filled with n objects, there are n possible ways to fill the first position (k1). The second position 
can be filled in (n – 1) ways (k2) after the first element is placed in the first position, the third in 
any one of (n – 2) ways (k3), and so on until the last position, which may be filled in only one 
possible way (kn). The number of permutations of n distinct objects is 

Pn = n ∙ (n-1) ∙ (n-2) ∙ … ∙ 3 ∙ 2 ∙ 1 = n! 

(it is read as ‘n factorial’), that is the product of all positive integers from 1 to n by the method 
of counting rule (by special definition 0! = 1). 

 

If elements are arranged on a circle, there is no starting point as on a line, therefore the number 
of permutations is !/ . If the orientation of the circle is not specified that is clockwise and 
counter clockwise patterns are not treated as different, then the number of permutations of n 
elements is !2 = − 1 !2  

 

 

EXAMPLE 1.2.1 

A yellow (Y), a red (R), a white (W) and an orange (O) rose are arranged linearly along a fence. 
There are 4! = 24 ways to align these four roses: 

Y R W O Y R O W Y W R O Y W O R Y O R W Y O W R 
R Y W O R Y O W R W Y O R W O Y R O Y W R O W Y 
W Y R O W Y O R W R Y O W R O Y W O Y R W O R Y 
O Y R W O Y W R O R Y W O R W Y O W Y R O W R Y 
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If there is no assumed orientation of the observer, these two mirror-image observations can be 
considered as the same. When we have n elements grouped into k categories, each of which 
contains ni identical elements (i= 1,…k, and n1 + n2 + … + nk = n) then the number of different 
permutations is  

P , ,…, = !∏ ! 

 

If n distinct elements are arranged to k (k ≤ n) positions, the number of possible linear 
permutations of taking k elements from n at a time (denoted by Pn

k) is: 

P = !− ! 

 

  

EXAMPLE 1.2.2 

A black (B), a grey (G) and a dun (D) horse running in a circle could be arranged in two different 
ways: 

B 
                   G       D 

B 
                    D       G 

P = 3!3 = 2 
 

EXAMPLE 1.2.3 

There are five fruit trees, of which three are apple trees (A), and two are pear trees (P). How many 
different linear sequences of trees are possible? 

A A A P P A A P A P A A P P A A P A A P A P A P A P = 5!3! · 2! = 10 
P A A A P P A A P A P A P A A A P P A A P P A A A 

 

EXAMPLE 1.2.4 

Three different varieties of apple trees are bought from an orchard selling fruit trees. The three 
different varieties can be selected from among Idared (I), Jonagold (J), Mutsu (M), Gloster (G) and 
Starking (S) apple trees and are planted in order. 

There are 5! = 120 ways of placing the 5 varieties in five positions on a line, but there are 

considerably fewer ways to arrange only three different varieties at a time: P = ! ! = 60 

I J M I J G I J S I M G I M S I G S J M G J M S J G S M G S 
I M J I G J I S J I G M I S M I S G J G M J S M J S G M S G 

J M I J G I J S I M G I M S I G S I M G J M S J G S J G S M 
J I M J I G J I S M I G M I S G I S M J G M J S G J S G M S 

M I J G I J S I J G I M S I M S I G G J M S J M S J G S M G 
M J I G J I S J I G M I S M I S G I G M J S M J S G J S G M 
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There are only !/[ − ! ] ways if the arrangement are circular. The number of possible 
orders of planting the apple trees in a circle is 60/3=20 (in EXAMPLE 1.2.4 each column 
contains two circular orders, the ones in italics being in the same circular order, and the rest are 
also of the same order). 

When each trial of the experiment has an equal number of possible outcomes, the total number 
of outcomes is Pn

k,r = nk, where k is the number of trials and n is the number of outcomes in 
each trial. 

 

A combination is a selection of a subset from a set without considering the sequence of 
elements within the subset. In this case only the elements of the subset are important, not their 
arrangement. The number of combinations of k elements taken from a set of n elements (denoted 
by Cn

k) is C = ! ! ! =  (read as ‘n choose k’). 

These numbers are called binomial coefficients. The properties of the binomial coefficients are: 

0 = = 1 = −  = − 1− 1 + − 1  

= 2  − = +  

 

Combination with replacement is defined by the following formula: 

C , = + − 1  

In this case the chosen k elements are not necessarily different, i.e. if six apple trees are to be 
planted and can be selected from five different varieties, the number of possible ways is  

C , = 5 + 6 − 16 = 210 

EXAMPLE 1.2.5 

Assume that the three apple trees bought from the orchard are 
not necessarily of different varieties. Five different apple tree 
varieties can be planted into the first place, five varieties can be 
planted again into the second place, and five varieties into the 
third place. The number of ways of planting the three apple trees 
is 53=125. 

 

EXAMPLE 1.2.6 

Referring again to apple trees when the three different varieties are selected from among Idared (I), 
Jonagold (J), Mutsu (M), Gloster (G) and Starking (S), ignoring the order, the number of ways of 
selecting 3 out of 5 varieties is 5!/[ 5 − 3 ! 3!] = 10 (since the order of the selected varieties is of 
no relevance, the choices in each column are the same in EXAMPLE 1.2.4). 
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The concept of probability has no existence without random sampling. To reach valid 
conclusions about populations by inference from samples, statistical methods assume random 
samples. This means that each element of the population has an equal and independent chance 
of being chosen, that is, the selection of any element has no influence on the selection of any 
other one. Hunyadi – Vita (2002) emphasize the known probability of the selection of the 
sample members. 

 

Summarizing the number of the sets of outcomes (sample), the following formulas can be 
applied (Table 2): 

Table 2 The number of the set of outcomes 

Objective 
n elements 

taken 
Replacement 

Without With 

Arrangement 

n at a time Pn = n! , ,…, = !∏ ! 
k at a time 

= !− ! Pn
k,r = nk 

Selection =  , = + − 1  

So the random selection of a sample may be done with or without replacement. Sampling with 
replacement means that the elements are taken one at a time, returning each one to the set before 
the next one is selected, that is, each element can appear in the sample repeatedly. If each 
element of a population can be selected only once (and is not replaced), the sampling is done 
without replacement. 

In the following section probability is defined and some rules are introduced. Probability is the 
language of inferential statistics, and understanding probability is important when interpreting 
P-values in the statistical tests.  

EXAMPLE 1.2.7 

If three apple trees would be planted and the three apple trees can be selected in the orchard from 
five different varieties, then the number of combinations with replacement is  

I I I J J J M M M G G G S S S I J M I G S C , = 5 + 3 − 13 = 35 
I I J J J I M M I G G I S S I I J G J M G 

I I M J J M M M J G G J S S J I J S J M S 

I I G J J G M M G G G M S S M I M G J G S 

I I S J J S M M S G G S S S G I M G M G S 
 

HOW TO COMPUTE FACTORIALS, PERMUTATIONS AND COMBINATIONS IN EXCEL? 

The FACT function is used for computing factorials, the PERMUT function for permutations, and 
the COMBIN function for combinations. 
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1.3. Probability 

Probabilities are associated with events and are referred to as chances. Probability (P(E), read 
as ‘P of E’) measures the likelihood of an event (E) with a scale ranging between 0 and 1 often 
converted to percentages. The value P(E) = 1 (closer to 1) indicates that the event E is certain 
(very likely) to occur. The value P(E) = 0 (closer to 0) indicates that the event E is certain not 
(very unlikely) to occur. 

A-priori or a-posteriori, empirical and theoretical probabilities can be distinguished. A prior 

probability is based on knowledge, previous experiences, or is derived by a logical deduction. 
A posterior probability is obtained from the prior probability with additional data collected 
from a planned experiment. 

Classical probability, the probability of an event E occurring (P(E)), in general, is defined as 

=  

where n(E) is the number of ways the event can occur, and N(S) is the total number of outcomes 
in the sample space.  

The empirical probability is calculated based on relative frequency, as a proportion  

≈  

where f is the number of outcomes not known exactly but observed from a large number (n) of 
trials. The relative frequency (i.e. the empirical probability) is (very likely) to change from one 
experiment, and so from one sample, to another for the same E event – from the same 
population, but the probability can be estimated through repetitive experiments. The relative 
frequency is approximately equal to the classical probability, i.e. the theoretical value that is 
expected. The use of the relative frequency approach to assigning probabilities of an event is a 
common way. According to the law of large numbers, as the number of trials, i.e. the sample 
size, increases (approaches infinity), the relative frequency approaches the theroretical 
probability value. 

 

EXAMPLE 1.3.1 

What is the chance that the newborn calf will be female?  
E might be the event that the newborn calf is female. There are two possible – equally likely – 
outcomes of the sex of the newborn calf S = {F, M}, therefore the probability of the event E is P(E) 
= ½. 
If two cows are calving, what is the chance that exactly one of the newborn calves is female (A), 
both of them have the ‘same’ sex (B), and at least one of the newborn calves is female (C)? 
In this case there are 4 possible outcomes of the sex of newborn calves: 
S = {M-M, F-M, M-F, F-F}. A = {F-M, M-F}, therefore P(A) = 2/4 = ½, 
B = {M-M, F-F}, therefore P(B) = 2/4 = ½, C = {M-F, F-M, F-F}, therefore P(C) = ¾. 
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The basic probability rules are: 

1. The addition rule: If two events A and B are disjoint (with no common intersecting 
elements) then the probability of the occurrence A or B (union) is the sum of the probabilities 
of the two events: P(A ∪ B) = P(A) + P(B). The formula can be extended for k disjoint events. 

 The probability of an event E = {ei, ej, …, ek} is the sum of the probabilities of the 
mutually exclusive elementary events (ei):  
P(E) = P(ei) + P(ej) + … + P(ek). 

 Since the occurrence of the whole sample space, i.e., all possible outcomes as an event, 
is a certainty, the sum of the probabilities of all elementary events in a sample space is 
equal to 1: ∑ = 1. 

 As the complement of an event A is the event that A does not occur, A and Ā are mutually 
exclusive, and A ∪ Ā = S, thus P(A ∪ Ā) = P(A) + P(Ā) = P(S) = 1. The probability of 
a complement is P(Ā) = 1 – P(A). 

2. The multiplication law: If two events A and B are independent, that is, the occurrence of 
event A does not change the probability of the occurrence of event B, and vica versa, then the 
probability of the occurrence A and B (intersection) is the product of the probabilities of the two 
events: P(A ∩ B) = P(A) ∙ P(B). The formula can be extended for k mutually independent events. 

3. Conditional probability (denoted by P(A│B) read as ‘P(A, given B)’) is the probability of 
the occurrence of an event (A) with the condition that another event (B) (P(B) ≠ 0) also occurred: 

| = ∩
 

 If the events A and B are independent, then P(A) = P(A│B) = P(A│ ). 
 If the events A and B are dependent, then P(A) ≠ P(A│B) and P(A ∩ B) ≠ P(A) ∙ P(B), 

the change in the probability of event A caused by the occurrence of the other event (B) 
must be taken into account. So the general multiplication law for any events (Bajpai, 
2010) is: ∩ = | ∙ = | ∙ , ℎ   | = | ∙

 

4. The addition rule for two intersecting events A and B can be calculated as: 

P(A ∪ B) = P(A) + P(B) – P(A ∩ B). 

to avoid the double-counting of the intersection space. 

What is the chance that exactly one of the newborn calves is female (A) and both of the newborn 
calves have the ‘same’ sex (B)? 
The two events are disjoint, therefore the probability of the occurrence A and B is 0. 
What is the chance that at least one of the newborn calves is female (A) and both of the newborn 
calves have the ‘same’ sex (B)? 
The intersection of the events is {F-F}, the probability of this event is P = ¼. 
What is the chance that exactly one of the newborn calves is female (A) or both of the newborn 
calves have the ‘same’ sex (B)? 
The union of the events is the whole sample space, therefore the probability is P = 1. 
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 If the events A and B are independent, then 

P(A ∪ B) = P(A) + P(B) – P(A) · P(B)= P(A) + P(B)∙[1-P(A)]. 

Because event A occurs either with or without event B, P(A) = P(A∩B) + P(A∩ ). This formula 
leads to the relation of the conditional and unconditional probabilities. 

5. For any events A and B 

P(A) = | ∙ + | ∙  

The formula can be extended for k disjoint and exhaustive (i.e., when at least one of them must 
occur) events (B1, B2, …, Bk). The probability of event A is the weighted average of the 
conditional probabilities of event A given event Bi: 

P(A) = ∑ | ∙  

 From this relationship the following formula, known as Bayes’ Theorem, is derived: 

| = | ∙ = | ∙∑ | ∙  

 

 

The value of a categorical or a numeric variable is observed for each sampled element of a 
population to describe the statistical features of the sample and generalize the sample results to 
the population. The variables, and the statistics are all random variables. 

EXAMPLE 1.3.2 

The grape powdery mildew infection risk was 60% in the region of Kőszeg and 80% in the region 
of Vaskeresztes in 2013. What does it mean? It means, that if a grape is selected in the region of 
Kőszeg random, the probability of the powdery mildew infection is 60%, that is, if 100 grapes are 
selected randomly, approximately 60 of 100 is infected, while the same proportion in Vaskeresztes 
is 80 of 100. Denote A the event, that the grape is infected, and Ā that it is not infected, and B and C 
the events that the grape is in Kőszeg and Vaskeresztes, respectively. The probability of infection in 
Kőszeg is P(A│B) = 60% (and of non-infection in Kőszeg is P(Ā│B) = 40%), while the same 
probabilities in Vaskeresztes are P(A│C) = 80% and P(Ā│C) = 20%. 

EXAMPLE 1.3.3 

In a region the proportion of resistant grape varieties is 30%. In case of these varieties the powdery 
mildew infection risk is 5%, while 70% otherwise. What is the chance of the powdery mildew 
infection of this region? Denote A the event that the grape is infected,  Ā that the grape is not infected, 
and B that the grape is resistant while  the event that the grape is not resistant. The probability of 
infection given a resistant grape variety is P(A│B) = 5%.  

 Infected (A) Non-infected (Ā) Probability 
Resistant (B) P(A│B) = 5% P(Ā│B) = 95% P(B) = 30% 
Non-resistant ) P(A│ ) = 70% P(Ā│ ) = 30% P( ) = 70% 

To calculate the probability of the powdery mildew infection, the following formula is used: 

P(A) = | ∙ + | ∙ = 0.05 ∙ 0.3 + 0.7 ∙ 0.7 = 0.505 = 50.5% 
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1.4. Probability Distribution 

A random variable is a function that assigns numeric values to the outcomes of a random 
experiment in the sample space. A quantitative variable (denoted by X) measuring the outcome, 
takes a random numerical value with some probability. Random variables can be: 

 discrete: that can take on only particular (i.e., a finite number of) values, and they are the 
results of a count – often integers (e.g. the number of infected trees, pregnant cows), or 

 continuous: that can take on any value in an interval, and they are typically the results of a 
measurement (the diameter of the tree trunk, the weight of a piece of valuable meat) – real 
numbers. 

A probability distribution is a table, a graph or a formula (a function) that assigns a probability 
to each value of a random variable. A relative frequency distribution based on an ‘infinitely’ 
large sample can be considered as a probability distribution. The function f(x) that presents a 
probability distribution of a discrete variable is called probability mass function. The function 
that presents a probability distribution of a continuous variable is called probability density 

function. 

A random variable and the associated probability distribution are described by parameters. The 
expectation or expected value of a variable X is the mean of the random variable, that 
represents the ‘central-point’ for the entire distribution, the long-term ‘average’value if the 
experiment is conducted repeatedly. The expected value is not necessarily a value of the sample 
space: 

E(X) = μX 

The variance of X is the mean square deviation from the mean, the spread, relative to the 
expected value 

Var(X) = σ2
X = E[(X - μX)2] = E(X2) – μX

2 

The standard deviation is the square root of the variance, that represents the measure of risk: 
the larger the standard deviation, the greater the likelihood that the random variable is different 
from the expected value. If the Greek letters (μ, σ) are used, the information given about the 
expected value or the standard deviation is from the entire population. 

The cumulative distribution function, denoted by F(x), assigns to each value the sum of 
probabilities of all values no larger than the considered value (x), and is defined as 

F(x) = P(X ≤ x) 

The Pth percentile of the distribution is the value such that P% of the data fall at, or below it, 
and (100-P)% of the data fall at, or above it.  

1.4.1. Probability Distribution for a Discrete Random Variable 

The probability distribution for a discrete random variable (X) assigns a probability 
0 ≤  P(x)  ≤ 1 to each distinct value (x) of a discrete random variable. The sum of all possible 
probability values must equal 1. To present a probability distribution graphically for a discrete 
random variable a stick plot is the correct type because it does not take on any value between 
two integers. The values of X are placed along the horizontal axis and the probabilities of the 
outcomes on the vertical axis.  
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The expected value of a discrete random variable is the weighted average of all possible values 
(x) of the variable, where the weights are the probabilities P(x): 

μX = E(X) = ΣxP(x) 

The variance of a discrete random variable is: 

σ2
X = Var(X) = Σ(x-μX)2P(x) = Σx2P(x)-μX

2 

 

 

  

EXAMPLE 1.4.1 

Assume that 5 (n) cows are calving. The probability and the cumulative distribution for the number (x) 
of the female newborn calves is as follows, where the probability P(x) of the outcomes is: 

= = =   

x 0 1 2 3 4 5 

P(X=x) =   =   =         

F(x) 
132 

632 
1632 

2632 
3132 1 

The mean and the variance are calculated as: 

μ  = 0 ∙ 132 + 1 ∙ 532 + 2 ∙ 1032 + 3 ∙ 1032 + 4 ∙ 532 + 5 ∙ 132 = 8032 = 2.5 

σ  = 0 ∙ 132 + 1 ∙ 532 + 2 ∙ 1032 + 3 ∙ 1032 + 4 ∙ 532 + 5 ∙ 132 − 2.5 = 1.25 

σX = 1,25 

EXAMPLE 1.4.2 

There are five fruit trees, of which three are apple trees (A), two are pear trees (P). Three trees are 
selected for planting. The probability distribution for the number (x) of planted apple trees is as follows, 
with the probability P(x) of the outcomes: 

= = ∙
 

x 1 2 3 Σ 

P(X=x) 

31 2253 = 310 

32 2153 = 610 

33 2053 = 110 1 

The mean and the variance are calculated as: 

       μ  =  E X  = 1 ∙ + 2 ∙ + 3 ∙ = = 1.8 

σ =  Var X  = 1 ∙ + 2 ∙ + 3 ∙ − 1.8 = 0.36  

σX = 0.6 
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Observations from experiments can be classified and described by a certain probability 
distribution. It is important to be able to recognize the type of a discrete distribution. The most 
common probability distributions are the following: 

 Uniform distribution: the probability of every outcome is the same (P(X)=1/k, where 
k is the number of the possible outcomes), the probability function is defined only by 
one parameter, the number of possible outcomes. The mean and the variance of a 
discrete uniform variable of consecutive integers between a ≤ b are 

=  =  

If the experiment has two possible outcomes (‘success’ and ‘failure’), the trial and the variable 
is called binary ~ Bernoulli. This trial is repeated several times (n) under identical conditions. 

 Binomial distribution: the probability function for this dichonomous event is defined 
by two parameters: the number of trials (n), and the probability (p) of the specific 
preferred  outcome (called ‘success’), which is the same for each trial. The trials are 
independent because binomial probabilities are the result from a sampling with 
replacement. The probability function for the variable X (0 ≤ x ≤ n) representing the 
occurrence number of the preferred outcome: = 1 −  

The mean and the variance of a binomial variable are =  =  

 

 Hypergeometric distribution: the probability is not constant, and the trials are not 
independent because trials are made without replacement. If the population is relatively 
small, the hypergeometric distribution should be used. If random sample is drawn from 
a very large population (n < 0.05N), the trials are approximately independent, so the 
probabilities do not change much and the hypergeometric distribution approaches the 
binomial one. The probability function for the variable X (0 ≤ x ≤ min(k,n)) representing 
the number of preferred outcomes (‘successes’) occurring in a sample of n from a set of 
size N (n < N) with k of them being ‘successes’ that is, the probability of ‘success’ is 
p = k/N: 

EXAMPLE 1.4.3 

A biologist is studying a new hybrid plant of which seeds have probability of germinating 0.85 (p). 
The biologist plants four (n) seeds. What is the probability that exactly x seeds will germinate, what 
is the expected number and the standard deviation of germinating seeds? 

= 4 0.85 0.15  = 4 ∙ 0.85 = 3.4 = √4 ∙ 0.85 ∙ 0.15 = √0.51=0.7141 

The mean and the variance can be also calculated in EXAMPLE 1.4.1, as: = 5 ∙ 0.5 = 2.5,  σ2 = 5 ∙ 0.5 ∙ 0.5 = 1.25 
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= −−  
The mean and the variance of a hypergeometric variable are 

= =   = 1 − = 1 −  

 

There are distributions in case of which n is not fixed but they give the probability of reaching 
a particular number of successes (k) from a certain number of trials. 

 Negative binomial distribution: gives the probability of reaching the kth success in the 
nth trial = − 1− 1 1 −  =   =  

 
 Geometric distribution: is a special form of the negative binomial distribution, which 

gives the probability of the first (k = 1) success in the nth trial. 
 = 1 −   =   =  

 

EXAMPLE 1.4.4 

In a box there are 2 (k) ill and 10 (N - k) healthy pigs, from which 3 (n) pigs are selected at random. 
What is the probability, the expected number and the standard deviation of the number of ill animals 
in the random selection? 

=   = 3 = 0.5   = 3 1 − = √0.34 

The mean and the variance can be also calculated in EXAMPLE 1.4.2. as 

μ = 3 = 1.8  σ2 = 3 1 − = 0.36 

EXAMPLE 1.4.5 

In a herd the pregnancy rate of the cows is approximately 40%. Denote n the random variable that 
represents the number of cows that must be examined to find the first pregnant one. What is the 
probability distribution of the random variable n, and the expected number of cows to be examined? = 0.4 0.6   = . = 2.5 
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If a distribution of the probability of rare events, occurring infrequently in time or space, is 
examined, that is, there is a small probability of an occurrence, the distribution is: 

 Poisson distribution: the probability distribution of the number of rare events in a fixed 
time, area, volume or any other quantity that can be subdivided into smaller and smaller 
intervals, based on long-term experience, with a known average rate over designated 
intervals (μ = λ), the mean and the variance of the distribution are: 

= !   x = 0,1,2,… =   =  

where e is the base of the natural logarithm, and the only parameter, λ defines the 
distribution. Binomial distribution can be approximated by a Poisson one if n is large 
(n > 100) and p is small (np < 10). 

  

EXAMPLE 1.4.6 

Approximately 4.0% of untreated Jonathan apples has bitter pit disease. Denote n the random 
variable that represents the number of apples that must be examined to find the first one with bitter 
pit. What is the probability distribution of the random variable n, and the expected number of apples 
that must be examined? = 0.04 0.96   = . = 25 

EXAMPLE 1.4.7 

There are 100 potato plants in a garden, on which 50 Colorado potato beetles randomly land. What 
is the expected number of beetles per plant and the probability of plants with X = 0,1,2,... beetles? μ = λ = 0 · 0.6065 + 1 · 0.3033 + ⋯ = = 0.5 beetles/plants 

Number of beetles X P(X) Estimated numbers of plant 
0 0.6065 61 
1 0.3033 30 
2 0.0758 7 
3 0.0126 1 
4 0.0016 0 
5 0.0002 0 

more than 5 0.0000 0 
Sum 1 100 
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1.4.2. Probability Distribution for a Continuous Random Variable 

Most variables examined in biology are continuous. In this section distributions of continuous 
variables are discussed. Assume there is no measurement error and the random variable can 
take on a continuum of possible values. The probability density function f(x) of the random 
variable X represents the density for a given value of the variable. Because a continuous variable 
X can take on infinite possible numbers of values, the probability distribution assigns a 
probability 0 ≤ P(x) ≤ 1 to each interval of values (between any two limits x1 and x2) of the 
continuous random variable. The probability of any exact value is always 0 (it is impossible to 
define the probability of an individual value, therefore P(X ≤ x) = P(X < x)). 

P(x1 ≤ X ≤ x2) =  

As the variable may potentially have any value, the probability density function can be 
represented by a continuous curve. The total area under this curve, between the two limits, i.e. 
the lowest and the highest outcomes,  – that may be an infinite interval ]-∞, ∞[ – must equal 1. 
The horizontal axis (abscissa) shows the values of the continuous variable and the frequency or 
the density is given by the height of the curve (vertical axis/ordinate). Because the probability 
density function is continuous, the cumulative distribution function is also continuous, and is 
defined as the anti-derivative or integral of the probability density function f(x) in the interval 
(-∞, x): 

F(x) = P(X ≤ x) =  for - ∞ < x < ∞ 

The density function is the first derivative of the cumulative distribution function: f(x) =  

The cumulative distribution function, the mean and the variance for a continuous random 
variable have the same meaning as for a discrete distribution. 

  

HOW TO COMPUTE PROBABILITIES FOR A DISCRETE RANDOM VARIABLE IN EXCEL 
AND IN SPSS? 

IN EXCEL: the BINOM.DIST function is used to compute binomial probabilities with the following 
arguments: the number of successes in trials (x); the number of independent trials (n); and the 
probability of success on each trial (p). 
NEGBINOM.DIST is used to compute negative binomial probabilities with the following 
arguments: the number of failures (n-k); the threshold number of successes (k, for the geometric 
distribution k = 1); and the probability of success (p). 
The POISSON.DIST function is used to compute the Poisson distribution with the following 
arguments: the number of events (x); and the expected value (λ). 
Each of the above-mentioned functions have a logical parameter value, which is set to FALSE to 
compute the probability P(x), or TRUE to compute the cumulative probability F(x). 
IN SPSS: The values of a new variable x are entered in the data editor. In the menu, choose 
Transform ►Compute, and in the dialogue box type P_x (F_x) for the target variable and in the 
function box type Pdf.Binom, Pdf.Hyper, Pdf.Negbin, Pdf.Geom or Pdf.Poisson, respectively, to 
compute the probability distribution function. Cdf. functions with a similar name are also available 
to calculate the (cumulative) probabilities in a new column of the data editor. 
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The expected value of a continuous random variable is the weighted average of all possible 
values (x) of the variable, where the weights are the probabilities f(x): 

μX = E(X) = dx 

The variance of a continuous random variable is: 

σ2
X = Var(X) = −  =  – μx

2 

Similarly to discrete probability distributions there are many kinds of continuous distributions 
to describe the observations gained from experiments. The uniform density is the continuous 
counterpart to the uniform distribution, and the exponential density is the continuous version to 
the Poisson distribution. 

 Uniform distribution: the meaning is the same as in the case of discrete random 
variable i.e. the probability of every outcome is equal. 

 Exponential distribution: while the probability of the number of rare events (discrete 
random variable) occurring within a time or space interval is described by the Poisson 
distribution, the probability of the elapsed times or distances between occurrences of 
consecutive events is described by the exponential distribution, and both of these 
distributions are determined by their mean value. 

The density, the cumulative distribution function, the mean and the variance of the uniform and 
the exponential distribution are calculated as in Table 3. 

Table 3 The distribution functions and the statistics of uniform and exponential distribution 

Type f(x) F(x) E(X) Var(X) 

Uniform f x =       < ≤0   ℎ     F x =       < ≤0   ℎ    =   =   

Exponential f x =       0 ≤0  < 0   F x = 1 −      0 ≤0  < 0   =   =   

 

 

EXAMPLE 1.4.8 

Suppose that the length of a 5 m piece of pine slat can be trimmed to any length of between 4.9 m 
and 5.1 m with equal probabilities. Therefore, the actual slat length is described by a uniform 
distribution. What is the probability that a piece of slat selected at random is between 4.91 m and 
4.95 m? P 4.91 ≤  x ≤  4.95 = 15.1 − 4.9,

, = 4.95 − 4.915.1 − 4.9 = 0.040.2 = 20% 
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There are many other continuous distributions (Gamma, Beta, Weibull, Logistic, Cauchy) 
which are not discussed in this textbook. As the normal probability distribution is the most 
common and the most important continuous probability distribution in mathematical statistics, 
therefore it will be explored in more detail. 

1.5. The Normal and the Standard Normal Distribution 

If the majority of the values tend to be around the mean with progressively fewer observations 
toward the extreme ends of the range producing ‘tails’ on either side of the distribution, 
variables and statistics can be characterized by a normal distribution. This distribution is 
symmetric around its mean (the coefficient of skewness is 0, f(μ) = the maximum of the 
distribution, and μ = mode = median) and ‘bell-shaped’, although not all bell-shaped curves are 
normal. The probability function = 1√2  

which is defined by two parameters the mean and the variance, which specify the position (the 
balance point = μ) and the extent of spread as well as the height ( √ ) of the curve of the normal 

distribution. The shorthand expression for this distribution is N(μ,σ2). Any normal random 
variable X can be transformed (standardized) to standard normal variable as: 

= −
 

Thus X = zσ + μ, that is, the z value shows how many standard deviations a value is above or 
below the mean value. The mean of the standard normal distribution is always 0 (in standard 
units), and the variance is always 1; Z~ N(0,1). A positive z value corresponds to a value above 
the mean in the original distribution, while a value below the mean has a negative z score. The 
standard score describes the location of the value of the original variable from the mean in 
standard deviation units. 

  

EXAMPLE 1.4.9 

A tractor part can work for 1 000 hours on average without failure (Hunkár, 2011). What is the 
chance that the tractor will actually work 

 for less than 5 000 hours? = 1000    =        < 5000 = 1 − = 1 −      

 

 for more than 12 000 hours without failure?     > 12000 = 1 − 1 − =  

HOW TO COMPUTE PROBABILITIES FOR AN EXPONENTIAL RANDOM VARIABLE IN 
EXCEL AND IN SPSS? 

IN EXCEL: the EXP.DIST function is used to compute exponential probabilities with the following 
arguments: the value of the function (x); the parameter value (λ); and a logical value which is set to 
FALSE to compute the probability P(x), or TRUE to compute the cumulative probability F(x). 
IN SPSS: The procedure is the same as with discrete distributions with the Pdf.Exp and Cdf.Exp. 
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The properties of the normal and the standard normal distribution (Figure 1) are: 

 The curve is symmetric, the skewness (the measure of the symmetry) is 0, while the 
mean, median and mode all have the same value, half of the values fall above the mean. 

Figure 1 The standard normal distribution and 

its cumulative distribution function, Z ~ N(0,1) 

Source: Rosner (2011) 

 
 The cumulative distribution function of a N(0,1) variable us usually denoted by ϕ(z).  
 The kurtosis (the measure of relative peakedness of a probability distribution) is also 0. 
 The curve approaches the X-axis asymptotically, that is, the tails of the curve, while moving 

away from the mean, approach the X-axis, but they never quite reach it. 
 Around 68% (slightly over two-thirds) of the area under the curve falls within one standard 

deviation on each side of the mean, roughly 95% is between μ-2σ and μ+2σ1.  

The probability of a normal random variable between two bounds (x1 and x2) is determined by: P x1 ≤ X ≤ x2  = P z1 ≤ Z ≤ z2  
i.e., the area under the normal curve, for which the integration should be computed. For 
convenience the procedure is to transform the bounds into standard z scores first, then look up 
the probabilities of these standard scores in a z-table. The z-table contains the values of the 
cumulative probability distribution denoted by ϕ(z) = P(Z < z), the probability of the standard 
normal variable Z being ‘less than’ a given z-value. 

  

 
1 By Chebyshev’s Theorem, that the data spread about the mean can be given for all distributions: for a constant k 
(k > 1) the proportion of values within k standard deviations above or below the mean is at least 1-1/k2. 
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The structure of the z-table (Table A.1 in APPENDICES) is the following: increments of z in 
tenths in the leftmost column, and increments in hundredths added to these values across the 
rows. Linear interpolation of the p-values can result in an approximation if a z-value with more 
than two decimals is required. For example, to find the probability ϕ(0.36) look up the row with 
0.30 in the first column of the table, and the column with 0.06 in the first row. The value in the 
intersection of the chosen row and column, i.e. 0.6406 is the required probability. If we need 
ϕ(0.365) take the average of ϕ(0.36)=0.6405 and ϕ(0.37)=0.6443, i.e. ϕ(0.365)=0.64245. 

The following rules show the way to compute the probabilities:  

 P(Z ≥ z): use the rule of complements P(Z ≥ z) = 1 – P(Z < z), 
 P(Z ≤ -z): from the symmetry properties P(Z ≤ -z) = P(Z ≥ z), 
 P(z1 ≤ Z ≤ z2): the following formula can be used P(Z ≤ z2) – P(Z ≤ z1). 

 

 

A binomial distribution can be approximated by a normal distribution with  (μ = np, σ2=np(1-
p)), if np(1-p) ≥ 5 or np ≥ 5 and n(1-p) ≥ 5. A Poisson distribution also can be approximated by 
a normal distribution with (μ = σ2), if μ ≥ 10. 

Why is the normal distribution important? 

 Many statistical tests assume, that the data come from a normal distribution. 
 The mean and the variance are not dependent on each other for normally distributed 

data. 
 Many natural phenomena are, in fact, more or less normally distributed, that is, the 

curves illustrating the measures of the phenomena would be close to symmetric around 
their mean and look like the general bell shape. 

  

EXAMPLE 1.5.1 

In a pig farm the average weight of three-month piglets is 35 kg, the weight is normally distributed, with 
a standard deviation of 6 kg (Hunkár, 2011). Randomly choosing a piglet, compute the chance of its 
weight being: 

less than 32 kg?  P(X < 32) = P(Z<  = P(Z<-0.5) = P(Z >0.5)=1– P(Z<0.5)=1– 0.3085=0.6915 

more than 38 kg? P(X > 38) = 1 – P(X ≤ 38) = 1 – P(Z <  = 1 – P(Z < 0.5) = 0.3085 

between 36 and 37 kg? P(36 ≤ Z ≤ 37) = P(  ≤ Z ≤ ) = P(Z < ) – P(Z < ) = 0.6293 – 0.5675 = 0.0618 

EXAMPLE 1.5.2 

What is the weight that the heaviest 5% of piglets exceed? If P(Z ≥ z) = 0.05, then 
P(Z < z) = 0.95. The approximate z score associated with the specific probability can be found from 
the inverse standard normal distribution. From table A1, using interpolation we get that  
approximately 5% of piglets are at least 1.645 standard deviations above the mean weight: X0,95 = zσ 
+ μ = 1,645 ∙ 6 + 35 = 44.87 kg, thus the heaviest 5% of piglets are 44.87 kg or heavier, that is P(Z ≥ 
1.645) = P(X ≥ 44.87) = 0.95. 
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 Central Limit Therorem: the distribution of the means of samples taken from even a 
non-normal distribution can be normally distributed if the sample size is large enough. 
When an infinite number of successive random samples of n elements are taken from a 
population, the sampling distribution of the means of those samples will become 
approximately normally distributed with mean μ and standard deviation /√ , 
irrespective of the shape of the population distribution, as the sample size (n) becomes 
larger (see more detail in Chapter 2.3). 

 If the variable is not normal, it can be transformed into normal distribution. 

Most of the distributions are approximated with this distribution. 

 

Therefore, the standard normal distribution is used: 

 to test and estimate the confidence interval for a population mean and proportion of a 
normal distribution, 

 to test and estimate the difference of the means of dependent and independent 
populations, 

  to test and estimate the difference of the proportions of populations. 

  

HOW TO COMPUTE Z VALUES IN EXCEL AND IN SPSS? 

IN EXCEL: the mean (AVERAGE) and the standard deviation (STDEV) is needed to compute first, 
then the STANDARDIZE function is used to compute z scores. 
IN SPSS: In the menu choose Analyze ►Descriptive Statistics ►Descriptives, and then, in the 
dialogue box the option ‘Save standardized values as variables’ has to be checked, so the 
standardized values will appear in a new column of the data editor. 

HOW TO COMPUTE PROBABILITIES FOR A NORMAL VARIABLE IN EXCEL AND IN 
SPSS?  
IN EXCEL: The NORM.DIST function is used to compute normal distribution probabilities with 
the following arguments: the value of the function (x); the arithmetic mean of the distribution (μ); 
the standard deviation of the distribution (σ) and a logical value, which is set to FALSE to compute 
the probability P(x) or TRUE to compute the cumulative probability F(x). The NORMINV function 
is used to find the value x for which F(x) is equal to p. Later in Chapter 4, this function will be used 
to determine the critical value(s) for hypothetis testing. 
IN SPSS: The procedure is the same as shown before, using Pdf.Normal and Cdf.Normal functions. 
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1.6. Distributions Associated with the Normal Distribution (χ2, t, F) 

In this chapter the probability distributions most widely used in statistics are discussed. 

Chi-Square Distribution 

Let z1, z2, …, zν be a set of standard normal random variables (zi ~ N(0,1)), that are identical and 
independently distributed. The random variable X defined as the sum of the squares of these ν 
independent standard normal random variables has a χ2 (chi-square) distribution with ν degrees 
of freedom (denoted by ν, or abbreviated d.f.), X ~ χ2(ν):  

 =    =  1, … ,  

If X ~ N(μ,σ2), then  ~ χ2(1). If X ~ N(μ,σ2) and x1, x2, …, xn is a random sample from 

the population X with s sample standard deviation (see later in detail, in Chapter 2.5.), then ∑   ~ χ2(n), and   ~ χ2(n – 1). 

The χ2 curve starts at zero and extends to infinity (so it is positive valued), but the shape of the 
χ2 distribution depends on degrees of freedom (Figure 2). The χ2 distributions are positively 
skewed, but the degree of skew decreases with increasing degrees of freedom. 

Figure 2 Chi-square distributions 

 
Source: own edition 

As the degrees of freedom increases, the χ2 distribution tends to grow close to the normal 
distribution. The expectation and variance of a χ2 variable with ν degrees of freedom is: E(X) = 
v and Var(X) = 2v. 

The Chi-square distribution is used: 
 to test and estimate the confidence interval for a population standard deviation of a 

normal distribution using a sample standard deviation, 
 to test the independence between categorical variables (differences between expected 

and observed frequencies), 
 to test goodness of fit, 
 to test homogeneity of populations.  
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Student’s t Distribution 

Let Z ~ N(0,1) be a standard normal random variable, and  χ2 a chi-square random variable with 
ν degrees of freedom, Z and χ2 are independent. A continuous random variable X defined by: 

= χ ν 

is of a Student’s t-distribution with ν degrees of freedom X ~ t(ν). 

If X ~ N(μ,σ2) and x1, x2, …, xn is a random sample from the population X, then 
̅  
√  ~ t(n-1). 

This distribution is a generalization of the normal distribution, that is, the curve of the Student’s 
t distribution is similar to the normal distribution shape: 

 it is symmetric about the mean 0 (therefore tα = -t1-α) and 
 it is bell-shaped as the normal distribution, 
 however the shape of the t distribution depends on the degrees of freedom (Figure 3): 

as the number of degrees of freedom decreases, the curve flattens in the middle and has 
fatter tails (it is leptokurtic, that is the percentage of the distribution within 1.96 standard 
deviations of the mean is less than 95%, the relevant value for the normal distribution). 
As the number of degrees of freedom increases, the t distribution tends to the normal 
distribution, just as the χ2 distribution. 

Figure 3 Student t distributions 

 
Source: own edition 

The expectation and variance of a t variable with ν degrees of freedom are: E(X) = 0 (ν ≥ 2) and 
Var(X) = ν/(ν-2) (ν ≥ 3) that is, the standard deviation depends on the sample size, but is always 
higher than 1. 

Student’s t distribution is used when the population variance is unknown: 

 to test and estimate the confidence interval for a population mean, 
 to test and estimate the difference of the means of paired and independent populations. 
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The F Distribution 

The F distribution arises as the distribution of a ratio of variances. Let χ2
1 and χ2

2 be two 

independent chi-square random variables with ν1 and ν2 degrees of freedom, respectively. A 
continuous random variable X, defined as the ratio of two independent χ2 values divided by 
their degrees of freedom, has an F-distribution with ν1 and ν2 degrees of freedom 
X ~ F(n1-1,n2-1): 

= χ νχ ν  

Similar to the χ2 distribution, the F curve is positively skewed and positive valued, and besides, 
with increasing degrees of freedom it approaches the normal distribution, but the F distribution 
depends on two degrees of freedom (Figure 4). The expectation and variance of an F variable 

are: E(X) = ν2/(ν2-2) (ν2 ≥ 3) and Var(X) = . 

Figure 4 F distributions 

 
Source: own edition 

 
The F distribution is used: 

 to test two variances, 
 for testing the equalities of several sample means. 

The total area under the χ2, t and F curves is equal to one, and between any two values the area 
under the curve can be obtained by integration (beyond the scope of this textbook) for the 
normal distribution χ2, t and F statistical tables can be used (Tables A.2, A.3, A.4 in 
APPENDICES). 

The structure of the t and χ2-table is the following: the first column of the table (row headers) 
contains the degrees of freedom, and the column headers show the cumulative probabilities up 
to a specified value, while the table entries are the t and χ2 values, respectively. Because of the 
symmetry in the t table only the positive t-values are listed. If the degrees of freedom needed 
are not in the table, the closest smaller d.f. is used from the table, or interpolation can be applied. 
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The structure of the F-table is somewhat different as it is defined by two degrees of freedom. 
The first column of the table (row headers) contains the denominator degrees of freedom 
(denoted by ν2), and the column headers contains the numerator degrees of freedom (denoted 
by ν1), while the table entries are the F values.  

 

EXAMPLE 1.6.1 

What is the probability, that X is between 5.07 and 20.09, if X ~ χ2(8)? 

The probability of X falling between 5.07 and 20.09 can be calculated as: 
P(5.07 ≤ X ≤ 20.09) = P(X ≤ 20.09) − P(X ≤ 5.07) = 0.99 – 0.25 = 0.74 (from the χ2-table). 

What is the probability, that X is at least 1.86, if X ~ t(8)? 

The probability, that X is at least 1.86, is given by P(X ≥ 1.86) = 1 − P(X < 1.86) = 1 − 0.95 
= 0.05 (from the t-table). 

HOW TO COMPUTE PROBABILITIES FOR A χ2, t AND F VARIABLE IN EXCEL AND IN 
SPSS?  

IN EXCEL: the CHISQ.DIST, the T.DIST the F.DIST functions are used to compute probabilities 
with the following arguments: the value of the function (x); the number of degrees of freedom 
(Deg_freedom, in case of F distribution the numerator and the denominator degrees of freedom); 
and a logical value which, when set to FALSE, computes the probability P(x), and when set to TRUE, 
computes the cumulative probability F(x). CHISQ.INV, T.INV and F.INV functions are used to find 
the value x for which F(x) is equal to p. Later in Chapter3. and Chapter 4. these inverse functions 
will be used to determine the confidence interval and the critical value(s) for hypothesis testing. 
IN SPSS: The procedure is the same as with the other distributions, applying the Pdf.Chisq, Pdf.T, 
Pdf.F and Cdf.Chisq, Cdf.T, Cdf.F functions. 

Try to compute the z, t, χ2, and F tables, as shown in the APPENDICES! 
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2. INTRODUCTION INTO SAMPLING DISTRIBUTIONS 

The basic ideas of sampling will be considered in this chapter. Usually when analysing sample 
data, these can be thought of as a sample from a hypothetical population of infinite size, and 
we hope, that the sample units used for experimentation are sufficiently representative of the 
population about which inferences are to be made.  

2.1. Sampling Methods 

Data taken from a population, that contain every individual of interest, are fixed and complete, 
while data derived from a sample contain only some of the individuals, and vary from sample 
to sample. A parameter is a numerical measure of the population, while a statistic describes a 
feature of the sample. 

Because of constraints on time, money, or effort, it is usually impossible to collect all data from 
an entire population, thus only sample data are available for analysis. This means that inferences 
about a population parameter can only be made relying on some statistics. 

The sample is required to have the same characteristics as the population to describe a certain 
property of the population, which it is representing. There are many ways of sampling 
(Figure 5), samples can be selected from finite or infinite populations, with or without 
replacement. 

A random sample is a subset of the population, in which each individual is independently 
selected with a known nonzero probability. In case of this sampling methods it is possible to 
obtain unbiased results about the population from studying the sample. 

 A simple random sample (SRS) is defined as a random sample from the population, in 
which each sample of size n, and each individual of the population has the same and 
equal chance of being chosen. This is the basic, and because of the random number 
tables or generators, the simplest sampling technique, if a complete list of all individuals 
is available, and it is assumed, that all members of the population can be numbered 
sequentally. After the selection of random numbers from the numbers assigned to the 
population members, the units denoted by numbers corresponding to the randomly 
selected ones are included in the sample. For an infinite population the definition of the 
SRS is modified, by the requirement, that the selected items are independent. 

 

HOW TO GENERATE RANDOM NUMBERS IN EXCEL AND SPSS? 

IN EXCEL: there are two fuctions to generate random numbers. The RAND function (without any 
arguments) generates a random real number greater than, or equal to, 0 and less than 1; another 
possibility is to use the function RAND()*(b-a)+a to generate a number between a and b. The 
RANDBETWEEN function generates random integer numbers between a and b, the arguments of 
the function. The Data Analysis command in the Data tab also includes a Random Number 
Generation tool with different distribution methods. 
IN SPSS: In the menu choose Transform ►Compute, and then in the dialogue box type the name of 
a new variable as the target variable. Then, in the function box, a function has to be selected from 
different distribution methods with the specified parameters (e.g. RV.Uniform, RV.Normal), to 
generate random numbers of the specified distributions. 
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 In stratified sampling, the population is divided into at least two distinct, non-
overlapping groups, called strata, that share a common characteristic. Then a random 
selection is used for each stratum often in the same proportion as in the total population, 
and the obtained information is weighted in all calculations. The sample based on which 
the attributes of the target population are estimated is the total of the subsamples. 
If measurements within strata are very homogeneous, stratification may produce a 
smaller error, increased precision of estimates, than would be produced by a simple 
random sample of the same size, and requires fewer observations.  

 If the elements of the population are arranged in some natural sequential order, it is easy 
to get a random sample by systematic sampling. After selecting a random starting point 
(in space or in time) every kth element has to be selected for the sample. The location of 
the sample units is much easier to find, and the sample covers the population more 
uniformly in space or time, than SRS, but if the population is cyclic in nature, this 
technique does not give a random sample. 

Figure 5 Sampling methods 

Source: own edition 

 In the cluster (two-stage) sampling method first the population is divided into sections 
(e.g. plots), then some of these sections are chosen randomly, and then all members of 
the randomly selected sections (clusters) are included in the sample. If the population is 
very large, samples can be constructed through multi-stage sampling. First the studied 
population (e.g. the area) is divided into primary units (blocks), from which k primary 
units will be randomly selected, then m randomly selected secondary units within each 
of these k blocks will be chosen for observation. This technique is cost effective, and 
less time-consuming. Specialized books on sampling methods discuss this topic in more 
detail. 
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Non-probability samples are selected without the use of probability considerations or 
randomisation. Therefore, in the case of non-probability sampling it is not possible to estimate 
the sampling variability, while in the case of probability sampling it is. 

When statistics, that is, sample values are applied to estimate characteristics of a population, 
two types of error can occur: 

 a sampling error: is a natural consequence of taking samples, a sample statistic 
calculated from one sample will not be the same as those calculated from other samples, 
but the larger the sample, the smaller the sampling error. 

 a non-sampling error: is not related to the sampling process; but it may arise from 
incorrect methods of observation, poor measuring equipment and techniques, but non-
response and the errors in data processing operations can also cause a non-sampling 
error. 

Sampling errors are closely associated with sampling distributions. 

2.2. Sampling Distributions 

As discussed earlier, because to observe every element of a population is usually too costly and 
time-consuming, one of the main purposes of statistics is to obtain information about a 
population by a sample. But if only a subset of the population is considered in estimating one 
or more unknown parameters of the population, the appropriate statistics computed from a 
sample for characterizing the population is expected to vary. Despite the uncertainty resulting 
from the statistics changing from sample to sample, if the probability distribution of the sample 
statistic is known, generalizations from a sample statistic to an unknown population parameter 
can be made with confidence. 

So as the elements of a random sample are random variables, their values may vary from sample 
to sample, and the sample statistics computed from (functions of) these individual sample 
elements are also random variables. The sampling distribution of a statistic is the probability 
distribution of a statistic based on all possible simple random samples of the same size (n) from 
the same population. 

 

SIMULATIONS AND DEMONSTRATIONS 

Several simulations, online interactive applets and videos can be found in online to demonstrate the 
sampling and the sampling distributions of statistics and the use of the applets. In this textbook the 
Sampling Distribution Simulation of Online Statistics Education a Multimedia Course of Study of 
Rice University (http://onlinestatbook.com/stat_sim/sampling_dist/index.html) is used to estimate 
and plot the sampling distribution of various statistics with specified population distribution, sample 
size, and statistic. An animated sample from the population is shown and the statistic is plotted 
repeatedly, of which the sampling distribution can be estimated.  
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Figure 6. Sample elements and sample statistics as random variables 

 
Source: own edition based on the Sampling Distribution Simulation 

Later the mean and the spread of the sampling distribution of the most important sample statistic 
will be discussed. A sample statistic is unbiased, if the mean of the distribution of the sample 
statistic is equal to the population parameter being estimated. 

The values of a sample statistic are scattered around the population parameter, the scattering 
for larger samples is smaller – that is, larger samples better approximate the population 
parameter. It means, that the statistic is consistent. So the spread of the sampling distribution, 
i.e. the variability of the statistic is affected by the sample size, and by the sampling method, 
too. The spread of the sample statistic can be described by the standard deviation. The standard 
deviation of a sampling distribution is called the standard error of the statistic (SE). Standard 
errors measure the reliability of an estimate, and indicate, how well the sample represents the 
population. The standard error is commonly expressed as a plus/minus value around the sample 
statistic. 

  

EXAMPLE 2.1 

Apply the Sampling Distribution Simulation. Take a sample of five scores from a normally 
distributed population, then take another sample of five scores from the same normally distributed 
population. See that the values of the sample statistics (e.g. range, mean) computed from the random 
sample are random variables. Repeat this several times to see how the sampling distribution of the 
mean begins to be formed. An example is shown in Figure 6. 

Make your own simulation. Assume a population with some elements (e.g. 5), take samples (size of 
e.g. 2) in all possible ways – with and without replacement – and compute the sample statistics. 
Check the statistical theorem discussed later. 
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2.3. Sampling Distribution of the Mean 

By taking a sample of observations from a population, the sample mean is an estimate of the 
population mean. By taking many samples and computing the values of the sample means the 
distribution of the values of the sample mean for a given sample size could be obtained. The 
properties of the distribution of the sample mean are the following: 

 the mean of the distribution of the sample mean, that is, the mean of all possible sample 
means, is equal to the mean value of the distribution of individual observations, i.e. the 
population mean  = μ, 

 the spread of the distribution of the sample mean is less than that of the distribution of 
individual observations. 

The variance of all possible means of samples of size n from a population with standard 
deviation (σ) is called the variance of the mean and defined by: 

=  

So the standard deviation of the sample mean (the square root of the variance), called the 
standard error of the mean, has the same units as the original measurement, and decreases as 
n increases, that is, smaller samples are less reliable.  

The sampling distribution of the mean is 
 approximately normal (regardless of the sample size), if the distribution of individual 

meaurements is approximately normal, in this case the distribution can be converted to 
the standard normal distribution applying the following transformation: 
 =  → = ̅ = √̅  

 approximately normal, when the sample size gets sufficiently large (n ≥ 30) regardless 
of the population distribution (even with the nonnormality of the distribution of 
individual observations) = Central Limit Theorem, 

 influenced by the population distribution, when the sample is small. If n < 30, the 
distribution of individual meaurements should be mound-shaped and approximately 
symmetric (even better normal). 

 

  

EXAMPLE 2.2 

Apply the Sampling Distribution Simulation. Take a sample of 5 scores from a normally distributed 
population, repeat this 100, then 10000 times to see how the sampling distribution of the mean is 
formed. Then take another sample of 25 scores from the same normally distributed population, repeat 
this also several times. See that the means based on larger samples are closer to the parametric mean 
and means based on larger samples do not vary as much as means based on smaller samples. An 
example is shown in Figure 7. 
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Figure 7. Sampling distribution of the mean 

for a sample size of 5 and 25 with 100 and 10000 repeats, respectively 

 
Source: own edition based on the Sampling Distribution Simulation 

The mean of all possible sample means is equal to the population mean regardless of the 
sampling method (with or without replacement). However, in case of sampling without 
replacement the standard error of the mean is computed somewhat differently, as described 
earlier (applied for infinite populations and for sampling with replacement) 

= √ , where  is a finite population correction factor. 

In practice, the correction factor is omitted, when the sample size is less, than 5% of the 
population, because (N-n)/(N-1) → 1. 

 

  

EXAMPLE 2.3 

Relying on the values of statistics shown in on Figure 7, check that the variance of means is partly 
a function of the sample size and also a function of the variance of the items. The expected standard 
deviation of the mean is: 

n = 5 n = 25 = √ = 5.00√5 = 2.24 = √ = 5.00√25 = 1.00 

as can be seen in Figure 7 with 10000 repeats for both sample sizes. 

Check that the means of samples drawn from a population of any distribution approaches a normal 
distribution. An example is shown in Figure 8. 
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Figure 8. Sampling distribution of the mean for a normal, a skewed and a uniform 

population distribution for a sample size of 25 with 10000 repeats 

 
Source: own edition based on the Sampling Distribution Simulation 

To determine the SE of the mean the standard deviation of the population (parameter) should 
be known, which can seldom be calculated. It is also unlikely to have numerous samples of size 
n to compute the standard deviation of means directly, therefore it has to be estimated from a 
random single sample taken from the population. 

The intuitive estimator of σ is computed in the following way: = ∑ ̅
. 

But the sample standard deviation is defined by 

= ∑ − ̅− 1  

despite the denominator being expected to be n. See later in detail, in Chapter 2.5. 

The best estimate of the SE of the mean is the sample standard error of the mean: 

= √  

The quantity  ̅ − ̅̅ = ̅ − μ
√  

is no longer normally distributed, its distribution depends on the sample size n. Therefore, it is 
of the Student’s t distribution indexed by a parameter referred to as the degree of freedom of 
the distribution. 

The sample standard deviation, s is an approximation to the population standard deviation σ, 
which is a good estimate, when n is large (n ≥ 30). In this case the sample standard deviation 
approaches the standard deviation of the population, it does not vary considerably from sample 
to sample. As the sample size increases, the sample standard deviation converges to the 
population standard deviation, therefore the t distribution converges to the N(0,1) distribution, 
and the Central Limit Theorem can be applied. 

But if the sample size is small, s varies considerably, therefore the approximation gives the 
sample mean - that is standardized based on the sample standard deviation - more variability, 
which is distributed as Student’s t with ν = n-1 degrees of freedom. 
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2.4. Sampling Distribution of the Proportion 

To make inferences about a usually unknown population parameter (as for the mean), the 
distribution of other statistics such as sample proportion or variance can be examined. In some 
cases, the statistics are normally distributed like the mean; in other cases, only the statistics 
based on samples from a normally distributed population and/or based on large samples will be 
normally distributed. 

To draw conclusions about the proportion of the items, that possess the specified characteristic 
in the population (referred to as a ‘success’), the sampling distribution for the proportion has to 
be considered. In this case the population follows binomial distribution, the characteristics of 
which were discussed earlier in Chapter 1.4.1. As mentioned in Chapter 1.5. the binomial 
distribution can be approximated by a normal one, if np(1-p) ≥ 5 and in this case μ=np, and 
σ2=np(1-p). 

To make inferences about the unknown population proportion (P), the proportion based on 
samples (p) has to be examined, computed by 

=        

which sample proportion changes from sample to sample, as the sample mean. The proportion 
based on samplesdescribed by a binomial distribution, is approximately normal, when 
nP(1-P) ≥ 5, because the proportion is a linear function of the number of successes out of n 
binomial trials. 

Let x be a random variable (with mean μ; and standard deviation σ). The mean and the variance 
of its any linear function (x’ = a + bx) are μ’ = a + b·μ and σ’2 = b2·σ2, therefore 

μp=nP/n=P, and σp
2=nP(1-P)/n2=P(1-P)/n, so 

 the mean of all possible sample proportions is equal to the population proportion μp=P, 
 the standard error of the proportion, that is the spread of all possible proportions is 

calculated by the parameter of the distribution (P) and the sample size. In case of 
sampling without replacement the finite population corrector factor of the standard error 
of the proportion can be omitted, when the number of population is relatively large. 

  If n ≥ 30, the sampling distribution of the proportion approaches the normal 
distribution. In this case, as in the case of the mean, the distribution can be converted to 
the standard normal distribution as: 

=  → = =  

To determine the SE of the proportion, the parameter (P) must be known, but most often it is 
unknown. The best estimate of the SE of the proportion is the sample standard error of the 

proportion. While =  is often seen to estimate the SE of the proportion, Zar (2010) 

highlights, that it is an underestimate. The =  is the best estimator, but when n is 

large, the difference between the two estimators is slight. 
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2.5. Sampling Distribution of the Variance 

To characterize the variation, the standard deviation is usually used as a measure of dispersion. 
However, because the techniques applied for estimating the standard deviation of a population, 
as well as those applied for testing hypotheses for it, employ the sample variance rather than 
the standard deviation, it is usual to talk about variance instead of standard deviation. The 
conclusions about the variance are easily converted into conclusions about the standard 
deviation, as the latter is the square root of the former. 

To make inferences about the unknown population variance (σ2), the adjusted sample variance 
(s2) has to be examined. The formula of unbiased estimator of the population variance is 

= ∑ − ̅− 1  

If the true mean is unknown, to calculate the sample variance, the sample mean has to be 
calculated first. As the x values of the sample are going to be closer to the sample mean x̄ than 
to true mean μ, the true variability of the data is underestimated by considering squared 
deviations from the sample mean rather than squared deviations from the true mean. To correct 

EXAMPLE 2.4 

Nutritional influences were examined on reproduction of sheep (Márton, 2018). The following table 
contains the number of ewes lambing / lambing multiple, on the basis of which the multiple lambing 
rate can be calculated: 

Number of ewes Lambing - Lambing 
multiple 

Multiple lambing 
rate, % (p) 

sp, % 

Control 38 8 8/38=21.1 6.7 
Flushed with flocked lupine 40 22 22/40=55.0 8.0 

The proportion, based on sample, estimates the unknown population proportion and sp estimates the 
SE of the proportion. In case of control group, the calculation: 

= 1 −− 1 = 0.211 ∙ 0.78937 = 6.7% 

EXAMPLE 2.5 

The rate of tomato seedling survival in a particular plantation is 0.95 (P). If a sample of 100 seedlings 
is taken from this population, what is the probability, that we obtain a survival rate of less, than 0.90 
(p)? 

= 1 − = 0.95 ∙ 0.05100 = 0.022 

P(P < 0.90) = P(Z < ) = P(Z < 
. .. ) = P(Z < -2.29) = 1 – 0.989 = 1.1% 
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this bias and to obtain an unbiased estimator, the value n-1 rather than n should be used in the 
division. 

As ∑ − ̅ = 0, only n-1 observations used in the calculation are independent. The term 
‘degrees of freedom’ will be used later, when making inference from samples using Student’s 
t, 2 or F distributions. The degrees of freedom are equal to the number of independent 
observations connected with the estimation of variance, that is, the total number of sample 
points minus the number of estimated parameters used in the calculation of the variance. 

Naturally the sample variance changes from sample to sample, thus it is a random variable. 
Since the mean of all possible sample variances of size n is equal to the population variance, 
the sample variance is an unbiased estimator of the population variance. The sampling 
distribution of the variance is positively skewed with values from zero to infinity. What type of 
distribution is this? 

Let X ~ N(μ,σ2) be a random variable, which can be standardized. The sum of the square of the 
new random variable Z ~ N(0,1) has a chi-square distribution with n degrees of freedom as 
discussed in Chapter 1.6.  

 = −  ~  .  
Because the population mean is unknown for the standardization, it is substituted by the sample 

mean losing 1 degree of freedom. As ∑ = , the ∑ −  is equal to − 1 , therefore − 1  ~  . 
The sampling distribution of s2 is a chi-square distribution with n-1 degree of freedom: 

~ − 1    
but in practice the distribution of − 1  ~   

is used. 

So the sample variances calculated from different random samples of size n changes from 
sample to sample around their mean, which is equal to the population variance σ2. If the 
population, from which the samples were taken, is normally distributed, the sampling 
distribution of the variance will follow a 2 distribution with n-1 degrees of freedom. 
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2.6. Sampling Distribution of the Difference or Ratio of Statistics 

In this section the comparison of parameters will be considered. If the question is ‘Do the data 
of one population vary significantly from data of another one?’, the statistics from two different 
populations have to be compared. Two cases of sampling distributions can be distinguished: 

 independent populations: the variables of populations are independent, the units of the 
two populations can not be matched in pairs, they are completely unrelated (either n = 
n1 = n2 or n1 ≠ n2), 

 dependent/paired populations: the observations occur in pairs, or the units of the two 
populations can be matched in pairs by some special characteristics (n1 = n2 pairs). In 
this case the sampling from one population marks the sample of the other population, 
that is, a new – one – population can be created (e.g. before and after the treatment 
cases). 

2.6.1. Sampling distribution of the differences calculated from independent 

populations 

Let x1 and x2 be two independent random variables (with respective mean μ1 and μ2; and 
standard deviation σ1 and σ2). The mean and the variance of their linear combination 
(x’ = ax1 + bx2) are μ’ = a μ1 + b μ2 and σ’2 = a2σ1

2 + b2σ2
2. If the difference of two independent 

variables is examined that is x’ = x1 – x2, a = 1 and b = -1, the mean and the variance of their 
linear combination are μ’ = μ1 – μ2 and σ’2 = 12·σ1

2 + (-1)2·σ2
2 = σ1

2 + σ2
2. 

Assume two independent random variables with their own distributions. They may represent 
the same quantitative feature, but measured in two different populations, so their distributions 
may differ. Independent random samples of size n1 from the x1 distribution, and of size n2 from 
the x2 distribution are taken. 

First, two sets of all possible sample means ̅  and ̅ ) are calculated based on the samples, 
then a new random variable −  is created by calculating all possible differences of ̅ − ̅ , which changes sample to sample. On the basis of the mean and the variance for the 
linear combination of independent random variables – discussed above, the mean of all possible 
differences is equal to the difference of the two population means ( ̅ − ̅ =̅ ̅ = ̅ − ̅ =  – . 

As the variance of the means of samples of size n from a population is  = , the variance of all possible differences is: 

= +  

In case of sampling without replacement the finite population corrector factor of the standard 
error is required, but it can be omitted when the population size is relatively large: 

= −− 1 + −− 1  
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Similar to the distribution of the mean (as discussed earlier in Chapter 2.3.) the variable ̅ − ̅  has normal distribution: 

 if x1 and x2 have normal distributions, 
 if x1 and x2 have not exactly normal distributions, but both n1 and n2 are 30 or larger, 

and the central limit theorem assures the approximately normal distribution. 

In this case the distribution can be converted to the standard normal distribution  

= − → = ̅ − ̅ − −
+  

If σ1 and σ2 are unknown, the sample standard deviations, s1 and s2 are the approximation to the 
unknown population standard deviations. In this case the difference of the means is distributed 
as Student’s t: 

= ̅ − ̅ − −
 

1. If the populations are normal or approximately normal (mound-shaped and symmetric) 
or n1 and n2 ≥ 30 

= +  
2. If the sample sizes are small, but it is assumed that σ1 = σ2 = σ, then the pooled standard 

deviation is used to estimate the common 

= − 1 + − 1+ − 2  
and the standard error of the mean difference  = +  

with ν = + − 2 degrees of freedom. The expression simplifies to the former 
expression of the standard error of the mean difference, if the number of observations 
is equal in two samples, that is n1 = n2 = n, 

3. If the sample sizes are small, but it is not assumed that σ1 = σ2 = σ, then 

= +  
but ν = smaller of − 1  − 1. 

Later on estimating the ratio of variances (see Chapter 3.1.6) and statistical test for variances 
can help to decide about the homogeneity of variances. 
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The difference of two unknown independent population proportions can be estimated in a 
similar way. In this case the point estimator is the difference between two proportions of 
independent samples with sample sizes of n1 and n2, as  − ) = P1 – P2. 

As the variance of the proportions of samples of size n from a population is  = , the variance of all possible differences is: 

= 1 − + 1 −
 

EXAMPLE 2.6 

At the Georgikon in Hungary an internationally significant grapevine collection was established in 
1803, aiming to introduce new varieties into the practice. Using the data of GRAPEVINE 
VARIETIES database (.xls and .sav) calculate the standard error of the difference between the 
means: Pinot Noir – Kövérszőlő, Chasselas Blanc – Cabernet Sauvignon, Pinot Noir – Cabernet 
Sauvignon. 

Pinot Noir – Kövérszőlő Suppose that the population standard deviations are not known, but can be 
estimated from two representative samples of size 34 and 30. As n1 = 34 and n2 = 30 ≥ 30, the 
standard error of the difference between two means is calculated by the following formula 

= +  

The sample standard deviation of Pinot Noir is s1 = 20.84g and the sample standard deviation of 
Kövérszőlő is s2 = 61.62g, so the standard error of the difference between the means is 

= 20.8434 + 61.6230 = √139.35 = 11.80  

Chasselas Blanc – Cabernet Sauvignon Assume that the variances of the two populations are 
unknown and not equal σ1 ≠ σ2. The standard error of the difference between the means can be 
determined by the same way, but the variable has Student-t distribution, as the sample sizes are less, 
than 30. 

= 40.6120 + 23.8520 = √110.88 = 10.53  

Pinot Noir – Cabernet Sauvignon Because the sample size of Cabernet Sauvignon is less than 30 and 
it can be assumed that σ1 = σ2 (the standard deviations of the samples are close to each other, later 
test the equality of two population variances – see section 4.4.1) the pooled standard deviation is 
used to estimate the common 

= − 1 + − 1+ − 2 = 34 − 1 20.84 + 20 − 1 23.8534 + 20 − 2 = 21.99  

and the variance of the mean difference 

= 21.99 134 + 120 = 6.20  
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If large sample sizes are provided, that is, the binomial distribution approaches the normal 
distribution, the distribution can be converted to the standard normal distribution 

= − → = p − p − −1 − + 1 −  

To determine the SE of the proportion difference, the parameters (P1 and P1) should be known, 
but they are usually unknown. If they differ considerably from each other, in the formula the 
sample proportions can be used instead of unknown population proportions. 

2.6.2. Sampling distribution of the differences calculated from paired populations 

A special case of the sampling distribution of the differences between two means is, when the 
samples are taken from dependent populations. In this case the starting point is to create data 
pairs and calculate each difference of − = , then compute 

 the mean ̅, the point estimate of the difference of two unknown population means and 
 the standard deviation sd of the n differences. 

If the variable ̅ − ̅ =  has normal distribution, or n is 30 or larger (central limit theorem) 
the distribution can be converted to the standard normal distribution 

=  → =  

To determine the SE of the difference , the population standard deviation of the differences 
(the parameter) should be known, but it is seldom available. It can be estimated by the sample 
standard deviation of the differences: 

= ∑ − ̅− 1 → = ∑ − ̅− 1  

but in this case the difference of the means is distributed as Student’s t distribution 

= ̅ − = ̅ −
√  

with ν = n – 1 degrees of freedom. 

 

EXAMPLE 2.7 

The effect of five Hungarian herbs and spices, garden thyme (Thymus vulgaris L.), sage 
(Salvia offi cinalis L.), rosemary (Rosmarinus offi cinalis L.), lemon balm (Melissa offi cinalis L.) 
and peppermint (Mentha x piperita L.) were studied on the development of Botrytis cinerea Pers. 
24, 48, and 72 hours after the treatment (Cseh et. al., 2015). During the experiment hot water and 
ethanol extracts were used and disc diffusion method was applied. As the petri dishes were marked 
- numbered, the paired samples method was used to examine the effect of the time. See the results 
later in EXAMPLE 4.11. 
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2.6.3. Sampling distribution of the ratios 

The ratio of two unknown population variances is estimated by the ratio of two sample 
variances. The ratio of /  changes from sample to sample, but the mean of all possible 
ratios is equal to the population ratios / ) = σ1

2 / σ2
2. As discussed earlier in 

Chapter 1.6., the variable X, defined as the ratio of two independent χ2 values divided by their 
respective degrees of freedom, has an F-distribution with ν1 and ν2 degrees of freedom: 

= χ νχ ν . 
In Chapter 2.5. it was proved that − 1  ~  . 
Therefore 

= χ νχ ν = − 1− 1− 1− 1 = s σs σ ~ , . 
~ ,  

 

 

  

EXAMPLE 2.8 

Broiler chickens were fed with four types of feeds (four types of soybean A, B, C, CP). Types A and 
B are new varieties (with less antinutritive material), C is an old type and CP is Type C flushed with 
flocked lupine. The experimental animals were housed in 6 cages per treatment. Individual weights 
were measured in grams on days 10, 24, and 42. 

Using the data of BROILER_CHICKENS database (.xls and .sav), calculate the ratio of the variances 
of the new varieties. The quotient is expressed with the larger sample variance being always in the 
numerator. 

On days 
Type A Type B The ratio of the larger variance 

divided by the smaller one 
variances 

10 1509.6 1367.1 1.104 
24 26202.7 19509.1 1.343 
42 104207.9 105688.3 1.014 

Later estimate and test the ratio of the variances. 



45 

 

 

3. ESTIMATION OF PARAMETERS 

The main object of an experiment, and the major goal of statistical analysis related to the 
experiment, is to draw inferences, to estimate or test certain quantities of a population by 
examining a sample from that population. To obtain all the data of an entire population is 
difficult, because of constraints on time, money or effort. Therefore, sample statistics are used 
to draw conclusions about the population parameter, based on information obtained from a 
sample, knowing that this information is incomplete. This process is called statistical inference. 
To evaluate the reliability of the inference, the probability distribution of the statistic is used. 

Statistical inference, the process of drawing a conclusion, can be divided into the two main 
areas of estimation and hypothesis testing. Estimation is concerned with the estimation of the 
value of a population parameter, hypothesis testing is concerned with making a decision 
concerning the value of a population parameter. How is a specific random sample applied to 
estimate an unknown parameter of the population? Statistical estimation can be classified to 
two categories: point estimation and interval estimation.  

3.1. Point Estimation 

The sample statistics calculated from the sample data are estimates of the population 
parameters, so to estimate any population parameter θ, a sample statistic is computed. A point 

estimate is a single numeric value, computed from a sample of size n taken from the population. 
The rule or the function, that describes how to calculate this single number estimate from the 
sample observations, is called a point estimator . So the point estimator is a random variable, 
the values of which vary from sample to sample. Summarizing, the symbol of the unknown 
population parameter and the ‘best guess’ statistic are presented in Table 4, as discussed earlier 
in Chapter 2.2. 

Table 4 The symbol and the estimate of the parameters 

 Parameter The sample statistics Estimate of standard error 

Mean μ ̅ =  

Difference 
(independent) 

μ1 – μ2 ̅ − ̅  = +  

Difference 
(paired) 

μ1 – μ2 ̅ − ̅ = ̅ → = √  

Ratio 
(paired) 

μ1 / μ2 
̅̅ = ℎ → = ℎ + − 2  

Proportion P p = 1 −
 

Difference P1 – P2 p1 – p2 = 1 − + 1 −
 

Variance σ s  
Ratio σ1 / σ2 s1 / s2  
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The estimate of standard error, and later the margin of error or the sample size calculations are 
only discussed in the cases of the symmetric z and t distributions. 

Point estimators are easy to find. The methods of moments and the maximum likelihood method 
are the most often used procedures for finding a point estimator. The characteristics – unbiased 
and consistent – were mentioned earlier in connection with the statistics. Complementing these, 
the quality of a point estimator  is judged according to the following characteristics: 

The estimator should be  
1. unbiased: E( ) = θ, 
2. efficient, that is, if there are several unbiased estimators for a population parameter, the 

best, most efficient one is the estimator with the smallest variance E[ − ], 
3. consistent: as n → ∞,  → θ. 

Although the adjusted sample variance is an unbiased estimator of the population variance, the 
sample standard deviation s is not an unbiased statistic, but if the sample size is greater than 30, 
the bias is negligible. 

The values of the point estimator vary from sample to sample, but the point estimate is probably 
close to the parameter. At the same time, it is usually not exactly equal to the parameter even 
when the estimator is unbiased, efficient, consistent and drawn from a large random sample, 
thus point estimates have limitations. 

3.2. Interval Estimation 

When using ̅ as a point estimator for μ, s as a point estimator for σ, or p as a point estimator 
for P, the computed point estimate does not reveal anything about the potential size of the error. 
As the population parameter is unknown, the actual sampling error or error of estimate, that 
is the magnitude of the difference between the statistic and the true value │ ̅ – μ│, │s – σ│, or 
│p – P│ is unknown, too. At the same time the larger the sample size, the better the estimate. 
But with a point estimator the role of the sample size is ignored. So the point estimate cannot 
reveal, how accurate the estimate is. Both of these problems are solved by using the interval 
estimation. 

As discussed earlier, a point estimator  is a random variable with a probability distribution. It 
is possible to determine a confidence interval as an interval estimation of a parameter θ for a 
given probability, if the probability distribution is known. If this distribution is symmetric, the 
interval estimator can be written in the form:  – E ≤  ≤  + E 

where the maximum error of estimate (represented by E), that determines the interval limits, 
depends on the probability distribution of the point estimator. 

Assume that  has a normal distribution N(μ,σ2) = N(θ, ). Define z, a standard normal 
variable: 

= −
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As  has a normal distribution, and α is 
a value between 0 and 1, the area under 
the curve in the interval [- z1-α/2; + z1-α/2] 
represents, that the probability of the 
standard normal variable lying in that 
interval is 1-α (Figure 9): 

P(-z1-α/2 ≤ z ≤ z1-α/2) = 1 – α 

Replacing: 

− /  ≤ ≤  /  =  1 –    

− ⁄   ≤ ≤  + ⁄ =  1 –    
where ± z /   is the interval estimator and determines the confidence interval. It can 
be interpreted as the probability of finding the unknown, true population parameter in the 
interval of the confidence is 1-α regardless of the actual value  calculated from the sample. 
Therefore, a confidence interval can be interpreted as follows: if all or a large number of 
samples of size n are drawn from a population and for each sample a 1-α confidence interval is 
calculated, then 100·(1-α) of these intervals are expected to contain the true population 
parameter, and only 100·α of them do not. For example, with α=0.05, only 5 of 100 (or 1 in 20) 
intervals do not contain the true mean (Figure 10). 

Figure 10. 95% Confidence intervals for estimation of the population mean 

 

Source: based on Kozak et al. (2008) 

Figure 9. Confidence Level 1-α and Corresponding 

Critical Values on the Standard Normal Curve 

 
Source: based on Kozak et al. (2008) 
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If the estimator has approximately normal or Student’s t distribution, then the general 
expression for the confidence interval is: 

Point estimate ± (value of standard normal or Student’s t variable for 1-α/2) ∙ standard error 

This probability statement is expressed as ‘confidence’, where the reliability of the estimate is 
measured by the confidence level or degree of confidence 1-α. The most frequently used α 
values are 0.05, 0.1 and 0.01, viz. the common probabilities used for confidence intervals are 
95%, 90% and 99%, respectively. The higher level is the confidence, the wider is the interval. 

 

The value z1-α/2 is the critical value for the confidence level 1-α, the lower and the upper bounds 
of the interval are the confidence limits. The lower confidence limit is denoted by LCL and the 
upper confidence limit is denoted by UCL. 

The result of the interval estimation concerning the error of estimate gives us the opportunity 
to compute the maximum error of the estimate (represented by E), if the sampling distribution 
of  is symmetric: 

=  −2 =  / ∙   / ∙  

Beside the confidence level, the sample size affects the size of the interval, too. The larger of 
the representative sample size, the narrower is the width of the interval, so the greater the 
precision, due to the smaller SE. 

 

The process of the determination of a confidence interval can be summarized in the following 
steps: 

 find a point estimator with a known probability distribution, 
 choose a confidence level (1-α), 
 compute the point estimate and the standard error from the sample, then 
 calculate the interval limits using critical values for the confidence level 1-α. 

  

EXAMPLE 3.1 

Assume a 95% confidence interval. What will happen to this confidence interval if the confidence 
level is increased to 99%, or is decreased to 90%? 

Check that the value of the z1-α/2 increases as the confidence level is higher, thus opens the confidence 
interval. 

1-α 1-α/2 z1-α/2 
90% 0.950 1.65 
95% 0.975 1.96 
99% 0.995 2.58 

EXAMPLE 3.2 

Assume a 95% confidence interval with a sample size of 100. What will happen to the confidence 
interval, if the confidence level is the same, but the sample size decreases to 81 or increases to 121? 
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3.3. Interval Estimation for the Mean and the Sum of Scores 

For estimating the population mean, first a simple random sample of size n of x values has to 
be drawn from a population. The sample mean ̅ is the point estimate of the population mean 
μ. Assume that the variable x has a normal distribution. If this cannot be assumed, then use a 
sample size of n ≥ 30. The process of the determination of the 1 – α confidence interval for the 
mean is as follows: 

Interval estimation for the mean 

The point estimator is the sample mean: ̅ 
σ is known 

(almost never happens) 
σ is unknown 

(most common) 
↓ ↓ 

Use normal distribution Approximate σ by s 
Use Student's t distribution 

↓ ↓ 
The standard error of the mean: = √  

The standard error of the mean: = √  

in case of sampling without replacement multipy it by the 
finite population correction factor 

↓ ↓ 
Confidence interval for the mean: ̅  ±   =  ̅  ± / √   

Confidence interval for the mean: ̅  ±   =  ̅  ±  / √  

for the confidence level 1 – α, so that  ̅ − / √ ≤   ≤  ̅ + / √ =  1 −    ̅ − / √ ≤   ≤  ̅ + / √ =  1 −   

 

HOW TO ESTIMATE THE POPULATION MEAN IN EXCEL AND IN SPSS? 

Assuming σ is known, IN EXCEL the function CONFIDENCE is used to compute the maximum 
margin of error E with the following arguments: the probability of the interval containing the 
population mean (1–α), the population standard deviation σ, and the sample size n. Calculate the 
sample mean by the function AVERAGE, and the endpoints of the confidence interval are computed 
as ̅ ± E. 
Assuming σ is unknown, Excel and SPSS determine the confidence interval using the Student’s t 
distribution. 
IN EXCEL: In the menu choose Tools ➤ Data Analysis ➤ Descriptive Statistics, then in the 
dialogue box check Summary statistics and check Confidence level for Mean (change the desired 
confidence level, if it is necessary). Based on the Mean (sample mean, ̅) and the Confidence Level 
(margin of error, E) the confidence interval can be easily constructed by computing ̅ ± E. 
IN SPSS: In the menu choose Analyze ► Descriptive Statistics ► Explore … Then in the dialogue 
box move the quantitative variable x to the Dependent List. To change the level of confidence, click 
on ‘Statistics’ and check the ‘Descriptives’ box (it is automatically checked). The Explore procedure 
produces a variety of statistics, including the confidence interval in the Output Window. 

HOW TO ILLUSTRATE THE CONFIDENCE INTERVAL OF THE MEAN IN SPSS? 
In the menu choose Graphs ► Legacy Dialogs ► Error Bar, and select the Simple option. In the 
dialogue box move the quantitative variable x to the Variable. Bars represent the Confidence interval 
for Mean. The level of confidence can be varied. 
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EXAMPLE 3.3 

At the Georgikon, in Hungary an internationally significant grapevine collection was established in 
1803, aiming to introduce new varieties into the practice. In a random sample the average weight of 
the Pinot Noir cluster was examined. 

The sample mean ̅ is 70.39g. The standard error of the mean is: = √ = .√ = 3.57 . 

The value E = t1-α/2 √ = 2.03 · 3.57 = 7.27 . 

It is concluded with 95% confidence, that the interval from 63.12g to 77.67g is an interval, that 

contains the population mean weight μ. The extent of the error of the estimate is: = . . = 10.3% 

Check the similarity and the difference of the presentation of descriptipve sample statistics in the 
outputs of Excel and of SPSS. 

SPSS output 

 

EXCEL output 

Pinot Noir  
Mean 70,39441 → Point estimate 

Standard Error 3,573903 ↓ 
Median 68,02  

 

95% Confidence limits for the mean 

 ̅ ± E = 70.39 ± 7.27 
 

Between 63.12g and 77.67g 

Mode #N/A 
Standard Deviation 20,83926 

Sample Variance 434,2747 
Kurtosis -0,37341 
Skewness 0,617711 
Range 78,07 
Minimum 40,65 
Maximum 118,72 
Sum 2393,41 
Count 34 ↑ 
Confidence Level (95,0%) 7,271161 → The maximum error of estimate 
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Since the sample mean is a random variable, the confidence limits are also random variables. 
The probability of this interval ̅ ± E containing the population mean is 1–α. In other words, 
drawing many random samples of size n and computing the confidence interval for the mean, 
the proportion of all intervals containing the population mean is 1–α. 

The margin of error is the half of the width of the confidence interval, and it expresses the extent 
of the error of estimate. It can be expressed as a relative measure, as a percent of the true value 
or, if the true value of the population mean is not known, as a percent of the estimate (sample 
mean). 

The width of the confidence interval, that is, the extent of the error of the estimate depends on 
three factors: 

 the larger the sample size, the narrower the interval, 
 the greater the variability, the wider the interval, 
 the larger the confidence (the smaller the α), the wider the interval. 

 

EXAMPLE 3.4 

Use the sample and the data of EXAMPLE 3.3. 

Illustrate the confidence interval of the means in SPSS. 

 
For the Pinot Noir clusters, the interval from 63.12g to 77.67g contains the population mean weight 
μ with 95% confidence, while for Kossuth szőlő the confidence interval is from 131.66g to 159.89g, 
as it can be seen in the output. 
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The sum of scores is equal to the mean multipled by the number of observations. The sample 
mean is the unbiased point estimator of the population mean and the multiplication does not 
change the characteristic of the mean. Therefore, the sample mean multiplied by the number of 
the population (N) is the point estimator of the population sum of scores and the confidence 
interval for the mean multiplied by N is the confidence interval for the population sum of scores. 

For planning a statistical study, it is a good idea to decide in advance on the confidence level 
of statistical research projects. The value of the maximum acceptable margin of error E depends 
on the requirements of the project and the practical nature of the problem. As the confidence 
interval expresses the precision of the estimation and as discussed earlier, it increases as the 
sample size increases, we can ask the question: ‘How large sample should be drawn to reach 
the desired margin of error chosen for the research project?’ The required sample size for a 
future sample can be estimated relying on the selected E. To determine the minimum sample 
size that gives the maximum E error of estimate for a specified confidence level, the formula is 
solved:  =  / √ , so that 

= / ∙
 

assuming naturally that the distribution of sample means is approximately normal. If the result 
(n) is not an integer number, it should be rounded up to the next integer number. 

If σ is unknown, the unknown variance of a normal population can be approximated by a sample 
estimate (s) of a preliminary study with a sample of 30 or larger elements. Then  =  / √ , so that 

= / ∙
 

There is a basic difficulty in the formula, because the critical value t depends on the unknown 
sample size n. The solution may be an approximation: guess a suitably large sample size n, and 
use this to compute E, estimate the resulting sample size, then correct the critical value. In this 
case do not forget that the reliability of the estimation depends on the accuracy of the σ estimate. 
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3.4. Interval Estimation for the Mean for Stratified Sampling 

In stratified sampling, as discussed earlier in Chapter 2.1. Sampling methods, the population is 
partitioned into non-overlapping groups, called strata. The principal reasons for using stratified 
random sampling rather than simple random sampling include: 
• Stratification may produce a smaller error of estimation, than a simple random sample of 

the same size. This result is particularly true, if measurements within strata are very 
homogeneous. 

• The cost per observation in the survey may be reduced by stratification of the population 
elements into convenient groupings. 

• Estimates of population parameters may be desired for subgroups of the population. 

For stratified sampling the point estimate of the population mean is the weighted mean of the 
strata sample means ̅ : ̅ = ̅  
and the SE of the mean is the weighted mean of the strata sample standard deviations sj: 

̅ = 1 − = 1 − ∑ − 1− 1  

where: 
k is the number of strata, 
Nj is the number of units in stratum j and 
N = N1 + N2 + ... + Nk is the total number of units in the population, 
nj is the sample size taken from stratum j, and n = n1 + n2 + ... + nk 

and the confidence interval for the mean for the confidence level 1–α is  ̅  ±  / ∙ ̅ . 

EXAMPLE 3.5 

Use the sample and the data of EXAMPLE 3.3. 

The desired margin of error chosen for research project is µ = 5%. The unknown population mean 

is estimated by the sample mean. So the desired error of estimate is E = 70.39·0.05 = 3.52g. How 
large a sample should be drawn to reach the desired margin of error with the same confident? 

= / ∙ = / ∙ 20.843.52  

Start with ν = ∞ degrees of freedom, when t0.975 = z0.975 = 1.96 

= 1.96 ∙ 20.843.52 = 134,65~135 

The sample size cannot be recalculated, because this size is fit to the degrees of freedom. So the 
required sample size is 135 to reach the desired (5%) maximum margin of error with a 0.95 
confidence level. 
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3.5. Interval Estimation of Proportion and Variance 

As it was discussed in Chapter 2.4., the point estimator of the unknown population proportion 
is the sample proportion p = f/n, where f is the number of successes of n observations. As the 
sampling distribution of the proportion approaches the normal distribution if n ≥ 30 and p is 
greater than 0 and smaller than 1 (or np ≥ 5 and n(1-p) ≥ 5) , then − ⁄ ≤  ≤  ⁄ =  1 –  , 

that is − ⁄ ≤  = ≤  ⁄ =  1 –   

Rearranging the inequality and using the estimate p (when P is unknown) 

− ⁄ 1 −  ≤   ≤  + / 1 −  =  1 –  .  
From the formula the maximum margin of error of the proportion estimation is 

 =  ⁄ 1 −  
Based on the desired E and a specified level of confidence, the required sample size for a future 
sample can be estimated in the same manner, as for the sample mean (Kozak et al., 2008): 

= / 1 −
 

EXAMPLE 3.6 

The total yield of apple trees needs to be estimated on a farm, where there are three types of apples, A, 
B and C. Therefore, a stratified random sample is taken, the sample size is 10% of the population in 
each stratum, respectively. The results of the sampling are shown in the table below: 

Type Number of elements 

in the sample 
Sample statistics (kg/tree) 
Mean Std. deviation 

A 100 37 7 
B 100 34 9 
C 200 35 8 

Construct a 95% confidence interval of the average yield per apple tree for type ‚A’ apples, of the 
average yield of the farm and of the total yield of the farm (altogether 4000 trees). 

The point estimate of the average yield of the farm is: ̅ = 100 ∙ 37 + 100 ∙ 34 + 200 ∙ 35400 = 14100400 = 35.25 /  

The SE of the mean 38.0144.0
400
399

8199999799

4000

400
1

222












 xs kg/tree 

The confidence interval for the total farm yield is: 4000 ∙ [35.25 ± 1.96 ∙ 0.38] = [138 t; 144 t] 
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assuming naturally that the distribution is approximately normal. If the result (n) is not an 
integer number, it should be rounded up to the next integer number. The increase of the sample 
size may be necessary to ensure the large-sample requirement (np ≥ 5 and n(1-p) ≥ 5). 

 

As it was discussed in Chapter 2.5., for estimating the population variance, the adjusted sample 
variance has to be calculated first, as the point estimate of the true variance. The sampling 
distribution of the variance will follow a 2 distribution with n-1 degrees of freedom, if the 
population, from which the samples were taken, is normally distributed N(μ,σ2). 

Assume that the variable x has a normal distribution. The process to determinate the  
1–α confidence interval for the variance is: 

Interval estimation for the variance 

The point estimator is the adjusted sample variance: S2 

that can be transformed into a  =   random variable. 

P( /  ≤   ≤  / ) = 1 – α (see Figure 11), that is, 

P( /  ≤  ≤  / ) = 1 – α, after rearranging: 

P(
 /  ≤  ≤

 / ) = 1 – α 

  

EXAMPLE 3.7 

Using the sample and the data of EXAMPLE 2.4, find the 95% confidence interval for the unknown 
population proportion. Check that the number of trials is large enough to justify a normal 
approximation to the binomial distribution. 

For the control np = 38 ∙ 0.211 = 8 ≥ 5 and n(1-p) = 38 ∙ (1 – 0.211) = 30 ≥ 5, the margin of error of 
the proportion estimation is E = 1.96 · 0.067. 

 Multiple lambing 
rate (p) 

sp 
Lower 
bound 

Upper 
bound 

Control 21.1% 6.7% 8.1% 34.0% 
Flushed with flocked lupine 55.0% 8.0% 39.6% 70.4% 

If a 95% confidence level is needed for the margin of error in estimating the confidence interval 
around the population proportion not to exceed 0.1, how large a sample is required? 

= 1.96 ∙ 0.211 1 − 0.2110.1 63.95 ≈ 64 

The required sample size is 64 to maintain a maximum margin of error of 0.1 with a 0.95 confidence 
level.  
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Figure 11. Confidence Level 1-α and the Corresponding Critical Values on the   Curve 

 

Source: Kozak et al. (2008)  

While for estimating the mean the equation is valid for large samples, even if the distribution 
of the population is not normal, this equation is only valid for samples taken from a normally 
distributed population. In contrast to the confidence interval for the mean and the proportion, 
the confidence interval for the variance is not symmetric. 

 

3.6. Interval Estimation of Differences and Ratios 

As discussed in Chapter 2.6., the point estimator of a difference or ratio of unknown parameters 
is the difference or ratio of the sample statistics. Because the estimator of the difference between 
two means and the estimator of the difference between two proportions have approximately 
normal distributions, the general expression for the confidence interval is: 

Point estimate ± (value of standard normal or Student’s t variable for 1-α/2) ∙ standard error 

Assume, that variables x1 and x2 have normal distributions. If this cannot be assumed, then use 
sample sizes of n1 ≥ 30 and n2 ≥ 30. The process to determine the 1 – α confidence interval for 
the difference between the means of independent populations is: 

  

EXAMPLE 3.8 

Using the sample and the data of EXAMPLE 3.3, find the 95% confidence interval for the unknown 
population variance assuming that the variable x has a normal distribution. − 1

 / ≤   ≤ − 1
 /  

The sample standard deviation of the 34 measurements is 20.84, that is, n = 34, s = 20.84, while the 

  random variables are  . / = 19.0,  . / = 50.7, so 

34 − 1 20.8450.7 ≤   ≤ 34 − 1 20.8419.0  

282.66 ≤   ≤ 754.27 

Taking the square roots, there is a 95% probability that the unknown population standard deviation 
is between 16.8g and 27.5g. 
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Interval estimation for the difference between the means (independent samples) 

The point estimator is the difference of sample means: ̅ − ̅  
 

σ1 and σ2 are known 
(almost never happens) 

σ1 and σ2 are unknown 
(most common) 

↓ ↓ 
Use normal distribution Approximate the standard deviations by s1 and s2 

Use Student's t distribution 
↓ ↓ 

The standard error of the difference is: 

= +  

 

The standard error of the difference is: 

= +  

 
in case of sampling without replacement multiply it by the 

finite population correction factor 
↓ ↓ 

Confidence interval for the difference: 

̅ − ̅ ±  E = ̅ − ̅ ±  / +  

Confidence interval for the difference: 

̅ − ̅ ± E =  ̅ − ̅  ±  / +  

where the estimate for the degrees of freedom is 
the smaller one of n1 – 1 and n2 – 1 

for the confidence level 1 – α, that is, 
P( ̅ − ̅ − ≤  1 − 2  ≤  ̅ − ̅ + =  1 −   

 

For the Student’s t distribution statistical softwares give a more accurate and larger degrees of 
freedom, based on Satterthwaite’s approximation: 

= +⁄− 1 + ⁄− 1  

If σ1 = σ2 is assumed, the pooled standard deviation can be used (see Chapter 2.6.1). 

 

HOW TO ESTIMATE THE DIFFERENCE BETWEEN INDEPENDENT POPULATION 
MEANS IN SPSS? 

SPSS determine the confidence interval using the Student’s t distribution and assuming unknown σ1 
and σ2 values. In the menu choose Analyze ► Compare Means ► Independent-Samples …Then in 
the dialogue box move the quantitative variable x to the Test Variable(s). The Grouping Variable 
can define the two populations by their code numbers. To vary the level of confidence, click on 
‘Options’. See later the EXAMPLE 4.10 for the application. 
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If the question ‘How large sample must be drawn to reach the desired margin of error (E) chosen 
for research project?’ has to be answered, assume that σ1 and σ2 are known and assume that the 
sample sizes are equal, that is 

= / + = / + = / +√  

Solve the formula for n: 

= +  

If the result (n) is not an integer number, round it up to the next integer number. If σ1 and σ2 are 
not known, the unknown variances of normal populations can be approximated by sample 
estimates (s1 and s1) of a preliminary study with sample of 30 or more elements. 

If the samples taken from the populations are not independent, the estimation can be simplified 
and considered as of one random variable and a one-sample estimation for the population mean. 
In this case the point estimate of the difference between the unknown population means −

 is ̅, which is calculated from data pairs of the paired samples and the process of the 
estimation is the following: 

 

Interval estimation for the difference between the means (paired samples) 

The point estimator is the difference of sample means: ̅ − ̅ = ̅ 
 

 is known 
(almost never happens) 

 is unknown 
(most common) 

↓ ↓ 
Use normal distribution Approximate the standard deviation by  

Use Student's t distribution 
↓ ↓ 

The standard error of the difference: 

= √  

The standard error of the difference: 

= √  

in case of sampling without replacement multiply it by the 
finite population correction factor 

↓ ↓ 
Confidence interval for the difference: ̅ ±  E = ̅ ±  1− /2  

Confidence interval for the difference: ̅ ± E =  ̅ ±  1− /2 √  

where the degrees of freedom is n – 1 
for the confidence level 1 – α, that is, P( ̅ − ≤  −  ≤  ̅ + =  1 −   

 

HOW TO ESTIMATE THE DIFFERENCE BETWEEN PAIRED POPULATION MEANS IN 
SPSS? 

In the menu choose Analyze ► Compare Means ► Paired-Samples … In the dialogue box select 
the paired quantitative variables from the database. To vary the level of confidence, click on 
‘Options’. See later the EXAMPLE 4.13 for the application. 
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The process of determining the confidence interval for the difference between proportions is as 
before. Assume that variable x1 and x2 have normal distributions and the sample sizes are n1 ≥ 
30 and n2 ≥ 30, moreover n1p1(1 – p1) ≥ 5 and n2p2(1 – p2) ≥ 5. In this case p1 – p2 is 
approximately normally distributed. The process of determining the 1 – α confidence interval 
for the difference between the proportions is: 

Interval estimation for the difference between the proportions 

The point estimator is the difference of sample proportions: −  
 

The standard error of the difference: 

= 1 − + 1 −
 

The unknown parameters (P1 and P1) are estimated by the sample proportions. 
 

in case of sampling without replacement multiply it by the 
finite population correction factor 

↓ 
Confidence interval for the difference: 

− ±  E = − ±  1− /2 1 − + 1 −
 

for the confidence level 1 – α, that is 
P( − − ≤  −  ≤  − + =  1 −   

As discussed earlier, if the homogenity of the variances can be assumed, then the pooled 
standard deviation can be used for estimating the differences between two means. Estimate the 
ratio of two unknown population variances to draw conclusions about the homogeneity of the 
variances.  

The point estimate for the ratio of two unknown population variances σ1
2 / σ2

2 is the ratio of the 
two sample variances /  calculated from two samples of sizes n1 and n2. The sampling 
distribution for the ratio of two variances is an F-distribution with ν1 and ν2 degrees of freedom, 
therefore  s σs σ ~ ,  

/ ≤   ≤  /  =  1 –    (see Figure 12), that is, 

/ ≤  ss ∙ σσ ≤  / =  1 –   

Rearranging: ss 1
/ ≤  σσ ≤  ss 1

/ =  1 –  . 
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Figure 12. Confidence Level 1-α and the Corresponding Critical Values on the  Curve 

 
Source: Kozak et al. (2008) 

 

3.7. Assessing Normality – Data transformation 

As discussed earlier the assumption for calculating confidence intervals is that the sample(s) 
are taken from normally distributed populations. Normality is one of the most important 
assumptions for inferential statistical parametric analyses, both in estimating population 
parameters discussed earlier, and for hypothesis testing discussed in the following chapter. 

To assess normality, review the histogram, the box plot, to see if they are symmetrically 
distributed, or the Q-Q plot of the variable, or examine the standardized proportions of the 
distribution and the values of skewness and kurtosis of the data. If the variable has normal 
distribution, then approximately 68% of data values should fall within one standard deviation 
on each side of the mean, while skewness and kurtosis are equal to zero. One measure of 
skewness is the coefficient of skewness and one measure of kurtosis is the coefficient of excess 
defined in Poór (2014). Based on the sample values the population value of skewness and 
kurtosis can be estimated, but these estimators are biased. Table 5 contains the unbiased 
estimator and the standard error of the coefficients. 

Table 5 The estimate and the standard error of the measures of shape 

 Estimator 
Standard error 

Biased Unbiased 

S
ke

w
ne

ss
 ′ = ∑ ̅

  = ′  =   

K
ur

to
si

s ′ = ∑ ̅ − 3  = [ ]
  = 2   

If the sample values of skewness and kurtosis are within ± 2 standard errors of the measure of 
shape (2 is the value of the standard normal. or Student’s t variable), the score distribution can 
be considered approximately normal. The detailed estimation of the measures of shape is 
beyond the scope of this textbook, but the outputs produced by SPSS can be used. In the next 
chapter normality test will also be discussed. Note that the procedure of assessing normality is 
sensitive to the sample size. 
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If data do not form a normal distribution, data transformations are reommended applying 
mathematical functions to convert the data and change the distribution. The applicable 
mathematical transformations depend on the type of data to be transformed. Figure 13 shows 
the original data and the transformed data distributions for the most common transformations. 
Harnos – Ladányi (2005) recommend primarily the logarithmic transformations for positively 
skewed frequency distributions, and the exponential transformations mainly for negatively 
skewed ones. 

Figure 13. Transformations to approximate the normal distribution 

 

Source: Pituch – Stevens (2016) 

Due to the transformation the data set will be normal, but the interpretation of the results become 
much more difficult, because it will have to refer to the performend data transformation, too. 

 

EXAMPLE 3.9 

Using the sample and the data of EXAMPLE 3.3 assess the normality of the average weight of the 
Pinot Noir grape clusters. 

The median and the mean (measures of central location) are close to each other (Me = 68.02 ~ ̅ =70.39). Relying on the sample shape indicators the data distribution is moderately skewed to the 
right and considered to leptocurtic. 
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Source: SPSS output 

The standard error of skewness 

= 6 · 34 · 34 − 134 − 2 34 + 1 34 + 3 = 0.403 

The standard error of kurtosis 

= 4 · 34 − 1 · 0.40334 − 3 34 + 5 = 0.788 

The 95% confidence interval for skewness: 
0.618 ± 2 ∙ 0.403 = -0.188 to 0.424, the interval contains the zero value. 

The 95% confidence interval for kurtosis: 
-0.373 ± 2 ∙0.788 = -1.949 to 1.203, the interval contains the zero value. 

 

 

 
Source: SPSS output 
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4. HYPOTHESIS TESTING 

In Chapter 3 the procedure of the estimation for unknown population parameters was discussed, 
based on a sample from the population. In this case we wanted to know the mean of the average 
weight of the cluster of a grape variety, or the multiple lambing rate (%) resulting from different 
nutrition schemes. In Chapter 4 the other type of the statistical inferences will be discussed, 
namely the test of hypotheses. In doing so a claim, or statement is formed about some parameter, 
or characteristic of a population, called hypothesis. 

The research hypothesis is claimed on the basis of some previous study, experience or 
investigations. It is followed by the statistical hypothesis, which formally describes the 
statistical alternatives that can result from the experimental evaluation of the research 
hypothesis. 

It will never really be known, whether a statistical hypothesis is false or true, unless all elements 
of the population are examined. The problem is the same as before: the population is too large, 
therefore the observation of all population elements is too costly and time-consuming to decide 
about the hypothesis directly. Therefore the decision about the statistical hypothesis must be 
based on a sample from the population, which is so never for certain, but made with an error. 
The formerly discussed probability rules and theoretical distribution characteristics are applied 
to test a hypothesis. The statistical hypotheses are to be stated before data collection and data 
analyis. 

4.1. Introduction to Statistical Tests 

Many different types of statistical significance test are available to decide about the validity of 
a hypothesis. Hypothesis testing is a process to determine whether the hypothesis is true. All 
statistically significant tests are based on the same concepts, principles and procedures. 

4.1.1. Types of Statistical Hypotheses 

Two contradictory statistical hypotheses describe the statistical alternatives: the null hypothesis 
and the alternative (or alternate) hypothesis. The null hypothesis, denoted by H0, is the 
statement being tested – it is assumed to be true, so the decision will be made on this statement. 
If the average weight of the cluster of a grape variety is measured, with the purpose of 
identifying the varieties of high cluster weight (of around 150 g), the null hypothesis could be 
that the average weight of the cluster of Kossuth szőlő is 150 g, or the average weight of the 
cluster of Kossuth szőlő is higher than that of Pinot Noir. If the multiple lambing rate (%) of 
different nutrition schemes is measured, the null hypothesis could be, that there is no difference 
between the different nutrition schemes. So, the null hypothesis usually represents a statement 
about an assumption of unchanged state (‘no effect’, ‘no difference’). Therefore it is important 
to note, that the null hypothesis always expresses an equality, i.e. the formal description always 
contains the equal ’=’ symbol. 

The alternative hypothesis, denoted by H1, is contradictory to the null hypothesis, that is, any 
hypothesis that differs from the null hypothesis is called alternative hypothesis, and always 
refers to an inequality. The null hypothesis is usually opposite to what the researcher expects. 
As the alternative hypothesis is opposite to the null hypothesis, H0 and H1 mutually exclude 
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each other and cover the whole space, all possible outcomes are accounted for by this pair of 
hypothesis. 

A hypothesis may be stated about one, two or more populations, and about some parameters 
(e.g. mean, proportion, variance) or characteristics of the population(s). If the hypothesis is a 
parametric statement, the alternative hypothesis can state that the parameter (e.g. µ) is simply 
not equal, or less than, or greater than a hypothetic value. So according to the alternative 
hypothesis, a statistical test can be two-tailed, or one-tailed – left-tailed or right-tailed. A two-
tailed test is a test of any difference regardless of the direction, while a one-tailed test specifies 
and examines the difference in only one of the two possible directions. Table 6 summarizes the 
types of hypotheses with the null hypothesis. Naturally, when the alternative hypothesis is left-

sided, the null hypothesis contains the ’≥’ symbol, and if the alternate hypothesis is right-sided, 
the null hypothesis contains the ’≤’ symbol. 

Table 6 The null and alternative hypotheses for tests 

Type Null hypothesis 
Alternative hypothesis 

Left-tailed Two-tailed Right-tailed 
One-Sample H0: =  H1: <  H1: ≠  H1: >  
Two-Samples H0: =  H1: <  H1: ≠  H1: >  
Multisample H0: = =. . . =  There is a difference (at least one) 

The decision about the null hypothesis can be ’reject’ or ’do not reject’. As the hypotheses 
exclude each other, when a decision is made directly about the null hypothesis, an indirect 
decision is automatically made about the alternative hypothesis. The null hypothesis is usually 
attempted to reject, as it is difficult to prove, that a null hypothesis is true, it is easier to prove 
that a null hypothesis is false. The acceptance of the null hypothesis implies: there is not enough 
evidence to conclude, that the null hypothesis is false. So failure to reject the null hypothesis 
does not mean that the null hypothesis is true. 

4.1.2. Errors in Hypothesis Testing 

In the hypothesis testing process four different kinds of conclusions can be drawn, which are 
shown in Table 7. The columns represent the real situation, the rows show the study 
conclusions. Two kinds of errors can be made. The rejection of an actually true null hypothesis 
is known as Type I error (’error of the first kind’), the probabilty of which is denoted by α. 
This probability can be interpreted as the chance of concluding that the sample is from the H1 
distribution, when in fact, it is from the H0 distribution (Norman – Streiner, 2008). 

Table 7 Types of errors 

Decision 
Truth of H0 

H0 is true H0 is false 

H0 is rejected 
Type I error 

(α) 
Correct decision 
No error (1-β) 

H0 is not rejected 
Correct decision 
No error (1-α) 

Type II error 
(β) 

Probability is used, because not the whole population is observed, so there cannot be a 100% 
confidence that the conclusion drawn from the sample is a correct conclusion. The α probability, 
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called the level of significance, is arbitrary, but is selected and announced in advance. 
Significance means that at the α level of risk the reality or the evidence in the sample data 
against H0 is enough to accept H1. But it cannot be claimed that the null hypothesis has been 
’proved’ or ’disproved’. As it was mentioned about estimations, the most frequently used α 
values are 0.05, 0.1 and 0.01, but any other level can be used. 

The acceptance of an actually false null hypothesis is known as Type II error (’error of the 
second kind’), the probability of which is denoted by β. The value of 1-β, called the power of 

the test, is the probability of the rejection of an actually false null hypothesis. While the value 
of α is decided in advance, the value of β is not available in most cases, as the distribution of 
H1 is unknown. To determine β, some distribution of H1 must be assumed to be true. 

To maximize the probability of making correct conclusions, that is, to minimize possible errors 
of decision (α and β), the following factors have to be aware of: 

- Level of significance: as the value of α is decided on, using a larger value of α will 
increase the power of a statistical test (Figure 14 proves this), and vice versa, the 
reduction of α causes the increase of β (for a given sample size and assuming a constant 
distance between the distributions), 

- Sample size: the increase of the sample size reduces both types of errors, as it decreases 
the standard error, that is, the spread of both sampling distributions, so the overlap 
between them also decreases, 

- Hypothesized value: the difference between the distributions (e.g. µ and µ0) as is shown 
in Figure 14, also influences the power of the test, the larger the distance (the farther 
the population mean µ is from the µ0 specified in H0), the larger the power of the test. 

Figure 14. Type I and type II errors and the power of the test for one-tailed test 

 

Source: based on Kaps - Lamberson (2004) 

The factors that determine the distribution are shown in the example presented in Figure 14. 
The distribution is determined by the statistical significance test applied for hypothesis testing. 
Many different types of statistical significance tests are available. The choice of the test depends 
on many considerations: 

- The type (e.g. measurement, distribution) of data, the type of experimental design, 
- The question being asked or the type of hypothesis being tested,  
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- The number of variables or samples that are examined, and the samples being 
independent or paired samples.  

 

4.1.3. Methods of Testing the Null Hypothesis 

There are two (in some cases three) ways to decide about the hypothesis. 

First, the P-value method is described briefly. The statistic of the suitable test has a known 
probability (H0) distribution, assuming that the null hypothesis is correct. After the sampling, 
and calculating the value for the test statistic, the P-value of the test, or the probability of 

chance is to be determined. 

Under the assumption that the null hypothesis is correct, the P-value is the probability of getting 
a sample statistic at least as extreme as the observed statistic if a random sample was taken. So 
the P-value can be thought of as the probability that the test statistic value is due to chance. 

 

If the value is sufficiently extreme, the probability of belonging to the H0 distribution will be 
small enough to reject H0. The smaller the P-value, the stronger the evidence against the null 
hypothesis. The probability of type I error, that is, the level of the significance α selected, can 
make the decision objective. As the P-value indicates the smallest level of significance for 
rejecting H0, if P-value ≤ α, the null hypothesis should be rejected. The P-value depends on the 
type of the test, so on the type of the alternative hypothesis. The P-value is often provided as a 
part of the output of statistical software packages. 

  

THE P-VALUE IN EXCEL AND IN SPSS 

IN EXCEL with the built-in functions: 
The Z.TEST returns the one-tailed P-value of a z-test for a given hypothesized population mean (µ0) 
with the following arguments: the range of data (Array) against which to test the hypothesized 
population mean µ0, the value µ0 to test (x) and the population standard deviation (σ) which can be 
omitted, in which case the sample standard deviation is used. The two-tailed probability-value of a 
z-test is twice the one-tailed one. 
The T.TEST function returns the probability whether two samples come from two underlying 
populations that have the same mean. The function has the following arguments: the first (Array1) 
and the second (Array2) data set, the type of the alternate hypothesis, that is, 1 = one-tailed, 2 = 
two-tailed (Tails), and the Type of the two-samples test (1 = paired samples, 2 = independent 
samples with equal variances, 3 = independent samples with unequal variances). 
The F.TEST function returns the two-tailed probability that the variances from two data sets are not 
significantly different. 

IN EXCEL with the tests available in Data Analysis (t-Test: Two-Sample Assuming Equal and 
Unequal Variances, Paired Two Sample for Means, F-Test Two-Sample for Variances and Anova: 
Single Factor). See later in the outputs for the different types of hypothesis testing. 

IN SPSS In the menu choose Analyze ► Compare Means ► One-Sample T Test…, Independent-
Samples T Test…, Paired-Samples T Test… and One-Way ANOVA… The procedure produces a 
variety of statistics, including the P-value of a test, appearing in the Output Window. See later the 
Sig. value in the outputs for the different types of hypothesis testing. 
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Secondly, the critical region method is described, as the traditional method. The critical region, 
or rejection region is the region, for the values of which the null hypothesis is rejected. 
Depending on the type of the alternative hypothesis, the critical region is located on one side 
(the left-side or the right-side) or on both sides (two-side) of the distribution (Figure 15). The 
critical value(s), víz. the boundari(es) of the critical region is (are) determined in advance by 
the level of significance. In the case of a left-sided alternate hypothesis, the critical region (α) 
lies in the left tail of the sampling distribution, while for the right-sided alternate hypothesis, 
the critical region (α) lies in the right tail. For the two-sided alternative hypothesis, the critical 
region lies in both tails of the sampling distribution with two equal parts (α/2). 

Figure 15. Critical regions for different tests 

 

Source: based on Kozak et al. (2008) 

The decision regarding the null hypothesis is usually made by using z, t, χ2 or F distributions. 
The distribution of the test statistics and the level of significance determine the critical value(s), 
which will be z, t, χ2 or F-value(s). If the value of the test statistic calculated from the sample 
is in the rejection region, that is, it is more extreme, than (either of) the critical value(s), the null 
hypothesis will be rejected, otherwise the null hypothesis cannot to be rejected. 

Thirdly the results of the interval estimation discussed in Chapter 3 can be used in hypothesis 
testing, if it is a two-tailed – one or two-sample – parametric test. In this case, if the calculated 
confidence interval contains the hypothesized parameter value, then the null hypothesis is not 
rejected, so there is not enough evidence to conclude that the null hypothesis is false. 

Any statistical hypothesis test can be performed by the following step by step procedure: 

1. Stating the hypotheses: Define and formulate H0 and H1, check that they are mutually 
exclusive and the null hypothesis is an equality statetment, 

2. Set the level of α. 
3. Select the mathematical tool – an equation – to be used to determine the test statistic 

and its distribution when H0 is correct, 
4. Determine the critical value(s) and define a rejection and an acceptance region on the 

basis of the α, 
5. Take sample(s) and calculate the value of the test statistic from a sample, 
6. Make a decision regarding H0 by comparing the test statistic value with the critical 

value(s), the P-value with α, or the confidence limits with the hypothesized parameter 
value, 

7. Give a conclusion on the original problem, interpret the results. 
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As it was mentioned earlier, a wide range of statistical tests is available, from which those will 
be chosen that are the most suitable for the type of data and the type of experimental design. In 
the following sections the most important hypothesis tests, used in statistics, will be presented. 

4.2. Non-Parametric Tests for a Single Sample (Tests for Normality, 

Goodness-of-fit tests, Test of Independence) 

First, the tests concerning the distribution of a population will be introduced, as normality is an 
important assumption for the estimation and the hypothesis testing of the population parameters 
(µ, P, σ) and their differences. In Chapter 3.7. some methods of assessing normality were 
presented. In this section statistical tests for normality will be discussed. 

To check for normality the first presented tests are the z test approximations for skewness 

and kurtosis. The null hypotheses state, that the distribution is normal. The sampling 
distribution of the test statistic is Student’s t distribution with degrees of freedom n – 1, if the 
sample values are used to estimate – for a large sample size the sampling distribution 
approaches the standard normal distribution. If both of the absolute values of the test statistic 
are less, than 2.0 (the approximate critical value of a standard normal, or Student’s t variable), 
the data are assumed reasonably normal. The tests are sensitive to outliers. 

Table 8 The null hypothesis and the test statistic for the tests of skewness and kurtosis 

 Skewness Kurtosis 
Null hypothesis H0: = 0 H0: = 0 

Test statistic =  =  

 

The tests for skewness and kurtosis can be combined. The Jarque-Bera test defined as 

= 6 + 14  

is χ2 distributed with ν = 2 under the assumption that H0 is correct, that is, the data set is normally 
distributed. This test can be used for only large sample sizes. 

EXAMPLE 4.1 

Using the results of EXAMPLE 3.9 test the normality of the average weight of Pinot Noir grape 
clusters by the z test approximations for skewness and kurtosis. 

= = .. = 1.533 and = = .. = −1.473 

 
so there is not enough evidence to conclude that the null hypothesis is false. 
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There are other tests to check, that the data fit a normal distribution. Tests called goodness-of-

fit tests are applicable to answer the question, whether a sample data set is likely to come from 
a population with a specified F0 distribution, or, in other words, whether a population from 
which the sample was taken, is likely to follow a particular theoretical distribution (e.g. normal). 
Therefore these tests are capable of checking the normality of a distribution. In this case, the 
null hypothesis is the following: H0: = . 

According to the traditional approach we wish to find out to what extent the frequency (fi), with 
which the observed data fall within a set of categories, differs from an expected – maybe a 
theoretical – frequency (fi

*). For testing the normality or another theoretical distribution, first, 
a frequency distribution with frequency classes will be constructed from the sample. The class 
frequencies are called observed frequencies (fi = Oi). For each frequency class an expected 
frequency (fi

* = Ei) will also be computed from the specified theoretical distribution. 

The null hypothesis of the goodness-of-fit test states that the observed frequencies for all classes 
are equal to the expected frequencies. The null hypothesis is H0: Oi = Ei, claiming that the class 
probabilities for all classes are equal to the probabilities of the specified theoretical distribution. 
The test statistic is defined as 

= O −
 

As it is computed from sample data, it is an estimate. The sampling distribution of the value of 
the test statistic is  with degrees of freedom ν = c – k (c is the number of categories, k is 
the number of independent quantities, e.g. if one constant is required viz. the total number of 
observations, then the ν = c – 1). 

Note here, that this test statistic can also be used for testing the association. The test of 

independence (two-way tables) compares the frequencies in one set of categories with the 
frequencies observed in another set of categories. The formula of the test statistic is the same, 
the only difference is the way how the expected frequencies are calculated. The observed 
frequency fij

 = Oi, and the fij
* = Ei values are determined from the observed sample data. 

Accordding to the null hypothesis, if the variables are totally independent from each other, then 
the ratio of the frequencies is constant across the categories: 

. = ⋯ . = . = . → ∗  =  = . .   
where Ri. is the total for row i and C.j is the total for column j (see the meaning of the symbols 
in Table 9). The degrees of freedom is a conveniently simple formula: (r-1)(c-1), where r is the 
number of rows and c is the number of columns. 

Table 9 A contingency RxC table 

 B1 … Bj… Bs Total 
A1 f11  f1s R1. 

… Ai…  fij  Ri. 
At ft1  fts Rt. 

Total C.1 C.j C.s N 



70 

 

 

This looks like a two-tail test, but the most extreme left tailed value for the test statistic is zero, 
which means that the condition of the null hypothesis is perfectly met. Therefore despite the 
formulas of the hypotheses, this test – as the Jarque-Bera test – is a right-tailed test. 

Another goodness-of-fit test is the Kolmogorov–Smirnov goodness-of-fit test, which 
determines the probability that a set of data falls within the expected standardized proportions 
of the normal distribution. The Kolmogorov-Smirnov test compares the observed cumulative 
relative frequencies with the expected ones, and the largest absolute difference between the 
frequencies provides the value of the test statistic dmax

observed. The appropriate critical value is 
obtained from the probability distribution of dmax

critical(c,n). 

The combination of skewness and kurtosis coefficients and the Shapiro–Wilk test are the most 
powerful tests for checking the normality for (small) samples of less than 20 elements.  

 

After checking the normality the parametric test can be used. In the next section the step by step 
guide for hypothesis testing will be followed, based on the normality assumption. 

EXAMPLE 4.2 

Using the data of BROILER_CHICKENS database, test the normality of the weight of the chickens 
by the Jarque-Bera test, the chi-squared goodness-of-fit test, and the Kolmogorov–Smirnov and 
Shapiro–Wilk tests (by SPSS). For type A soyabean feed, on days 10 (n=143) 

= 6 + 14 = 6 −0.368 + 14 −0.004 = 3.22 

χ2 = 3.22 < 5.99 = χ2(2)
0.95 

Weight 
(g) 

Frequencies 
(observed Oi) 

z = −
 Φ(ziu) = Pi’ Pi n·Pi = Ei 

−
 

      -160 6 -1.855 0.032 0.032   4.547 0.464 
160-190 17 -1.083 0.139 0.108 15.388 0.169 
190-220 29 -0.310 0.378 0.239 34.159 0.779 
220-250 41 0.462 0.678 0.299 42.854 0.080 
250-280 35 1.234 0.891 0.213 30.522 0.657 
  280- 15 ∞ 1.000 0.109 15.530 0.018 

∑ 143 - - 1.000 143 2.168 

For the chi-squared goodness-of-fit test the predicted frequencies were calculated from the normal 
probability distribution. For standardization the estimates, i.e. the sample mean and standard 
deviation were used, therefore the degrees of freedom is c – k = 6 – 2 – 1. 

χ2 = 2.168 < 7.815 = χ2(6-2-1)
0.95 

 

PKolmogorov-Smirnov = 0.200 > α = 0.05 
PShapiro-Wilk = 0.143 > α = 0.05 

so there is not enough evidence to conclude that the null hypothesis is false, i.e., normality cannot 
be rejected.. 
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4.3. One-Sample Parametric Tests 

The population parameter is a numerical descriptive measurement of the whole population, a 
fixed value. It is a less common, but not rare, experimetal design, to ask, whether the sample 
statistic, and naturally the related unknown population parameter, differs significantly from a 
theoretical or hypothesized population parameter. 

So, for one-sample parametric tests the null hypothesis is a statement about a population 
parameter. Any difference can be tested regardless of the direction, or the difference in only 
one of the two possible directions (less than, or greater than) may be assessed. 

For hypothesis testing, a simple random sample is taken and a test statistic corresponding to the 
parameter in the null hypothesis, is computed. Using this statistic, which is a numerical 
descripitive measurement of the sample, and the sampling distribution of the statistic, the 
probability can be determined that the result of the sample belongs to the distribution, assuming 
that the null hypothesis is correct. So it can be assessed how compatible the test statistic is with 
the null hypothesis. First the tests concerning the population mean will be presented. 

4.3.1. One-Sample Hypothesis Tests of the Mean 

For testing the hypothesis for the mean, we need the information that was discussed in 
Chapter 3.3. First the null and the alternate hypothesis are defined. The null hypothesis states 
that the population mean µ is (less than, or greater than, or) equal to the hypothesized population 
mean µ0, while the alternate hypothesis states that there is a difference (Table 9). After setting 
the level of significance, the test statistic with a known theoretical distribution has to be defined. 

Table 9 The null and alternative hypothesis for the one-sample mean tests 

One-Sample Left-tailed Two-tailed Right-tailed 
Null hypothesis H0: µ ≥ µ  H0: µ = µ  H0: µ ≤ µ  
Alternate hypothesis H1: µ < µ  H1: µ ≠ µ H1: µ > µ  

As it was discussed in Chapter 2.3., if the distribution of individual meaurements is normal 
with the mean µ and known standard deviation σ, the sampling distribution of the mean can be 
converted for any sample size n to the standard normal distribution. As σ is almost never known, 
the sample standard deviation s will be used for estimating the unknown σ. With the estimate s, 
the sampling distribution of the mean has Student’s t distribution with the degree of freedom ν. 
These distributions are used for testing the hypothesis of the mean. 

After calculating the estimate for the mean and (if necessary, the standard deviation) from the 
sample, the value of the test statistic is calculated. If the sample mean is extreme, it is at a large 
distance from the hypothesized mean, and then the value of the test statistic will also be extreme. 
In this case the null hypothesis is rejected, and we conclude that the sample belongs to a 
population with a different mean (not equal to µ0). Note however, that the value of the test 
statistic is influenced by the standard error of the mean, that is, the sample size and the 
dispersion (standard deviation). 
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Hypothesis tests for the mean 

 
σ is known 

(very rarely happens) 
σ is unknown 

(most common) 
↓ ↓ 

Use normal distribution Approximate σ by s 
Use Student's t distribution 

↓ ↓ 
The test statistic 

= ̅ −
√ → z = ̅ −

√  = ̅ − μ
√ → t = ̅ −

√  

 
Where µ0 stated in H0 is the hypothesized population mean and 

for sampling without replacement the standard error of the mean is multiplied 
by the finite population correction factor 

The decision about the null hypothesis can be made by the critical region method. The critical 
values (z or t) obtained from the Tables in the APPENDICES or determined by statistical 
software (as presented in Chapter 1.5. and 1.6.) define the rejection and acceptance regions 
(Figure 16). The t critical value is determined with n – 1 degrees of freedom. The value of the 
test statistics calculated from the sample is compared with the critical value(s). If the value of 
the test statistic is more extreme than the critical value, that is, it falls in a rejection region, the 
decision will be to reject the null hypothesis. 

Figure 16. Critical regions for one-sample mean tests 

One-Sample Left-tailed Two-tailed Right-tailed 
Alternate hypothesis H1: µ < µ  H1: µ ≠ µ  H1: µ > µ  

P 
P (z < zα) = α 
P (t < tα) = α 

׀ ׀ > ⁄ = 2 P (z > z1-α) = α 
P (t > t1-α) = α 

 
Source: based on Kozak et al. (2008) 

The decision about the null hypothesis can be made by the P-value method. In this case the P-
value of the test statistic calculated from the sample is determined by the statistical software as 
presented in Chapter 4.1.3. As the P-value is the probability of observing a value of the test 
statistic that is at least as extreme as the one for the sample, assuming the null hypothesis is 
true, then if the calculated P-value ≤ α, reject the null hypothesis. 
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EXAMPLE 4.3 

From a workshop paper it is known, that though the average weight of a grape cluster varies 
significantly from year to year in Oregon, on average the Pinot Noir clusters weight about 0.2 pounds 
(i.e. around 90 g).  

Using the sample and the data of EXAMPLE 3.3 can it be assumed, that the unknown population 
mean reaches the average cluster weight of the Pinot Noir grapes in Oregon? Use α = 0.05 

Do not forget the step by step guide: 

1. Stating the hypotheses: ’the unknown population mean reaches’ means that it is greater than, or 
equal to, so this will be claimed in H0. The hypothetical population mean µ  is 0.2 pounds = 90 g 
and the hypotheses are: 
H0: µ ≥ µ = 90  
H1: µ < µ   This indicates that a one-tailed (left-sided) test is appropriate. 
 

2. Set the level of α: ’Use α = 0.05’ 
 

3. Select the mathematical tool – an equation – to be used to determine the test statistic and its 
distribution, when H0 is correct: since σ is unknown, use t = ̅ −

√  

 

4. Determine the critical value(s) and define a rejection region and an acceptance region based on 
the chosen α: as it is a left-sided test there will be only one critical value. 
The critical value with n - 1 degrees of freedom is obtained from Table A.2. in the APPENDICES. 
tα = t0.05 But how many observations are there in the sample? → See step 5. (n = 34) 
tα

(n-1) = -t1-α
 (n-1) → t0.05

(34-1) = -t0.95
(34-1) = -1.69 is the upper limit of the critical region. 

 

5. Take sample(s) and calculate the value of the test statistic from a sample: from EXAMPLE 3.3 

n = 34, ̅ = 70.39, s = 20.84 and the standard error of the mean is ̅ = √ = 3.57 t = ̅ −
√ = 70.39 − 903.57 = −5.49 

 

6. Make a decision regarding H0 by comparingthe test statistic value with the critical value(s) 

 
 

7. Give a conclusion for the original problem, interpret the results: The sample mean is 
considerably less than the assumed population mean of 90 g. At  5% level of significance the 
evidence is enough to reject the null hypothesis. 
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As for two-tailed tests with the level of significance α 

⁄  ≤   ≤  ⁄ =  1 –   and as ⁄ = − ⁄  → ׀ ׀ > ⁄ = 2 

the two-tailed tests are equivalent to the (1 – α) confidence intervals 

̅ − ⁄ √  ≤   ≤  ̅ + ⁄ √  =  1 −    

This statement is also true for the Student’s t distribution, the confidence limits of the interval 
estimation for the mean are the critical values expressed in the units of the mean. So if the 
hypotheses defined for testing equality and inequality, regardless of the direction (two-tailed 
test), the decision about the null hypothesis is made by comparing the sample mean with the 
confidence interval, i.e., the values of the lower and upper confidence limit. 

THE P-VALUE OF THE ONE-SAMPLE MEAN TEST IN EXCEL AND IN SPSS 

As mentioned in Chapter 4.1.3 

IN EXCEL the Z.TEST function returns the one-tailed P-value of a z-test for a given hypothesized 
population mean (µ0). The two-tailed probability-value of a z-test is twice the value of the one-tailed 
test. See EXAMPLE 4.4 for how to run and how to interpret the output. 

IN SPSS in the menu choose Analyze ► Compare Means ► One-Sample T Test… The procedure 
produces a variety of statistics, including the P-value of a test, appearing in the Output Window. 
See EXAMPLE 4.5 for how to run and how to interpret the output. 

The SPSS procedure for conducting a one-tailed test is the same as that for a two-tailed test. It differs 
only in the way how the P value is used. 

In SPSS the reported P value is for a two-tailed test, therefore P/2 is to be compared to , and it has 
to be verified that the sample mean differs in the direction supported by the alternative hypothesis. 

EXAMPLE 4.4 

THE P-VALUE OF EXAMPLE 4.3 IN EXCEL 

IN EXCEL the Z.TEST function, as a right tailed test, represents the probability for the hypotheses 
H0: µ ≤ µ = 90  and H1: µ > µ  
From the symmetry of the Normal distribution, if ̅ < , then the Z.TEST function will return a 
value greater than 0.5. Since σ is unknown, Excel uses the sample standard deviation computed from 
the data. 
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EXAMPLE 4.5 

THE P-VALUE OF EXAMPLE 4.3 IN SPSS 

IN SPSS In the menu choose Analyze ► Compare Means ► One-Sample T Test… The procedure 
produces a variety of statistics, including the P-value of a test, appearing in the Output Window. 

 

,  

 

The One-Sample Statistics are the same as in Descriptives in EXAMPLE 3.3. 

The value of the test statistic (t = -5.49) is in the One-Sample Test table, with the degrees of freedom  
(34 – 1 = 33) and with the P-value of the test statistic. As it was mentioned, in SPSS the reported P-
value is for a two-tailed test, therefore P/2 is to be compared to , and it has to be verified, that the 
sample mean differs in the direction supported by the alternative hypothesis.  2 =  0.0000042 = 0.000 ≤  = 0.05 

So reject the null hypothesis. 
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4.3.2. One-Sample Hypothesis Tests of Population Proportion and Variance 

For testing hypotheses about the proportion and the variance, we rely on the information 
discussed in Chapter 3.4. In the previous section the concepts and the method of hypothesis 
testing were presented in the example about the hypothesis tests of the mean. Now let’s see 
what is the same, and what is the different in the procedure, when the one-sample test concerns 
other parameters. 

First, similarly to the means tests, the null and the alternate hypothesis is defined. The null 
hypothesis states that the population parameter P or σ2 is (less than, or greater than, or) equal 
to the hypothesized population parameter P0 or σ0

2, while the alternate hypothesis states, that 
there is a difference (Table 9). After the setting of the level of significance, the test statistic with 
a known theoretical distribution is defined, in the same way as with the means tests. 

Table 9 The hypotheses for the one-sample proportion and variance tests 

One-Sample Left-tailed Two-tailed Right-tailed 
Proportion 

Null hypothesis H0: ≥  H0: =  H0: ≤  

Alternate hypothesis H1: <  H1: ≠  H1: >  

Variance 

Null hypothesis H0: ≥  H0: =  H0: ≤  

Alternate hypothesis H1: <  H1: ≠  H1: >  

As it was discussed in Chapter 2.4, the sampling distribution of the proportion approaches the 
normal distribution if n ≥ 30 and 0 < p < 1  (or np ≥ 5 and n(1-p) ≥ 5). Meanwhile the sampling 
distribution of the variance will follow a 2 distribution with n – 1 degrees of freedom, if the 
population, from which the samples were taken, is normally distributed N(μ,σ2). So the standard 
normal distribution is used for testing the hypothesis about the population proportion and the 
2 distribution is used for testing the hypothesis about the population variance. 

Hypothesis test for the proportion Hypothesis test for the variance 
↓ ↓ 

Use normal distribution Use 2 distribution 
↓ ↓ 

The test statistic 

= − P1 − → = − PP 1 − P  

in case of sampling without replacement the 
standard error of the mean is multiplied by the  

finite population correction factor 

 = − 1 →  = − 1
 

Where P0 stated in H0 Where σ0
2 stated in H0 

is the hypothetical population parameter 
  



77 

 

 

After computing the estimate for the sample proportion, or the sample standard deviation, the 
value of the test statistic for the sample is calculated. If the sample statistic is extreme, i.e. it is 
at a large distance from the assumed population parameter, the value of the test statistic will 
also be extreme. In this case, the null hypothesis is rejected and we conclude, that the sample 
belongs to a population with a parameter different from P0 or σ0

2. Note, however, that the value 
of the test statistic is influenced by the sample size n. 

The decision about the null hypothesis can be made by the critical region method. The critical 
values, z or 2, obtained from the Tables in the APPENDICES, or determined by statistical 
software (as presented in Chapter 1.5 and 1.6) define the rejection and acceptance regions 
(Figure 16 can be used with z values for the proportion, while Figure 17 for the variance). The 
2 critical value is determined with n – 1 degrees of freedom. The value of the test statistics 
calculated from the sample is compared with the critical value(s). If the value of the test statistic 
is more extreme than the critical value, that is, it falls in a rejection region, decision will be the 
rejection of the null hypothesis. 

Figure 17. Critical regions for one-sample proportion tests 

One-Sample Left-tailed Two-tailed Right-tailed 
Alternate hypothesis H1: <  H1: ≠  H1: >  

P P (2 < 2
α) = α 

 <   /  = 2 

 >   /  = 2 
P (2 > 2

1-α) = α 

Two-tailed One-tailed (Right-tailed) 

 -  
Source: based on Kozak et al. (2008) 

If the hypotheses defined for testing equality and inequality do not consider the direction (two-
tailed test), the decision about the null hypothesis can be made by comparing the sample statistic 
with the confidence interval. The values of the lower and upper confidence limit are computed 
in the same way as discussed in Chapter 3.5. 
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4.4. Two-Sample Parametric Tests 

In many situations the question is: Are the two populations different? To answer the question 
the populations are to be compared. Because of constraints, the entire populations are usually 
not available, only sample data can be used. In case of two-sample parametric tests the alternate 
hypothesis is a statement about any difference between two unknown population parameters, 
which can be tested regardless of the direction, or the difference may be examined in only one 
direction (less than, or greater than).  

In the previous sections the concepts and the methods of one-sample hypothesis testing were 
presented. Now let’s see what is the same, and what is the different in the procedure, when the 
hypothesis concerns parameters of two populations. 

First the test concerning population variances will be presented, because in comparing the 
difference between two unknown population means the assumption of equal population 
variances is important. The homogeneity/inhomogeneity of the variances influences the test 
statistics of the two-sample hypothesis tests for the mean. 

4.4.1. Hypothesis Test of Two Population Variances 

The method for testing two independent population variances will be presented in this section. 
As discussed in Chapter 3.6, the sampling distribution of the ratio of two variances is an F-
distribution with ν1 and ν2 degrees of freedom. For the testing, there are two basic assumptions: 
the two populations are normally distributed, and independent of each other, so the two 
sampling distributions are also independent. 

First, similar to the one-sample tests, the null and the alternate hypothesis are defined. On the 
one hand, the hypotheses make claims about the variances, corresponding to the standard 
deviations. On the other hand, although the null hypothesis makes claims about the variances, 
as the sampling distribution of the ratio of two variances is known, in fact, the ratio of two 
variances will be tested. So the null hypothesis states, that H : ⁄ = , where c is a 
positive constant. In most cases it is assumed that c is equal to 1, to test the equality of the 
variances. In this case the null hypothesis states that the population variances are equal, while 
the alternate hypothesis states, that there is a difference, regardless of the direction, or there is 
a difference in one of the two possible directions (Table 10).  

  

EXAMPLE 4.6 

A seed company received complaints, that its packages of µ0=25 dkg (with allowed standard 
deviation of σ0=1 dkg) weigh a standard deviation less, than prescribed. The Consumer Protection 
Association measured a representative sample of 144 packages (n = 144) (for which the average 
weight was ̅=24 dkg with a standard deviation s = 2 dkg). Decide at 10% significance level, whether 
the consumer complaints are justifiable, or not (Hunkár, 2011). 

The test statistic for the variance regarding the H0: = : 

 = = = 572 > 2(143)
1-0.1/2 = 171.91, so the complaints are justifiable. 
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Table 10 The hypotheses for the two population variances 

Two-Sample Left-tailed Two-tailed Right-tailed 
Two Variances 

Null hypothesis H0: ≥  H0: =  H0: ≤  

Alternate hypothesis H1: <  H1: ≠  H1: >  

After setting the level of significance, similarly to the one-sample tests, the test statistic with a 
known theoretical distribution is to be defined, which is: 

= ss · 1c 

For testing the equality of variances =   
The quotient is expressed with the larger sample variance in the numerator, that is, Population1 
is the population with the larger sample variance. 

The decision about the null hypothesis may be made by the critical region method. The critical 
value, F, obtained from the Tables in the APPENDICES, or determined by a statistical software 
(as presented in Chapter 1.6.) defines the rejection and acceptance regions (Figure 18). The F 
critical value is determined with n1 – 1 degrees of freedom for the numerator and n2 – 1 degrees 
of freedom for the denominator. The value of the test statistics calculated from the sample is 
compared with the critical value(s). If the value of the test statistic is more extreme than the 
critical value, that is, it falls in a rejection region, the decision is to reject the null hypothesis. 

Figure 18. Critical regions for two-samples variance test 

One-Sample Left-tailed Two-tailed Right-tailed 
Alternate hypothesis H1: <  H1: ≠  H1: >  

P P (F < Fα) = α 

F <  F /  = 2 

F >  F /  = 2 
P (F > F1-α) = α 

Two-tailed One-tailed (Right-tailed) 

Source: based on Kozak et al. (2008) 
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The decision about the null hypothesis may also be made by the P-value method. In this case 
the P-value of the test statistic calculated from the sample is determined by a statistical sotware. 
As the P-value is the probability of observing a value of the test statistic that is at least as 
extreme as the one for the sample, assuming the null hypothesis is true, therefore, if the 
calculated P-value ≤ α, then reject the null hypothesis. 

 

EXAMPLE 4.7 

Using the sample and the data of EXAMPLE 3.3 can it be assumed, that the unknown population 
variance of the average cluster weight of Pinot Noir is equal to that of Kossuth szőlő? 

Do not forget the step by step guide: 

1. Stating the hypotheses: ’the unknown population variance of the average cluster weight of Pinot 
Noir is equal to that of Kossuth szőlő’, so this will be claimed in H0. 
The hypotheses are: 
H0: =  
H1: ≠   This indicates that a two-tailed test is appropriate. 
 

2. Set the level of α: ’Use α = 0.05 
 

3. Select the mathematical tool – an equation – to be used to determine the test statistic and its 

distribution, when H0 is correct: since σ is unknown, use =  
 

4. Determine the critical value(s) and define a rejection and an acceptance region according to the 
value of α: as it is a two-sided test there will be two critical values. 
The critical values with n1 – 1 and n2 – 1 degrees of freedom are obtained by the F.INV function in 
Excel. But what population is Population1 and how many observations are in the first sample? → 
See the necessary sample statistics: 

  Kossuth szőlő (1) Pinot Noir (2) 
Variance = 1325.53 = 434.27 
Observations n1 = 28 n2 = 34 
degrees of freedom (d.f.) ν1 = 27 ν2 =33 

As the sample standard deviation, and naturally the variance, of Kossuth szőlő is larger, denote 
Population1 the variety of Kossuth szőlő. The arguments of the F.INV function are α/2 for the lower 
critical value and 1 – α/2 for the upper critical value, with ν1 = 27 and ν2 = 33. So 
F.INV(0.025;27;33) = 0.4738 → Fα/2

(ν1, ν2) = F0.025
(27, 33) = 0.4738 

F.INV(0.975;27;33) = 2.0541 → F1-α/2
(ν1, ν2) = F0.975

(27, 33) = 2.0541 
and the acceptance region is between these values. 
 

5. Take samples and calculate the value of the test statistic from two samples: 
 = ss = 1325.53434.27 = .  
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6. Make a decision regarding H0 by comparing the test statistic value with the critical value(s) 

 
 

7. Give a conclusion on the original problem, interpret the results: The sample variances are 
considerably different. At  5% level of significance the evidence is enough to reject the null 
hypothesis. 

THE P-VALUE TEST OF THE TWO-POPULATION VARIANCES IN EXCEL 

As mentioned in Chapter 4.1.3 

IN EXCEL the F.TEST function returns the two-tailed probability, that the variances from two data 
sets are not significantly different. 

IN EXCEL with the Data Analysis procedure: F-Test Two-Sample for Variances produces a variety 
of statistics, including the one-tail P-value (as Sig.) of a test. 

See EXAMPLE 4.8 for how to run and interpret the output. 

EXAMPLE 4.8 

THE P-VALUE OF EXAMPLE 4.7 IN EXCEL 

IN EXCEL the F.TEST function returns the two-tailed probability, that the variances from two data 
sets are not significantly different. 

  P = 0.0026 < 0.05 = α 
so the evidence is enough to reject the null hypothesis. 

 

IN EXCEL F-Test Two-Sample for Variances in Data Analysis gives the one-tailed probability for 
the two-population variances test. How to run and how to interpret the output? 

Do not forget that as the sample standard deviation, and naturally the variance, of Kossuth szőlő is 
larger, Variable 1 Range will be the data set of Kossuth szőlő. 
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In SPSS an alternative test for the variances of two populations uses the Levene’s test. Levene’s 
test can be used without the assumption of normally distributed populations, and for two or 
more populations. The test statistic for Levene’s test is defined as: 

= −− 1 · ∑ −∑ ∑ −  

Notations: k is the number of populations (groups) to which the sampled observations belong, 

n is the total number of observations, nj is the number of observations in group j, 

 = − ̅ ,  is the ith observation in group j, ̅  is the sample mean of group j,  

and ̅ is the overall sample mean. 

Instead of the mean, the median may also be used, which provides a test called Brown–

Forsythe test for non-normal distributions. 

 

 

F-Test Two-Sample for Variances   
The value of the F test statistic is the 
same as the calculated value was in 
Example 4.7. Because the test is one-
tailed (right-tailed) and the two-tailed 
P-value is twice the one-tailed P-value 
for the alternative hypothesis, thus 

2 · 0,0013 = 0.0026 < 0.05 = α 
so reject the null hypothesis. 

 

  Kossuth szőlő Pinot noir 
Mean 145,7725 70,39441176 
Variance 1325,528797 434,2746618 
Observations 28 34 
df 27 33 
F 3,052282148  
P(F<=f) one-tail 0,00131659  
F Critical one-tail 1,826916116   

 

THE P-VALUE TEST OF THE TWO-POPULATION VARIANCES IN SPSS 

IN SPSS In the menu choose Analyze ► Compare Means ► Independent-Samples T Test… The 
procedure produces a variety of statistics, including the P-value of Levene’s Test for Equality of 
Variances (which is also a hypothesis test of two population variances), appearing in the Output 
Window. 

See EXAMPLE 4.9 for how to run and interpret the output. 
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4.4.2. Hypothesis Tests of Two Independent Population Means 

In this section the method for testing two independent population means will be discussed first. 
Similar to the one-sample mean tests, the sampling distribution for the difference of the means 
is the standard normal distribution when the population variances are known, otherwise it is the 
Student’s t distribution. Besides the fact that the population variances are known or unknown, 
the homogeneity or inhomogeneity of the variances (which was tested in the previous section) 
also influences the test statistics applied for the two-sample means tests. The two populations, 
from which the independent samples were taken, are normally distributed. 

So the null hypothesis states, that H : µ − µ = , where c is a constant. In most cases it is 
assumed that c is equal to 0, to test the equality of the means. In this case the null hypothesis 
states, that the population means µ1 and µ1 are equal, while the alternate hypothesis states, that 
there is a difference regardless of the direction, or in one direction (Table 11). Although the 
null hypothesis states that H : µ = µ , as the sampling distribution of the difference between 
two means is known, the difference of two means will be tested, in fact (in the same way as in 
case of the two-sample variances test, the ratio was tested).  

Table 11 The null and alternative hypothesis for the two-sample means tests 

Two-Sample Left-tailed Two-tailed Right-tailed 
Null hypothesis H0: µ ≥ µ  H0: µ = µ  H0: µ ≤ µ  
Alternate hypothesis H1: µ < µ  H1: µ ≠ µ  H1: µ > µ  

After setting the level of significance, the test statistic with a known theoretical distribution is 
defined. According to the problem the standard error of the difference, that is, the denominator 
of the test statistic, can be different, while the numerator of the test statistic is the same. 

As it was discussed in Chapter 2.6.1, if the population standard deviations σ1 and σ2 are known, 
the sampling distribution of the difference between the means can be converted for any sample 
size n to the standard normal distribution. In that case the test statistic used for testing the 
difference between two population means is a z test. 

EXAMPLE 4.9 

THE P-VALUE OF EXAMPLE 4.7 IN SPSS 

IN SPSS in the menu choose Analyze ► Compare Means ► Independent-Samples T Test…. The 
procedure produces a variety of statistics, including the value of the Levene’s Test statistic and the 
P-value of Levene’s Test. 

Because the SPSS applies a different test for equality of variances, the value of the F test statistic 
and the P-value of it is not the same as of Excel output.  

 

F = 3.05 ≠ FLevene = 8.455 
and 

P = 0.0026 ≠ PLevene = 0.005 
BUT 

the conclusion is the same: It 
can be safely assumed that 
the two unknown population 
variances are not equal. 
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The situation that either σ1 or σ2 are known is  very rare, rather the sample standard deviations 
s1 and s2 are applied to estimate the unknown parameters. With the estimates, the sampling 
distribution of the difference between the means is a Student’s t distribution with degrees of 
freedom being the smaller of n1 – 1 and n2 – 1. If it is assumed that σ1 = σ2, the pooled standard 
deviation can be used, and the corresponding test statistic is also of a Student’s t distribution, 
with degrees of freedom n1 + n2 – 2. 

Hypothesis tests for the difference between two independent population means 

 
σ1 and σ2 are known 

(almost never happens) 
σ1 and σ2 are unknown 

(most common) 
↓ ↓ 

Use normal distribution Approximate the standard deviations by s1 and s2 
Use Student's t distribution 

↓ ↓ 
The test statistic 

= ̅ − ̅ − −
+  

 

= ̅ − ̅ − −
+  

If it is assumed that σ1 = σ2, the pooled standard deviation 
can be used (see Chapter 2.6.1.) 

for sampling without replacement the standard error of the mean is multiplied by the 
finite population correction factor 

After computing the estimates for the means (and, if necessary, the standard deviations) from 
the sample, the value of the test statistic for the samples is calculated. If there is a large distance 
between the sample means, the value of the test statistic will also be extreme. In this case the 
null hypothesis is rejected, as there is enough evidence to conclude that the population means 
are different, i.e. the samples belong to populations with different means. Note however, that 
the value of the test statistic is influenced by the standard error of the difference, i.e. by the 
sample sizes and the dispersions (standard deviations). 

The decision about the null hypothesis can also be made by the critical region method, following 
the same steps as for the one-sample mean tests. The critical values define the rejection and 
acceptance regions (Figure 19). The t critical value is determined with degrees of freedom 
n1 + n2 – 2, assuming equal population variances, otherwise the smaller one of  
n1 – 1 and n2 – 1 is chosen for the degrees of freedom. The value of the test statistics calculated 
from the sample is compared with the critical value(s). If the value of the test statistic is more 
extreme than the critical value, i.e. it falls in a rejection region, then the decision will be to reject 
the null hypothesis. 

The decision about the null hypothesis can be made by the P-value method, too. In this case the 
P-value of the test statistic calculated from the samples is determined by a statistical software, 
as presented in Chapter 4.1.3. As the P-value is the probability of observing a value of the test 
statistic that is at least as extreme as the one for the sample, assuming the null hypothesis is 
true, so if the calculated P-value ≤ α, then reject the null hypothesis. 
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Figure 19. Critical regions for two-sample means tests 

Two-Sample Left-tailed Two-tailed Right-tailed 
Alternate hypothesis H1: µ < µ  H1: µ ≠ µ  H1: µ > µ  

P 
P (z < zα) = α 
P (t < tα) = α 

׀ ׀ > ⁄ = 2 

׀ ׀ > ⁄ = 2 

P (z > z1-α) = α 
P (t > t1-α) = α 

 
Source:based on Kozak et al. (2008) 

As for two-tailed tests with the level of significance α 

⁄  ≤   ≤  ⁄ =  1 –   and as ⁄ = − ⁄  → ׀ ׀ > ⁄ = 2 

the two-tailed tests are equivalent to the (1 – α)-level confidence intervals 

P( ̅ − ̅ − ≤  1 − 2  ≤  ̅ − ̅ + =  1 –   

This statement is also true for the Student’s t distribution. The confidence limits of the interval 
estimation for the difference between the means are the critical values expressed in the units of 
the means. So if the hypotheses defined for testing equality and inequality regardless of the 
direction (two-tailed test), the decision about the null hypothesis is made by comparing the 
difference between the sample means with the confidence interval, i.e. with the values of the 
lower and upper confidence limit. 

 

EXAMPLE 4.10 

Using the sample and the data of EXAMPLE 3.3, can it be assumed that the average cluster weight 
of Kossuth szőlő is higher than that of Pinot Noir? Use α = 0.05 

Do not forget the step by step guide: 

1. Stating the hypotheses: ‘the average cluster weight of Kossuth szőlő is higher than that of Pinot 
Noir’ means that the average weight of the cluster of Pinot Noir is less than, or equal to that of 
Kossuth szőlő, so this will be claimed in H0. The hypotheses are: 
H0: µ ≤ µ   
H1: µ > µ    This indicates that a right-sided test is appropriate. 
 

2. Set the level of α: ’Use α = 0.05’ 
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3. Select the mathematical tool – an equation – to be used to determine the test statistic and its 
distribution when H0 is correct: since σ1 and σ2 are unknown, and based on the results of 
EXAMPLE 4.7, it can be safely assumed that the two unknown population variances are not equal. 
 = ̅ − ̅ − −

+  

with the degrees of freedom being the smaller one of n1 – 1 and n2 – 1. 
 

4. Determine the critical value(s) and define a rejection and an acceptance region according to the 
value of α: as it is a right-sided test, there will be only one critical value. 
As the smaller sample size is that of Kossuth szőlő, n = 28, the degrees of freedom is 27. 
The critical value is obtained from Table A.2 in the APPENDICES. 
t0.95

(28-1) = 1.7033 is the upper limit of the critical region. 
 

5. Calculate the value of the test statistic from the samples → 
Let’s see the necessary sample statistics: 

 Kossuth szőlő (1) Pinot Noir (2) 
Mean x = 145.77 x = 70.39 
Standard deviation σ = 36.41 σ = 20.84 
Observations n1 = 28 n2 = 34 

 

 = 145.77 − 70.39 − 01325.5328 + 434.2734 = 75.387.75 = .  

 

6. Make a decision regarding H0 by comparing the test statistic value with the critical value: the 
critical value is lower, than the test statistic… (t0.95 = 1.70 < 9.72) 
 

7. Give a conclusion on the original problem, interpret the results: The sample means are 
considerably different, at 5% level of significance the evidence is enough to reject the null 
hypothesis. This implies that the average weight of a cluster of Kossuth szőlő is higher, than that 
of Pinot Noir. 

THE P-VALUE OF THE TWO-SAMPLE TEST OF MEANS IN EXCEL AND IN SPSS 

As mentioned in Chapter 4.1.3 

IN EXCEL the T.TEST function returns the probability whether two samples come from two 
underlying populations that have the same mean, with the following arguments: the first (Array1) 
and the second (Array2) data set, the type of the alternate hypothesis, that is, 1 = one-tailed, 2 = 
two-tailed (Tails), and the Type of the two-samples test (2 = independent samples with equal 
variances, 3 = independent samples with unequal variances). 

IN EXCEL the tests in Data Analysis (t-Test: Two-Sample Assuming Equal and t-Test: Two-
Sample Assuming Unequal Variances) produce a variety of statistics, including the one-tail and 
two-tail P-value (as Sig.) of a test.  

See in EXAMPLE 4.11 for how to run and interpret the output. 

IN SPSS In the menu choose Analyze ► Compare Means ► Independent-Samples T Test… The 
procedure produces a variety of statistics, including the P-value (as Sig.) of a test, appearing in the 
Output Window. See EXAMPLE 4.12 for how to run and interpret the output. 
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EXAMPLE 4.11 

THE P-VALUE OF EXAMPLE 4.10 IN EXCEL 

As in EXAMPLE 4.7 – 4.9 the sample variances were proven to be considerably different, in the 
argument of the T.TEST function the Type is 3 = independent samples with unequal variances.  

 P = 1,62948E-12 < 0.05 = α 

so the evidence is enough to reject the null hypothesis. 

In Data Analysis of EXCEL the Two-Sample Assuming Unequal Variances test will be selected. 
How to interpret the results? 

t-Test: Two-Sample Assuming Unequal Variances 

  Kossuth szőlő Pinot Noir 
Mean 145,7725 70,39441176 
Variance 1325,528797 434,2746618 
Observations 28 34 
Hypothesized Mean Difference 0  
df 41  
t Stat 9,722110705  
P(T<=t) one-tail 1,66673E-12  
t Critical one-tail 1,682878002  
P(T<=t) two-tail 3,33347E-12  
t Critical two-tail 2,01954097   

 
The value of the t test statistic is the same as the calculated value was in Example 4.10. Because the 
test is one-tailed (right-tailed), thus the decision can be made by comparing the value of the test 
statistic with the t Critical one-tail  

t0.95 = 1.68 < 9.72 

or the P(T<=t) one-tail probability with the level of significance 

P = 1,66673E-12 = 0.000 < 0.05 = α 

so reject the null hypothesis. 

Do not forget that statistical software gives a more accurate and larger value for the degrees of 
freedom, based on Satterthwaite’s approximation for the critical value, therefore the critical value 
(1.68) is a little lower, than the critical value established in Example 4.10 (t0.95

(27) = 1.70). 

The explanation for the negligible difference between the P value (1,62948E-12) of the T.TEST and 
the P value (1,66673E-12) of the Data Analysis test is, that one rounds the degrees of freedom to an 
integer value, while the other interpolates. 



88 

 

 
 

EXAMPLE 4.12 

THE P-VALUE OF EXAMPLE 4.10 IN SPSS 

While in EXCEL before testing the difference of the means, we start with testing the ratio of the 
population variances (unless there is no other information about the population variances and their 
homogeneity), in SPSS in the menu we choose Analyze ► Compare Means ► Independent-Samples 
T Test….The procedure produces a variety of statistics, including the P-value of the T-test for 
Equality of Means, appearing in the Output Window. How to run and how to interpret the output? 

 

The Group statistics are the same as in Descriptives in EXAMPLE 3.3. 

 

The first block of the Independent Samples Test contains the value of Levene’s Test statistic and the 
P-value of Levene’s Test (see EXAMPLE 4.9) as it can be safely assumed that the two unknown 
population variances are not equal (that is ‘Equal variances not assumed’). So for decision about the 
null hypothesis, the results of the second row of the following table is to be considered. 

 

In the second row the value of the test statistic t is equal to the value in EXAMPLE 4.10 and 4.11. 
The statistical software gives a more accurate value for the degrees of freedom (than the one used in 
EXAMPLE 4.10) based on Satterthwaite’s approximation, thus the value of the degrees of freedom 
is 41. Check that t0.95

(41) = 1.68. 

The P-value of the test statistic (t = 9.72) is 3.26E-12, which value is equal to the P-value of the 
T.TEST function in Excel. As it was mentioned, in SPSS the reported P value is for a two-tailed test, 
therefore P/2 should be compared to , and it has to be verified, that the sample means differ in the 
direction supported by the alternative hypothesis.  2 =  0.00002 = 0.000 ≤  = 0.05 

So reject the null hypothesis. 
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4.4.3. Hypothesis Test of Paired Population Means 

In Chapter 2.6.2. the special case of paired populations was discussed. In this case the starting 
point is creating data pairs and calculating the pairwise differences of − = . Then let’s 
compute the mean ̅ as the point estimate of the difference of two unknown, but paired 
population means and the standard deviation sd of the differences. The problem, and thus the 
test, can be simplified to a one-sample mean test using a z- or a t-test, because of the normal 
distribution assumption for d. 

The null hypothesis states, that H : µ − µ = D = , where c is a constant, in most cases it is 
assumed that c is equal to 0 to test the equality of the means. When the null hypothesis states 
that the population means µ1 and µ2 are equal, the alternate hypothesis states that there is a 
difference regardless of the direction, or in one of the two possible directions. Similar to 
independent populations, for paired populations the difference of the two means will be tested. 
Now not only the fact, that the distribution of the difference between the means is known, but 
the speciality of the method underlines the necessity of concentrating on the difference between 
the means. The possible hypotheses are the same as they were in Table 11. 

As it was discussed in Chapter 2.6.2. if the distribution of the difference is normal with known 
population standard deviation of the differences , the sampling distribution of the difference 
can be converted for any sample size n to the standard normal distribution. Otherwise, relying 
on the estimate sd, Student’s t distribution is used with the degree of freedom ν = n – 1 
(n = n1 = n2). So the test statistic is: 

  

EXAMPLE 4.13 

DECISION REGARDING H0 WITH INTERVAL ESTIMATION FOR THE DIFFERENCE 
BETWEEN MEANS (INDEPENDENT SAMPLES) FOR EXAMPLE 4.10 IN SPSS 

If a two-sided test is appropriate to answer the research question, that is, the hypotheses are 
H0: µ = µ   and H1: µ ≠ µ  , the two-tailed tests are equivalent to  
(1-α)-level confidence intervals. In this case the decision about the null hypothesis can be made by 
comparing the difference between the sample means with the confidence interval, i.e. the values of 
the lower and upper confidence limit. 

The difference between the means, that is, the ’Mean Difference’ in the output of the previous 
example is ̅ − ̅ = 145.77 − 70.39 = 75.38, which value is the point estimate of the difference 
between the population means. As H0: µ = µ  , no difference is assumed between the 
varieties − = 0. The 95% Confidence Interval of the Difference (see the output in 
EXAMPLE 4.12) 59.72 ≤  −  ≤  91.04 = 0.95 does not contain the value of − = 0, therefore we can conclude that the two samples belong to populations with different 
population means. 
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Hypothesis tests for the difference between paired population means 

 
 is known 

(almost never happens) 
 is unknown 

(most common) 
↓ ↓ 

Use normal distribution Approximate  by sd 
Use Student's t distribution 

↓ ↓ 
The test statistic 

= − → z = ̅ −
 = ̅ − → t = ̅ −

√  

 
Where µD stated in H0 is the hypothesized difference (in most cases 0) 

for sampling without replacement the standard error of the mean is multiplied 
by the finite population correction factor 

The statistical hypothesis test is performed by the step by step guide. Either the critical region 
method (according to Figure 16 and Figure 19) or the P-value method can be applied to make 
the decision. 

 

EXAMPLE 4.14 

See the problem in EXAMPLE 2.7. This table contains the diameter of Botrytis cinerea Pers. 24, 
48, 72, 96 and 112 hours after the treatment with alcoholic extracts of sage and rosemary. The petri 
dishes were numbered (n = 10). 

Development of Botrytis cinerea Pers. (diameter, mm); sage + rosemary treatment 
 Time passed after 
the treatment 

1 2 3 4 5 6 7 8 9 10 

24 hours 0.0 0.0 12.0 11.0 0.0 14.5 9.5 0.0 12.0 0.0 
48 hours 11.5 15.0 33.5 34.0 21.5 34.0 30.0 13.5 33.0 9.5 
72 hours 24.5 33.0 51.0 55.0 44.0 51.5 52.0 25.0 54.5 13.0 
96 hours 49.0 65.5 77.0 79.0 72.5 69.5 82.0 49.0 78.0 30.0 
112 hours 65.0 85.0 83.5 85.0 85.0 80.0 85.0 66.5 83.5 46.0 

Based on the sample (n = 10) can it be assumed that there is a significant difference between the 
diameters 48 and 72 hours after the treatment? Use α = 0.05 

Do not forget the step by step guide: 

1. Stating the hypotheses: ‘there is a significant difference between the diameters 48 and 72 hours 
after the treatment’ means that diameters measured 48 hours and 72 hours after the treatment are 
not equal, so this will be claimed in H1. The hypotheses are: 
H0: µ = µ  that is H0: µ − µ = 0 
H1: µ ≠ µ   This indicates that a two-sided test is appropriate. 
 

2. Set the level of α: ’Use α = 0.05’ 
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3. Select the mathematical tool – an equation – to be used to determine the test statistic and its 
distribution, when H0 is correct: since  is unknown 
 t = ̅ −

√  

with degrees of freedom n – 1 = 10 – 1 = 9. 
 

4. Determine the critical value(s) and define a rejection region and an acceptance region with 
regard to α: as it is a two-sided test, there will be two critical values. 
The upper critical value is obtained from Table A.2 in the the APPENDICES:  
t0.975

(9) = 2.2622, and the lower value is t0.025
(9) = -t0.975

(9) = -2.2622, with the acceptance region 
between them. 
 

5. Calculate the value of the test statistic from the samples → 
Let’s see the necessary sample statistics: ̅ = 16.8, = 5.97 
 = 16.8 − 05.97√10 = 16,81.89 = .  

 

6. Make a decision regarding H0 by comparing the test statistic value with the critical value: the 
critical value is lower than the test statistic… (t0.975 = 2.26 < 8.89 = t) 
 

7. Give a conclusion on the original problem, interpret the results: The sample means are 
considerably different, at 5% level of significance. The evidence is enough to reject the null 
hypothesis. The positive mean value ̅ = 16.8 > 0 shows the growth of fungal mycelia in time. 

 

THE P-VALUE TEST OF THE PAIRED-SAMPLES MEANS IN EXCEL AND IN SPSS 

As mentioned in Chapter 4.1.3 

IN EXCEL the T.TEST function returns the probability whether two samples come from two 
underlying populations that have the same mean, with the following arguments: the first (Array1) 
and the second (Array2) data set, the type of the alternate hypothesis, that is, 1 = one-tailed, 2 = 
two-tailed (Tails), and the Type of the two-samples test (1 = paired samples). 

IN EXCEL the tests in Data Analysis (t-Test: Paired Two Sample for Means) produce a variety of 
statistics, including the one-tail and two-tail P-value (as Sig.) of a test. See EXAMPLE 4.15 for how 
to run and interpret the output. 

IN SPSS In the menu choose Analyze ► Compare Means ► Paired-Samples T Test…The 
procedure produces a variety of statistics, including the P-value (as Sig.) of a test, appearing in the 
Output Window. See EXAMPLE 4.16 for how to run and how to interpret the output. 
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EXAMPLE 4.15 

THE P-VALUE OF EXAMPLE 4.14 IN EXCEL 

The T.TEST returns the probability whether two samples come from two underlying populations 
that have the same mean, with the following arguments: the first (Array1) and the second (Array2) 
data set, the type of the alternate hypothesis is 2 = two-tailed (Tails), and the Type of the two-samples 
test is 1 = paired samples in this case. With this argumets the P-value of the T.Test is 0.000. 

 

The Z.TEST can also be used (do not forget that it is a right-tailed test) as the problem can be 
simplified for a one sample mean hypothesis. From the symmetry of the Normal distribution, if 
 ̅ < , then Z.TEST will return a value greater than 0.5. Since σ is unknown, Excel uses the sample 
standard deviation computed from the data. 

In Data Analysis of EXCEL the Paired Two Sample for Means test will be selected. How to interpret 
the results? 

t-Test: Paired Two Sample for Means 

Time passed after the treatment 
 48 hours 72 hours 

Mean 23,55 40,35 
Variance 107,6917 232,2806 
Observations 10 10 
Pearson Correlation 0,961981  
Hypothesized Mean Difference 0  
df 9  
t Stat -8,89427  
P(T<=t) one-tail 4,7E-06  
t Critical one-tail 1,833113  
P(T<=t) two-tail 9,4E-06  
t Critical two-tail 2,262157   

 

As the Variable 1 Range is the data set of 48 hours, the sample mean of which is lower, than that of 
the 72 hours sample, and the difference for the units is computed as d = x1 – x2 = x48 – x72, therefore 
although the absolute value of the t Stat is equal to the value of the test statistic in EXAMPLE 4.14, 
but this is a negative value. 

Because the test is two-tailed, thus the decision can be made by comparing the value of the test 
statistic with the t Critical two-tail value: 

t = -8.89 < t0.025 = -t0.975 = -2.2622 

or the P(T<=t) two-tail with the level of significance 

P = 9.4E-06 = 0.000 < 0.05 = α 

so reject the null hypothesis. 
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EXAMPLE 4.16 

THE P-VALUE OF EXAMPLE 4.14 IN SPSS 

IN SPSS In the menu choose Analyze ► Compare Means ► Paired-Samples T Test… The 
procedure produces a variety of statistics, including the P-value of the test, appearing in the Output 
Window. 

 

How to interpret the results? 

Similar to the Excel output, SPSS also computes the descriptive statistics of the Botrytis 
measurement 48 hours and 72 hours after the treatment. The output of SPSS contains not only the 
value of the Pearson Correlation (as for Excel), but also the P-value of it. 

In Paired Samples Test output table, first, the mean ̅ = 16.8 and the standard deviation of the 

difference = 5.97 can be seen with the standard error of the difference 
.√ = 1.89, which is the 

denominator of the test statistic. After the limits of the confidence interval the table contains the 
value of the test statistic (t = 8.89), with the degrees of freedom (n – 1 =10 – 1 = 9) and the P-value 
0.000009, which is equal to the P-value of Excel. As the Variable1 is the data set of 72 hours, the 
mean and therefore the value of the test is positive. 



94 

 

 

 

  

 

Because the test is two-tailed, thus the decision can be made by comparing the confidence interval 
limits with the hypothetical difference zero, as H0: µ − µ = 0. Since the confidence interval 
(12.53; 21.07) does not contain the zero, the null hypothesis will be rejected. 

Make certain, that a Paired-Samples T Test can be simplified to a One-Sample T Test. Compute a 
new variable (d difference): in the menu choose Transform ► Compute Variable… 

 

 
 

Then in the menu choose Analyze ► Compare Means ► One-Sample T Test with the Test 
Variable(s) d and the Test Value zero. 

 

Note, that the results of the One-Sample T Test are the same as the results in the Paired Samples Test 
output table. 
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4.4.4. Hypothesis Test of Two Population Proportions 

In this section the method for testing two independent population proportions will be presented. 
As discussed in Chapter 3.6. the sampling distribution of the difference of two proportions is 
the standard normal distribution. For the testing there are two basic assumptions: the two 
populations are normally distributed, and they are independent of each other, so the two 
sampling distributions are also independent. 

First, the null and the alternate hypothesis is defined. The null hypothesis states, that H : − = , where c is a constant. As the values of  and  are between 0 and 1, the 
value of their difference is between -1 and 1. In most cases it is assumed that c is equal to 0, to 
test the equality of the proportions. In this case the null hypothesis states that the population 
proportions are equal, while the alternate hypothesis states that there is a difference regardless 
of the direction, or in one of the two possible directions (Table 12).  

Table 12 The hypotheses for the two population proportions 

Two-Sample Left-tailed Two-tailed Right-tailed 
Two Proportions 

Null hypothesis H0: ≥  H0: =  H0: ≤  

Alternate hypothesis H1: <  H1: ≠  H1: >  

After setting the level of significance, the test statistic with a known theoretical distribution has 
to be defined. As discussed earlier, if the sample sizes n1 and n2 are greater than 30 and the 
values of P1 and P2 are not close to 0 or 1, the test statistic has the standard normal distribution: 

= − − −σ  

Since the values of P1 and P2 are unknown, σ is estimated by s , which is the standard 
error of the estimated difference between the proportions. When the null hypothesis states that 
the population proportions are equal H : = = P, the best estimate for this common value 
P (based on both samples) is the pooled or combined proportion 

= f + fn + n = n ∙ p + n ∙ pn + n  

(f is the number of successes out of n trials for both samples) and the estimate of the standard 
error can be calculated as 

= 1 − + 1 − = 1 − 1 + 1
 

If the sample proportions are not close to each other, another formula is recommended to 
estimate the standard error: 

= 1 − + 1 −
 

The decision about the null hypothesis can also be made by the critical region method. The 
critical value ( z ) obtained from the Tables in the APPENDICES, or determined by a statistical 
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software (as presented in Chapter 1.6.) defines the rejection and acceptance region (similar to 
Figure 19). The value of the test statistics calculated from the samples is compared with the 
critical value(s). If the value of the test statistic is more extreme than the critical value, that is, 
it falls in a rejection region, the decision will be to reject the null hypothesis. 

 

EXAMPLE 4.17 

The proportion of carp was examined in the fish stock of Lake Balaton on the northern and southern 
shores. Of the 250 fish caught on the north shore, 98 were carp, while on the south shore, 149 of 
the 250 fish were carp. With a 0.05 level of significance, can it be assumed that the proportion of 
carp does not differ on the northern and southern shores? (Hunkár, 2011) 

1. Stating the hypotheses: ‘there is a significant difference between the proportion of carp on the 
northern and southern shores’ The hypotheses are: 
H0: P = P  that is H0: P − P = 0 
H1: P ≠ P   This indicates that a two-sided test is appropriate.   
 

2. ’Use α = 0.05’ 
 

3. The equation is used for determining the test statistic and its distribution when H0 is correct: = − − −s  

 

4. Determine the critical value(s) and define a rejection and an acceptance region for α: as it is a 
two-sided test, there will be two critical values. 
z0.975 = 1.96 and the lower is z0.025 = -z0.975 = -1.96, the acceptance region is between these values. 
 

5. Calculate the value of the test statistic from the samples → 
Let’s see the necessary sample statistics: 

The sample proportions: = = = 0.392, = = = 0.596 

As there is a considerable difference between pN and pS, the estimate of the standard error is 
calculated as 

= 0.392 ∙ 0.608250 + 0.596 ∙ 0.404250 = √0.002 = 0.044 

Nevertheless, the formula for the standard error, based on the pooled or combined proportion, is: 

= 98 + 149250 + 250 = 247500 = 0.494 

= 1 − 1 + 1 = 0.494 ∙ 0.506 1250 + 1250 = 0.045 

gives almost the same results. 
 = 0.392 − 0.5960.044 = −4.660 
 

6. Make a decision regarding H0 by comparing the test statistic value with the critical values: the 
test statistic is lower than the critical value … (z = -4.660 < z0.025 = -1.96) 
 

7. Give a conclusion on the original problem, interpret the results: The proportions of carp are 
considerably different on the northern and southern shores, at 5% level of significance the evidence 
is enough to reject the null hypothesis. 
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EXERCISES 

Broiler chickens were fed with four types of feed (four types of soybean A, B, C, CP). Types 
A and B are new soybean varieties (with less antinutritive material), C is an old variety and CP 
is Type C flushed with flocked lupine. The experimental animals were housed in 6 cages per 
treatment. Individual weights were measured in grams on days 10, 24, and 42. 

1. Classify the variables 
 as qualitative or quantitative, 
 by their scale of measurement. 

Give an example of a random variable. 
2. Suppose the weights of chicken (X) on days 10 are normally distributed with a mean of 

210 g and a standard deviation of 37 g. 
Find the following probabilities: 

 P(X ≤ 200) 
 P(X < 250) 
 P(X > 240) 
 P(190 ≤ X < 220) 

3. On day 10  
find the desciptive statistics for the individual weight, by feed type, 
construct a frequency table, a histogram and a frequency polygon, by feed type, 
check the normality by feed type. 

4. Find the 95% and 99% confidence intervals for the unknown population mean of 
chicken weight by feed types A and CP, compare the two intervals and the margins of 
error. 

5. Find the 90% and 95% confidence intervals for the unknown population variance of 
chicken weight and draw some conclusions. 

6. Find the 95% and 99% confidence intervals for the difference of the two unknown 
population means of soybean A and CP and draw some conclusions. 

7. Can it be assumed that the population variance for the different feed types is equal to 
372 on day 10? 

8. Can it be assumed that the population means of Feed A and Feed CP are higher than 
210 g on day 10? 

9. Can it be assumed that the population mean of Feed A is lower than that of Feed CP on 
day 10? 
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Table A.1 Area under the standard normal curve Table A.2 Critical values of the t distribution 

Percentile values for the t distribution with with v degrees of freedom 
z 0.00 0.01 0.02 0.03 0.04 0.05 0.06 0.07 0.08 0.09 

0.00 0.5000 0.5040 0.5080 0.5120 0.5160 0.5199 0.5239 0.5279 0.5319 0.5359 

0.10 0.5398 0.5438 0.5478 0.5517 0.5557 0.5596 0.5636 0.5675 0.5714 0.5753 

0.20 0.5793 0.5832 0.5871 0.5910 0.5948 0.5987 0.6026 0.6064 0.6103 0.6141 

0.30 0.6179 0.6217 0.6255 0.6293 0.6331 0.6368 0.6406 0.6443 0.6480 0.6517 

0.40 0.6554 0.6591 0.6628 0.6664 0.6700 0.6736 0.6772 0.6808 0.6844 0.6879 

0.50 0.6915 0.6950 0.6985 0.7019 0.7054 0.7088 0.7123 0.7157 0.7190 0.7224 

0.60 0.7257 0.7291 0.7324 0.7357 0.7389 0.7422 0.7454 0.7486 0.7517 0.7549 

0.70 0.7580 0.7611 0.7642 0.7673 0.7704 0.7734 0.7764 0.7794 0.7823 0.7852 

0.80 0.7881 0.7910 0.7939 0.7967 0.7995 0.8023 0.8051 0.8078 0.8106 0.8133 

0.90 0.8159 0.8186 0.8212 0.8238 0.8264 0.8289 0.8315 0.8340 0.8365 0.8389 

1.00 0.8413 0.8438 0.8461 0.8485 0.8508 0.8531 0.8554 0.8577 0.8599 0.8621 

1.10 0.8643 0.8665 0.8686 0.8708 0.8729 0.8749 0.8770 0.8790 0.8810 0.8830 

1.20 0.8849 0.8869 0.8888 0.8907 0.8925 0.8944 0.8962 0.8980 0.8997 0.9015 

1.30 0.9032 0.9049 0.9066 0.9082 0.9099 0.9115 0.9131 0.9147 0.9162 0.9177 

1.40 0.9192 0.9207 0.9222 0.9236 0.9251 0.9265 0.9279 0.9292 0.9306 0.9319 

1.50 0.9332 0.9345 0.9357 0.9370 0.9382 0.9394 0.9406 0.9418 0.9429 0.9441 

1.60 0.9452 0.9463 0.9474 0.9484 0.9495 0.9505 0.9515 0.9525 0.9535 0.9545 

1.70 0.9554 0.9564 0.9573 0.9582 0.9591 0.9599 0.9608 0.9616 0.9625 0.9633 

1.80 0.9641 0.9649 0.9656 0.9664 0.9671 0.9678 0.9686 0.9693 0.9699 0.9706 

1.90 0.9713 0.9719 0.9726 0.9732 0.9738 0.9744 0.9750 0.9756 0.9761 0.9767 

2.00 0.9772 0.9778 0.9783 0.9788 0.9793 0.9798 0.9803 0.9808 0.9812 0.9817 

2.10 0.9821 0.9826 0.9830 0.9834 0.9838 0.9842 0.9846 0.9850 0.9854 0.9857 

2.20 0.9861 0.9864 0.9868 0.9871 0.9875 0.9878 0.9881 0.9884 0.9887 0.9890 

2.30 0.9893 0.9896 0.9898 0.9901 0.9904 0.9906 0.9909 0.9911 0.9913 0.9916 

2.40 0.9918 0.9920 0.9922 0.9925 0.9927 0.9929 0.9931 0.9932 0.9934 0.9936 

2.50 0.9938 0.9940 0.9941 0.9943 0.9945 0.9946 0.9948 0.9949 0.9951 0.9952 

2.60 0.9953 0.9955 0.9956 0.9957 0.9959 0.9960 0.9961 0.9962 0.9963 0.9964 

2.70 0.9965 0.9966 0.9967 0.9968 0.9969 0.9970 0.9971 0.9972 0.9973 0.9974 

2.80 0.9974 0.9975 0.9976 0.9977 0.9977 0.9978 0.9979 0.9979 0.9980 0.9981 

2.90 0.9981 0.9982 0.9982 0.9983 0.9984 0.9984 0.9985 0.9985 0.9986 0.9986 

3.00 0.9987 0.9987 0.9987 0.9988 0.9988 0.9989 0.9989 0.9989 0.9990 0.9990 

3.10 0.9990 0.9991 0.9991 0.9991 0.9992 0.9992 0.9992 0.9992 0.9993 0.9993 

3.20 0.9993 0.9993 0.9994 0.9994 0.9994 0.9994 0.9994 0.9995 0.9995 0.9995 

3.30 0.9995 0.9995 0.9995 0.9996 0.9996 0.9996 0.9996 0.9996 0.9996 0.9997 

3.40 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9998 

3.50 0.9998 0.9998 0.9998 0.9998 0.9998 0.9998 0.9998 0.9998 0.9998 0.9998 
 

v 0.90 0.95 0.975 0.98 0.99 0.995 0.998 0.999 

1 3.0777 6.3138 12.7062 15.8945 31.8205 63.6567 159.1528 318.3088 
2 1.8856 2.9200 4.3027 4.8487 6.9646 9.9248 15.7639 22.3271 
3 1.6377 2.3534 3.1824 3.4819 4.5407 5.8409 8.0526 10.2145 
4 1.5332 2.1318 2.7764 2.9985 3.7469 4.6041 5.9514 7.1732 
5 1.4759 2.0150 2.5706 2.7565 3.3649 4.0321 5.0302 5.8934 
6 1.4398 1.9432 2.4469 2.6122 3.1427 3.7074 4.5241 5.2076 
7 1.4149 1.8946 2.3646 2.5168 2.9980 3.4995 4.2071 4.7853 
8 1.3968 1.8595 2.3060 2.4490 2.8965 3.3554 3.9910 4.5008 
9 1.3830 1.8331 2.2622 2.3984 2.8214 3.2498 3.8345 4.2968 

10 1.3722 1.8125 2.2281 2.3593 2.7638 3.1693 3.7162 4.1437 
11 1.3634 1.7959 2.2010 2.3281 2.7181 3.1058 3.6238 4.0247 
12 1.3562 1.7823 2.1788 2.3027 2.6810 3.0545 3.5495 3.9296 
13 1.3502 1.7709 2.1604 2.2816 2.6503 3.0123 3.4887 3.8520 
14 1.3450 1.7613 2.1448 2.2638 2.6245 2.9768 3.4379 3.7874 
15 1.3406 1.7531 2.1314 2.2485 2.6025 2.9467 3.3948 3.7328 
16 1.3368 1.7459 2.1199 2.2354 2.5835 2.9208 3.3579 3.6862 
17 1.3334 1.7396 2.1098 2.2238 2.5669 2.8982 3.3259 3.6458 
18 1.3304 1.7341 2.1009 2.2137 2.5524 2.8784 3.2979 3.6105 
19 1.3277 1.7291 2.0930 2.2047 2.5395 2.8609 3.2731 3.5794 
20 1.3253 1.7247 2.0860 2.1967 2.5280 2.8453 3.2512 3.5518 
21 1.3232 1.7207 2.0796 2.1894 2.5176 2.8314 3.2315 3.5272 
22 1.3212 1.7171 2.0739 2.1829 2.5083 2.8188 3.2138 3.5050 
23 1.3195 1.7139 2.0687 2.1770 2.4999 2.8073 3.1978 3.4850 
24 1.3178 1.7109 2.0639 2.1715 2.4922 2.7969 3.1832 3.4668 
25 1.3163 1.7081 2.0595 2.1666 2.4851 2.7874 3.1699 3.4502 
26 1.3150 1.7056 2.0555 2.1620 2.4786 2.7787 3.1577 3.4350 
27 1.3137 1.7033 2.0518 2.1578 2.4727 2.7707 3.1465 3.4210 
28 1.3125 1.7011 2.0484 2.1539 2.4671 2.7633 3.1362 3.4082 
29 1.3114 1.6991 2.0452 2.1503 2.4620 2.7564 3.1266 3.3962 
30 1.3104 1.6973 2.0423 2.1470 2.4573 2.7500 3.1177 3.3852 
31 1.3095 1.6955 2.0395 2.1438 2.4528 2.7440 3.1094 3.3749 
32 1.3086 1.6939 2.0369 2.1409 2.4487 2.7385 3.1017 3.3653 
33 1.3077 1.6924 2.0345 2.1382 2.4448 2.7333 3.0944 3.3563 
34 1.3070 1.6909 2.0322 2.1356 2.4411 2.7284 3.0877 3.3479 
35 1.3062 1.6896 2.0301 2.1332 2.4377 2.7238 3.0813 3.3400 
40 1.3031 1.6839 2.0211 2.1229 2.4233 2.7045 3.0545 3.3069 
45 1.3006 1.6794 2.0141 2.1150 2.4121 2.6896 3.0340 3.2815 
50 1.2987 1.6759 2.0086 2.1087 2.4033 2.6778 3.0177 3.2614 
60 1.2958 1.6706 2.0003 2.0994 2.3901 2.6603 2.9936 3.2317 

100 1.2901 1.6602 1.9840 2.0809 2.3642 2.6259 2.9464 3.1737 
∞ 1.2816 1.6449 1.9600 2.0538 2.3264 2.5758 2.8782 3.0902 
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Table A.3 Critical values of the χ2 distribution 
Percentile values for the chi-square distribution with v degrees of freedom 

 

 

v 0,005 0,01 0,025 0,05 0,10 0,25 0,50 0,75 0,90 0,95 0,975 0,99 0,995 

1 0,0000 0,0002 0,0010 0,0039 0,0158 0,1015 0,4549 1,3233 2,7055 3,8415 5,0239 6,6349 7,8794 

2 0,0100 0,0201 0,0506 0,1026 0,2107 0,5754 1,3863 2,7726 4,6052 5,9915 7,3778 9,2103 10,5966 

3 0,0717 0,1148 0,2158 0,3518 0,5844 1,2125 2,3660 4,1083 6,2514 7,8147 9,3484 11,3449 12,8382 

4 0,2070 0,2971 0,4844 0,7107 1,0636 1,9226 3,3567 5,3853 7,7794 9,4877 11,1433 13,2767 14,8603 

5 0,4117 0,5543 0,8312 1,1455 1,6103 2,6746 4,3515 6,6257 9,2364 11,0705 12,8325 15,0863 16,7496 

6 0,6757 0,8721 1,2373 1,6354 2,2041 3,4546 5,3481 7,8408 10,6446 12,5916 14,4494 16,8119 18,5476 

7 0,9893 1,2390 1,6899 2,1673 2,8331 4,2549 6,3458 9,0371 12,0170 14,0671 16,0128 18,4753 20,2777 

8 1,3444 1,6465 2,1797 2,7326 3,4895 5,0706 7,3441 10,2189 13,3616 15,5073 17,5345 20,0902 21,9550 

9 1,7349 2,0879 2,7004 3,3251 4,1682 5,8988 8,3428 11,3888 14,6837 16,9190 19,0228 21,6660 23,5894 

10 2,1559 2,5582 3,2470 3,9403 4,8652 6,7372 9,3418 12,5489 15,9872 18,3070 20,4832 23,2093 25,1882 

11 2,6032 3,0535 3,8157 4,5748 5,5778 7,5841 10,3410 13,7007 17,2750 19,6751 21,9200 24,7250 26,7568 

12 3,0738 3,5706 4,4038 5,2260 6,3038 8,4384 11,3403 14,8454 18,5493 21,0261 23,3367 26,2170 28,2995 

13 3,5650 4,1069 5,0088 5,8919 7,0415 9,2991 12,3398 15,9839 19,8119 22,3620 24,7356 27,6882 29,8195 

14 4,0747 4,6604 5,6287 6,5706 7,7895 10,1653 13,3393 17,1169 21,0641 23,6848 26,1189 29,1412 31,3193 

15 4,6009 5,2293 6,2621 7,2609 8,5468 11,0365 14,3389 18,2451 22,3071 24,9958 27,4884 30,5779 32,8013 

16 5,1422 5,8122 6,9077 7,9616 9,3122 11,9122 15,3385 19,3689 23,5418 26,2962 28,8454 31,9999 34,2672 

17 5,6972 6,4078 7,5642 8,6718 10,0852 12,7919 16,3382 20,4887 24,7690 27,5871 30,1910 33,4087 35,7185 

18 6,2648 7,0149 8,2307 9,3905 10,8649 13,6753 17,3379 21,6049 25,9894 28,8693 31,5264 34,8053 37,1565 

19 6,8440 7,6327 8,9065 10,1170 11,6509 14,5620 18,3377 22,7178 27,2036 30,1435 32,8523 36,1909 38,5823 

20 7,4338 8,2604 9,5908 10,8508 12,4426 15,4518 19,3374 23,8277 28,4120 31,4104 34,1696 37,5662 39,9968 

21 8,0337 8,8972 10,2829 11,5913 13,2396 16,3444 20,3372 24,9348 29,6151 32,6706 35,4789 38,9322 41,4011 

22 8,6427 9,5425 10,9823 12,3380 14,0415 17,2396 21,3370 26,0393 30,8133 33,9244 36,7807 40,2894 42,7957 

23 9,2604 10,1957 11,6886 13,0905 14,8480 18,1373 22,3369 27,1413 32,0069 35,1725 38,0756 41,6384 44,1813 

24 9,8862 10,8564 12,4012 13,8484 15,6587 19,0373 23,3367 28,2412 33,1962 36,4150 39,3641 42,9798 45,5585 

25 10,5197 11,5240 13,1197 14,6114 16,4734 19,9393 24,3366 29,3389 34,3816 37,6525 40,6465 44,3141 46,9279 

26 11,1602 12,1981 13,8439 15,3792 17,2919 20,8434 25,3365 30,4346 35,5632 38,8851 41,9232 45,6417 48,2899 

27 11,8076 12,8785 14,5734 16,1514 18,1139 21,7494 26,3363 31,5284 36,7412 40,1133 43,1945 46,9629 49,6449 

28 12,4613 13,5647 15,3079 16,9279 18,9392 22,6572 27,3362 32,6205 37,9159 41,3371 44,4608 48,2782 50,9934 

29 13,1211 14,2565 16,0471 17,7084 19,7677 23,5666 28,3361 33,7109 39,0875 42,5570 45,7223 49,5879 52,3356 

30 13,7867 14,9535 16,7908 18,4927 20,5992 24,4776 29,3360 34,7997 40,2560 43,7730 46,9792 50,8922 53,6720 

31 14,4578 15,6555 17,5387 19,2806 21,4336 25,3901 30,3359 35,8871 41,4217 44,9853 48,2319 52,1914 55,0027 

32 15,1340 16,3622 18,2908 20,0719 22,2706 26,3041 31,3359 36,9730 42,5847 46,1943 49,4804 53,4858 56,3281 

33 15,8153 17,0735 19,0467 20,8665 23,1102 27,2194 32,3358 38,0575 43,7452 47,3999 50,7251 54,7755 57,6484 

34 16,5013 17,7891 19,8063 21,6643 23,9523 28,1361 33,3357 39,1408 44,9032 48,6024 51,9660 56,0609 58,9639 

35 17,1918 18,5089 20,5694 22,4650 24,7967 29,0540 34,3356 40,2228 46,0588 49,8018 53,2033 57,3421 60,2748 

40 20,7065 22,1643 24,4330 26,5093 29,0505 33,6603 39,3353 45,6160 51,8051 55,7585 59,3417 63,6907 66,7660 

45 24,3110 25,9013 28,3662 30,6123 33,3504 38,2910 44,3351 50,9849 57,5053 61,6562 65,4102 69,9568 73,1661 

50 27,9907 29,7067 32,3574 34,7643 37,6886 42,9421 49,3349 56,3336 63,1671 67,5048 71,4202 76,1539 79,4900 

60 35,5345 37,4849 40,4817 43,1880 46,4589 52,2938 59,3347 66,9815 74,3970 79,0819 83,2977 88,3794 91,9517 

70 43,2752 45,4417 48,7576 51,7393 55,3289 61,6983 69,3345 77,5767 85,5270 90,5312 95,0232 100,4252 104,2149 

80 51,1719 53,5401 57,1532 60,3915 64,2778 71,1445 79,3343 88,1303 96,5782 101,8795 106,6286 112,3288 116,3211 

90 59,1963 61,7541 65,6466 69,1260 73,2911 80,6247 89,3342 98,6499 107,5650 113,1453 118,1359 124,1163 128,2989 

100 67,3276 70,0649 74,2219 77,9295 82,3581 90,1332 99,3341 109,1412 118,4980 124,3421 129,5612 135,8067 140,1695 

120 83,8516 86,9233 91,5726 95,7046 100,6236 109,2197 119,3340 130,0546 140,2326 146,5674 152,2114 158,9502 163,6482 
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Table A.4 Critical values of the F distribution (F > F0.95) 

  
Numerator degrees of freedom 

1 2 3 4 5 6 7 8 9 10 12 15 20 25 30 35 40 45 50 60 70 80 90 100 120 ∞ 

D
e
n

o
m

in
a
to

r
 d

e
g
r
e
e
s 

o
f 

fr
e
e
d

o
m

 

1 161,45 199,50 215,71 224,58 230,16 233,99 236,77 238,88 240,54 241,88 243,91 245,95 248,01 249,26 250,10 250,69 251,14 251,49 251,77 252,20 252,50 252,72 252,90 253,04 253,25 254,31 
2 18,51 19,00 19,16 19,25 19,30 19,33 19,35 19,37 19,38 19,40 19,41 19,43 19,45 19,46 19,46 19,47 19,47 19,47 19,48 19,48 19,48 19,48 19,48 19,49 19,49 19,50 
3 10,13 9,55 9,28 9,12 9,01 8,94 8,89 8,85 8,81 8,79 8,74 8,70 8,66 8,63 8,62 8,60 8,59 8,59 8,58 8,57 8,57 8,56 8,56 8,55 8,55 8,53 
4 7,71 6,94 6,59 6,39 6,26 6,16 6,09 6,04 6,00 5,96 5,91 5,86 5,80 5,77 5,75 5,73 5,72 5,71 5,70 5,69 5,68 5,67 5,67 5,66 5,66 5,63 
5 6,61 5,79 5,41 5,19 5,05 4,95 4,88 4,82 4,77 4,74 4,68 4,62 4,56 4,52 4,50 4,48 4,46 4,45 4,44 4,43 4,42 4,41 4,41 4,41 4,40 4,37 
6 5,99 5,14 4,76 4,53 4,39 4,28 4,21 4,15 4,10 4,06 4,00 3,94 3,87 3,83 3,81 3,79 3,77 3,76 3,75 3,74 3,73 3,72 3,72 3,71 3,70 3,67 
7 5,59 4,74 4,35 4,12 3,97 3,87 3,79 3,73 3,68 3,64 3,57 3,51 3,44 3,40 3,38 3,36 3,34 3,33 3,32 3,30 3,29 3,29 3,28 3,27 3,27 3,23 
8 5,32 4,46 4,07 3,84 3,69 3,58 3,50 3,44 3,39 3,35 3,28 3,22 3,15 3,11 3,08 3,06 3,04 3,03 3,02 3,01 2,99 2,99 2,98 2,97 2,97 2,93 
9 5,12 4,26 3,86 3,63 3,48 3,37 3,29 3,23 3,18 3,14 3,07 3,01 2,94 2,89 2,86 2,84 2,83 2,81 2,80 2,79 2,78 2,77 2,76 2,76 2,75 2,71 

10 4,96 4,10 3,71 3,48 3,33 3,22 3,14 3,07 3,02 2,98 2,91 2,85 2,77 2,73 2,70 2,68 2,66 2,65 2,64 2,62 2,61 2,60 2,59 2,59 2,58 2,54 
11 4,84 3,98 3,59 3,36 3,20 3,09 3,01 2,95 2,90 2,85 2,79 2,72 2,65 2,60 2,57 2,55 2,53 2,52 2,51 2,49 2,48 2,47 2,46 2,46 2,45 2,40 
12 4,75 3,89 3,49 3,26 3,11 3,00 2,91 2,85 2,80 2,75 2,69 2,62 2,54 2,50 2,47 2,44 2,43 2,41 2,40 2,38 2,37 2,36 2,36 2,35 2,34 2,30 
13 4,67 3,81 3,41 3,18 3,03 2,92 2,83 2,77 2,71 2,67 2,60 2,53 2,46 2,41 2,38 2,36 2,34 2,33 2,31 2,30 2,28 2,27 2,27 2,26 2,25 2,21 
14 4,60 3,74 3,34 3,11 2,96 2,85 2,76 2,70 2,65 2,60 2,53 2,46 2,39 2,34 2,31 2,28 2,27 2,25 2,24 2,22 2,21 2,20 2,19 2,19 2,18 2,13 
15 4,54 3,68 3,29 3,06 2,90 2,79 2,71 2,64 2,59 2,54 2,48 2,40 2,33 2,28 2,25 2,22 2,20 2,19 2,18 2,16 2,15 2,14 2,13 2,12 2,11 2,07 
16 4,49 3,63 3,24 3,01 2,85 2,74 2,66 2,59 2,54 2,49 2,42 2,35 2,28 2,23 2,19 2,17 2,15 2,14 2,12 2,11 2,09 2,08 2,07 2,07 2,06 2,01 
17 4,45 3,59 3,20 2,96 2,81 2,70 2,61 2,55 2,49 2,45 2,38 2,31 2,23 2,18 2,15 2,12 2,10 2,09 2,08 2,06 2,05 2,03 2,03 2,02 2,01 1,96 
18 4,41 3,55 3,16 2,93 2,77 2,66 2,58 2,51 2,46 2,41 2,34 2,27 2,19 2,14 2,11 2,08 2,06 2,05 2,04 2,02 2,00 1,99 1,98 1,98 1,97 1,92 
19 4,38 3,52 3,13 2,90 2,74 2,63 2,54 2,48 2,42 2,38 2,31 2,23 2,16 2,11 2,07 2,05 2,03 2,01 2,00 1,98 1,97 1,96 1,95 1,94 1,93 1,88 
20 4,35 3,49 3,10 2,87 2,71 2,60 2,51 2,45 2,39 2,35 2,28 2,20 2,12 2,07 2,04 2,01 1,99 1,98 1,97 1,95 1,93 1,92 1,91 1,91 1,90 1,84 
21 4,32 3,47 3,07 2,84 2,68 2,57 2,49 2,42 2,37 2,32 2,25 2,18 2,10 2,05 2,01 1,98 1,96 1,95 1,94 1,92 1,90 1,89 1,88 1,88 1,87 1,81 
22 4,30 3,44 3,05 2,82 2,66 2,55 2,46 2,40 2,34 2,30 2,23 2,15 2,07 2,02 1,98 1,96 1,94 1,92 1,91 1,89 1,88 1,86 1,86 1,85 1,84 1,78 
23 4,28 3,42 3,03 2,80 2,64 2,53 2,44 2,37 2,32 2,27 2,20 2,13 2,05 2,00 1,96 1,93 1,91 1,90 1,88 1,86 1,85 1,84 1,83 1,82 1,81 1,76 
24 4,26 3,40 3,01 2,78 2,62 2,51 2,42 2,36 2,30 2,25 2,18 2,11 2,03 1,97 1,94 1,91 1,89 1,88 1,86 1,84 1,83 1,82 1,81 1,80 1,79 1,73 
25 4,24 3,39 2,99 2,76 2,60 2,49 2,40 2,34 2,28 2,24 2,16 2,09 2,01 1,96 1,92 1,89 1,87 1,86 1,84 1,82 1,81 1,80 1,79 1,78 1,77 1,71 
26 4,23 3,37 2,98 2,74 2,59 2,47 2,39 2,32 2,27 2,22 2,15 2,07 1,99 1,94 1,90 1,87 1,85 1,84 1,82 1,80 1,79 1,78 1,77 1,76 1,75 1,69 
27 4,21 3,35 2,96 2,73 2,57 2,46 2,37 2,31 2,25 2,20 2,13 2,06 1,97 1,92 1,88 1,86 1,84 1,82 1,81 1,79 1,77 1,76 1,75 1,74 1,73 1,67 
28 4,20 3,34 2,95 2,71 2,56 2,45 2,36 2,29 2,24 2,19 2,12 2,04 1,96 1,91 1,87 1,84 1,82 1,80 1,79 1,77 1,75 1,74 1,73 1,73 1,71 1,65 
29 4,18 3,33 2,93 2,70 2,55 2,43 2,35 2,28 2,22 2,18 2,10 2,03 1,94 1,89 1,85 1,83 1,81 1,79 1,77 1,75 1,74 1,73 1,72 1,71 1,70 1,64 
30 4,17 3,32 2,92 2,69 2,53 2,42 2,33 2,27 2,21 2,16 2,09 2,01 1,93 1,88 1,84 1,81 1,79 1,77 1,76 1,74 1,72 1,71 1,70 1,70 1,68 1,62 
35 4,12 3,27 2,87 2,64 2,49 2,37 2,29 2,22 2,16 2,11 2,04 1,96 1,88 1,82 1,79 1,76 1,74 1,72 1,70 1,68 1,66 1,65 1,64 1,63 1,62 1,56 
40 4,08 3,23 2,84 2,61 2,45 2,34 2,25 2,18 2,12 2,08 2,00 1,92 1,84 1,78 1,74 1,72 1,69 1,67 1,66 1,64 1,62 1,61 1,60 1,59 1,58 1,51 
45 4,06 3,20 2,81 2,58 2,42 2,31 2,22 2,15 2,10 2,05 1,97 1,89 1,81 1,75 1,71 1,68 1,66 1,64 1,63 1,60 1,59 1,57 1,56 1,55 1,54 1,47 
50 4,03 3,18 2,79 2,56 2,40 2,29 2,20 2,13 2,07 2,03 1,95 1,87 1,78 1,73 1,69 1,66 1,63 1,61 1,60 1,58 1,56 1,54 1,53 1,52 1,51 1,44 
60 4,00 3,15 2,76 2,53 2,37 2,25 2,17 2,10 2,04 1,99 1,92 1,84 1,75 1,69 1,65 1,62 1,59 1,57 1,56 1,53 1,52 1,50 1,49 1,48 1,47 1,39 
70 3,98 3,13 2,74 2,50 2,35 2,23 2,14 2,07 2,02 1,97 1,89 1,81 1,72 1,66 1,62 1,59 1,57 1,55 1,53 1,50 1,49 1,47 1,46 1,45 1,44 1,35 
80 3,96 3,11 2,72 2,49 2,33 2,21 2,13 2,06 2,00 1,95 1,88 1,79 1,70 1,64 1,60 1,57 1,54 1,52 1,51 1,48 1,46 1,45 1,44 1,43 1,41 1,32 
90 3,95 3,10 2,71 2,47 2,32 2,20 2,11 2,04 1,99 1,94 1,86 1,78 1,69 1,63 1,59 1,55 1,53 1,51 1,49 1,46 1,44 1,43 1,42 1,41 1,39 1,30 

100 3,94 3,09 2,70 2,46 2,31 2,19 2,10 2,03 1,97 1,93 1,85 1,77 1,68 1,62 1,57 1,54 1,52 1,49 1,48 1,45 1,43 1,41 1,40 1,39 1,38 1,28 
120 3,92 3,07 2,68 2,45 2,29 2,18 2,09 2,02 1,96 1,91 1,83 1,75 1,66 1,60 1,55 1,52 1,50 1,47 1,46 1,43 1,41 1,39 1,38 1,37 1,35 1,25 

∞ 3,84 3,00 2,60 2,37 2,21 2,10 2,01 1,94 1,88 1,83 1,75 1,67 1,57 1,51 1,46 1,42 1,39 1,37 1,35 1,32 1,29 1,27 1,26 1,24 1,22 1,00 
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